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Before you get started with Cisco WebEx Meeting Center:

Please check whether you are using Meeting Center on InterCall’s Pay per Use service or if you are
on your own dedicated WebEx Meeting Center URL. Some of the features and functionality are
different based on the version that you are running. For more information, please contact your sales
representative or contact InterCall’s technical support at http://www.intercall.com/customer-

center/techSupport.php.




Setting up and Preparing for
a Meeting

About setting up Meeting Center

To participate in a meeting, you must set up Meeting Center on your computer. Once
you schedule, start, or join a meeting for the first time, your meeting service Web site
starts the setup process. However, to save time, you can set up the application at any
time before scheduling, starting, or joining a meeting.

Setting up Meeting Center

System requirements for Meeting Center for Windows

You can find the system requirements and other information about compatible
browsers and operating systems on the User Guides page for your service:

1 Log in to your WebEx Meeting Center site.
2 On the WebEx Meeting Center navigation bar, click Support > Downloads.

3 On the right side of the page, under Release Notes and FAQs, click the link for
release notes.
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Setting up Meeting Center for Windows

Before installing Meeting Center, ensure that your computer meets the minimum
system requirements.

If you are not using the Windows operating system, please refer to our FAQ, which
includes information about setting up Meeting Center on other operating systems.

To go to the list of FAQs:

1 On your Meeting Center Web site, on the left navigation bar, click Support >
Downloads.

2 On the Downloads page, under Release Notes and FAQs, click the link for FAQs
(Frequently Asked Questions).

A list of questions displays, arranged by topic. Look for your information about
your operating system under Minimum System Requirements.

To set up Meeting Center for Windows:

1 On the navigation bar, expand Set Up, and then click Meeting Manager.
The Set Up page appears.

2 Click Set Up.

3 If asecurity dialog box appears, click Yes.

Setup continues. A progress message box appears, indicating the progress of
setup.

4 On the Setup Complete page, click OK.

You can now start, schedule, or join a meeting.

Note:

= Alternatively, you can download the Meeting Manager for Windows Installer from the
Support page on your Meeting Center Web site, and then install Meeting Manager on your
Web browser. This option is useful if your system does not allow you to install Meeting
Manager directly from the Set Up page.

= If you or another attendee plans to share Universal Communications Format (UCF) media
files during a meeting, you can verify that the required components are installed on your
system to play the media files.
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Uninstalling for Windows

You can easily uninstall or remove Meeting Manager for Windows on your computer.
1 Do one of the following:

= For Windows 2000: On your computer's desktop, double-click My
Computer, and then open the Control Panel folder.

=  For Windows XP: Click Start, and then click Control Panel.

2 Double-click Add/Remove Programs or Add or Remove Programs, depending
on your computer's operating system.

A dialog box appears, showing a list of programs installed on your computer.
3 Inthe list, select WebEXx.

4 Click Add/Remove or Change/Remove, depending on your computer's operating
system.

A message appears, asking you to confirm that you want to remove the software.
5 Click Yes.
The Uninstall WebEx Software dialog box appears.
6 Select Meeting Manager.
7 Click Uninstall.
8  Once the software is removed, click Finish.

Select an option to restart your computer now or later.

Preparing for a meeting

To take advantage of the many features available in a meeting, check your system and
then install some tools to extend meeting capabilities.

= Check your system for UCF compatibility (if you have presentations with
animations, save them as .ucf so meeting attendees can view these effects).

= Set up and install Cisco WebEx Connect.
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Checking your system for UCF Compatibility

If you intend to play or view Universal Communications Format (UCF) media files
during the meeting, either as a presenter or an attendee, you can verify that the
following components are installed on your computer:

= Flash Player for playing a Flash movie or interactive Flash files.
= Windows Media Player for playing audio or video files.

Checking your system is useful if you or another presenter plans to share a UCF
multimedia presentation or standalone UCF media files.

To check your system for UCF compatibility:
1 On the navigation bar, do one of the following:
= If you are a new meeting service user, click New User?.

= If you are already a meeting service user, expand Set Up, then click Meeting
Manager.

2 Click Verify your rich media players.

3 Click the links to verify that the required players are installed on your computer.

Note: The option to check your system for required rich media players is available only if your
Meeting Center Web site includes the UCF option.

About WebEx Connect

Use WebEx Connect, the instant messenger for business users to send secure instant
messages, invite or remind participants, and manage a meeting. Connect integrates
with Microsoft Outlook corporate directories and calendars, encrypts messages and
scans them for viruses, and offers quick access to business conferencing services from
WebEx.

To download WebEx Connect:

1 Log in to your Meeting Center Web site.

2 On the Meeting Center navigation bar, click Support > Downloads.
3 Scroll down to the section of the page describing WebEx Connect.

Click the link to learn more about this product and download it.



Joining a Meeting

About joining

You can join a meeting in a number of ways. The simplest and quickest is by clicking
the meeting URL, which the host can send you via an invitation email message or an
instant message.

If the host has given you just the meeting number, you have a couple of ways to join
the meeting.

Notes:
=  The meeting host may choose to record the meeting.

= If you are the host but you inadvertently land on the page for participants to join the a meeting,
click If you are the host, start your meeting.

= If you are the participant but you inadvertently land on the page for the host to start the a
meeting, click If you are not the host, join as a participant.

About the Join Meeting page

To access this page: Click the meeting link in your invitation email message, and then
click Join Now.

When joining a meeting, you may need to enter some details on the Join Meeting

page:
= Your name: Enter the name you want attendees to use to identify you during the
meeting.

= Email address: Enter your email address, in this format:
name@your_company—for example, msmith@company.com.
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= Meeting password: Enter the meeting password (optional). The meeting host
may have included the password in the email invitation or, for security reasons,
provided it to you in another way. If the meeting does not require a password, the

text box does not appear on this page.

Joining a meeting from an instant message

1 From the instant message window, click the link to join the meeting.
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2 On the Meeting Information page, enter the requested information.
For instance, you may be asked to enter the meeting password.
3 Click Join Now.

The Meeting window appears.

Joining from an email invitation

If you received an email invitation to a meeting, you can join the meeting by clicking
a link in the invitation.

Note: As you fill in the information requested, you may also be asked to type your username and
password. This page appears only if the meeting host requires that you have a user account to

attend the meeting.

To join a listed meeting from an invitation email message:

1 Open your email invitation, and then click the link.
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On the Meeting Information page, enter any requested information.
Click Join Now.

The Meeting window appears.

Note: If you did not receive an email invitation to a meeting, you can also join a meeting directly
from your Meeting Center Web site or from the host's Personal Meeting Room page.

Joining from the Meeting Center calendar

If you do not have an email invitation for a meeting, you can join it from the meeting
calendar, if the meeting host has listed it there.

To join a meeting listed on the meeting calendar:

1

On the navigation bar, expand Attend a meeting, and then click Browse
Meetings.

The Browse Meetings page appears.
On the meeting calendar, locate the meeting that you want to attend.
Tips for quickly finding a meeting:

= Select a view of the meeting calendar by clicking one of the following tabs:
Today, Daily, Weekly, or Monthly.

= Sort a meeting list by clicking the column headings.

= View a meeting list for another date.

= Search for a meeting.

Under Status, click Join.

On the Meeting Information page, enter any requested information.
Click Join Now.

The Meeting window appears.

You can obtain detailed information about a selected meeting or its agenda before joining it.
You can display all meeting times in another time zone.

You can refresh the meeting calendar to ensure that you are viewing the most recent
information.
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Joining a meeting from the host's personal page

You can join a meeting from the host's Personal Meeting Room page if the host has
listed it there.

To join a listed meeting from the host's Personal Meeting Room page:

1 Go to the URL, or Web address, for the host's Personal Meeting Room page. The
host must provide you with this URL.

2 On the Meetings tab and under Meetings in Progress, locate the meeting that you
want to join.

3 Under Status, click Join.
4 On the Meeting Information page, enter any requested information.
5 Click OK.

The Meeting window appears.

Tip: If the meeting is not in progress, you cannot join the meeting. To check whether the host has
started the meeting, you can periodically click the Refresh button on the page.

Joining a meeting using the meeting number

If the meeting host has not included a link to the meeting on the meeting calendar or
on his or her Personal Meeting page, you can still join that meeting. You need to
obtain the meeting number from the meeting host.

You can join a meeting by providing the meeting number on either:
= Your Meeting Center Web site

= The host's Personal Meeting page on your Meeting Center Web site, if the host
gave you the URL (Web address) for the page

Joining a meeting from the host's personal page using the
meeting number

If you want to attend a meeting that is not on the host's Personal Meeting Room page,
you can still join that meeting. Simply ask the host for the meeting number.
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To join a meeting from the host's Personal Meeting Room page:

1

Go to the URL, or Web address, for the host's Personal Meeting Room page. The
host must provide you with this URL.

On the Meetings tab and under Join an Unlisted Meeting, type the meeting
number that the host gave to you in the Meeting number box.

Click Join Now.
On the Meeting Information page, enter the requested information.
Click Join Now.

The Meeting window appears.

Joining a meeting from your Meeting Center Web site using
the meeting number

If the meeting you want to attend is not listed on the meeting calendar, you can still
join the meeting. You just need to know the meeting number, which the meeting host
can give you.

To join an unlisted meeting from your Meeting Center Web site:

1

On the navigation bar, expand Attend a meeting, and then click Unlisted
Meeting.

The Join an Unlisted Meeting page appears.

In the Meeting number box, type the meeting number that the host gave to you.
Click Join Now.

On the Meeting Information page enter any requested information.

Click Join Now.

The Meeting window appears.

Joining a meeting from your iPhone

If you receive an invitation to a meeting on your iPhone, you can join the meeting by
tapping the link in the invitation or from the Meet icon on your iPhone's home page.

To join a meeting from an email invitation link:

In your email invitation, tap the meeting link.

The WebEx Meeting Center application launches.
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To join a meeting from your Meet icon:
Open your home page, and tap the Meet icon.

The WebEx Meeting Center application launches.

Note: If you have a WebEXx account, we recommend that you sign in and save your account
settings so you can join meetings quickly in the future.

Joining a meeting from your BlackBerry device

If you have no WebEx account, join a meeting in one of these ways:

= Start the WebEx Meeting Center application and then select Join Now on the
welcome screen.

= Select the appropriate link in your email invitation or the meeting item on your
calendar.

If you have a WebEx account, follow these steps to join a meeting:
1 Start the WebEx Meeting Center application.

2 Sign in to your WebEXx account if you have not signed in or saved your account
settings.

We recommend that you save your account settings to join meetings quickly in
the future.

3 Select the meeting on the My Meetings page.

4 Select Join Meeting on the menu.

Registering for a meeting

About registering for a meeting

10

If a meeting host invites you to a meeting that requires registration, you receive an
invitation email message. The email message contains a link that you can click to
register for the meeting.

If you did not receive an email invitation to a meeting that requires registration, you
can register for the meeting on either:
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= The meeting calendar on your Meeting Center Web site

= The host's Personal Meeting Room page on your Meeting Center Web site, if the
host gave you the URL, or Web address, for the page

= Registering from an email message
= Registering from the meeting calendar
= Registering from the host’s personal page

= Obtaining information about a scheduled meeting

Registering from an email message

If you received an invitation email message for a meeting that requires registration,
you can register for the meeting from the message.

To register for a meeting from an invitation email message:
1 Open your invitation email, and then click the link to register for the meeting.
2 On the Meeting Information: [Topic] page that appears, click Register.
The Register for [Topic] page appears.
3 Provide the required information.
4  Click Register Now.

Once the host approves your registration, you receive a registration confirmation
email message. You can then join the meeting once it starts.

If the meeting is already in progress, and the host has chosen to approve all
registration requests automatically, you join the meeting immediately.

Registering from the meeting calendar

If you did not receive an invitation email message for a meeting that requires
registration, you can register for it from the meeting calendar on your Meeting Center
Web site.

To register for a meeting from the meeting calendar:
1 On the navigation bar, expand Attend a meeting, and then click Register.

The Register for a meeting page appears, showing the meeting calendar. This
calendar lists each meeting that requires registration for the current date.

2 On the meeting calendar, locate the meeting for which you want to register.

11
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4

5

6

To locate a meeting quickly, you can:

= Sort the meeting list by clicking the column headings.
= Display the meeting list for another date.

= Find a meeting.

Under Topic, select the option button for the meeting for which you want to
register.

Click Register.
On the Register for [Topic] page that appears, provide the required information.

Click Register Now.

Once the host approves your registration, you receive a registration confirmation
email message. You can then join the meeting once it starts.

If the meeting is already in progress, and the host has chosen to approve all
registration requests automatically, you join the meeting immediately.

Tip:

You can obtain detailed information about a selected meeting or its agenda before registering
for it.

You can display all meeting times in another time zone.

You can refresh the meeting calendar to ensure that you are viewing the most recent
information.

Registering from the host's personal page

12

You can register for a meeting from the host's Personal Meeting Room page on your
Meeting Center Web site.

To register for a meeting from the host's Personal Meeting Room page:

1

Go to the URL, or Web address, for the host's Personal Meeting Room page. The
host must provide you with this URL.

On the Meetings tab, do one of the following:

= |If the meeting is not currently in progress, under Scheduled Meetings, click
Register.

= If the meeting is currently in progress, under Meetings in Progress, click
Join Now. On the Join Meeting: [Topic] page that appears, click Register.

If the Log In page appears, provide your user name and password, and then click
Log In.



Chapter 2: Joining a Meeting

The Log In page appears only if the meeting host requires that you have a user
account to join the meeting. In this case, you must provide your user name and
password before you can register for the meeting.

4 On the Register for [Topic] page that appears, provide the required information.

5 Click Register Now.

Once the host approves your registration, you receive a registration confirmation
email message. You can then join the meeting once it starts.

If the meeting is already in progress, and the host has chosen to approve all
registration requests automatically, you join the meeting immediately.

Obtaining information about a scheduled
meeting

About obtaining meeting information

Before joining a meeting, you can obtain information about it from the Meeting
Information page. The information you can view includes the host's name and email
address, meeting number, and agenda. If you received an email invitation to a
meeting, you can click a link in the message to view the meeting information.

If you did not receive an email invitation from the host, you can view the meeting
information from either:

= The meeting calendar on your Meeting Center Web site

= The host's Personal Meeting Room page on your Meeting Center Web site, if the
host gave you the URL, or Web address, for the page

About the Meeting Information page
To access this page: In your invitation email message, click the appropriate link.

The Meeting Information: [Topic] page provides information about a selected
meeting. The following is a description of the information you can view from that

page.

13
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Term

Status

Date

Starting time

Duration

Meeting number

Meeting password
Teleconference
Host

Alternate host

Host's email address

Agenda

Add to My Calendar

Details

Status of the meeting can be: Not Started, Join
Now, or Registration (Meeting Center only).

Date of the meeting—for example, July 28, 2009.

Starting time for the meeting, including the time
zone—for example, 10:00 am, Pacific Standard
Time.

Length of the meeting in hours or minutes—for
example, 1 hour or 30 minutes.

Number that the meeting server assigns to a
meeting automatically.

Meeting password that the host specified.
Instructions for joining the teleconference.
Meeting host’s full name.

Appears only if the host designated one or more
participants as alternate hosts.

Host's email address.

Agenda: Displays the Agenda page, where you
can view the meeting's detailed agenda provided
by the host.

Adds the meeting to your calendar program, such
as Microsoft Outlook. Your calendar program
must support the iCalendar standard, a common
format for exchanging calendaring and scheduling
information across the Internet.

Obtaining information from an email message

14

If you receive an email invitation for a meeting, you can view the meeting

information from the email message.

To obtain information about a meeting from an invitation email message:

1 Open your invitation email message, and then click the link.

The Meeting Information appears.
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Optional. To view the meeting agenda, click View Agenda.

Obtaining information from the meeting calendar

If you did not receive an email invitation, you can obtain meeting information from
the meeting calendar on your Meeting Center Web site.

To obtain information about a meeting from the meeting calendar:

1

From the navigation bar on your Meeting Center Web site, expand Attend a
meeting.

Click Browse Meetings.

On the meeting calendar, locate the meeting about which you want to obtain
information.

Under Topic, click the link for the meeting.
If the meeting requires a password, the Get Info page appears.

If the meeting does not require a password, the Meeting Information page appears.
You can skip to step 6.

If the Get Info page appears, type the password that the meeting host gave to you
in the Meeting password box, and then click OK.

Optional. To view the meeting's agenda, click View Agenda.

The Agenda page appears.

Obtaining information from the host's personal page

You can obtain meeting information from the hosts's Personal Meeting Room page on
your Meeting Center Web site.

To obtain meeting information from the host's Personal Meeting Room page:

1

Go to the URL, or Web address, for the host's Personal Meeting Room page. The
host must provide you with this URL.

On the Meetings tab, locate the meeting about which you want to obtain
information.

Under Topic, click the link for the meeting.
If the meeting requires a password, the Get Info page appears.

If the meeting does not require a password, the Meeting Information page appears.

15
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4 If the Get Info page appears, type the password that the meeting host gave to you
in the Meeting password box, and then click OK.

5 Optional. To view the meeting's agenda, click View Agenda.

Adding a meeting to your calendar program

About adding a meeting to your calendar program

You can add a scheduled meeting to your calendar program, such as Microsoft
Outlook. This option is applicable only if your calendar program supports the
iCalendar standard, a common format for exchanging calendaring and scheduling
information across the Internet.

You can add a meeting to your calendar from either:
= The invitation email message that you receive from the host

= The Meeting Information page for the meeting, which you can access by clicking
the link for the meeting on the meeting calendar or on the host's Personal Meeting
Room page

Adding a meeting to your calendar program

16

You can add a scheduled meeting to your calendar program if your calendar program
supports the iCalendar standard.

To add a scheduled meeting to your calendar:
1 Do one of the following, as appropriate:

= In the invitation email message that you receive, click the link to add the
meeting to your calendar.

= On the Meeting Information page for the meeting, click Add to My
Calendar.

A meeting item opens in your calendar program.

2 Accept the meeting request. For example, in Outlook, click Accept to add the
meeting item to your calendar.

Note: If the host cancels the meeting, the cancellation email message that you receive contains an
option that lets you remove the meeting from your calendar program.
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About the meeting calendar

The public meeting calendar on your Meeting Center Web site provides information
about each listed meeting that is either scheduled or in progress. However, the
meeting calendar does not provide information about any unlisted meeting.

You can navigate the meeting calendar to quickly find a listed meeting - either on the
current date or any date - using one of several calendar views. For example, you can
view a meeting list for today's date only or for an entire month.

When viewing a meeting list, you can sort the list and refresh it at any time.

You can view a list of meetings that require registration.

Viewing the meeting calendar

You can open one of the following calendar views of all listed meetings:

Today Contains a list of meetings occurring on the current date, including
all meetings currently in progress and all scheduled meetings that
are not yet in progress.

Daily Contains a single list of all meetings occurring on the current date,
or on another date to which you have navigated.

Weekly Contains a list of scheduled meetings for each day of the selected
week.
Monthly Indicates on which dates meetings are scheduled for the selected

17
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month.

To open a calendar view of all scheduled meetings:
1 On the navigation bar, expand Attend a meeting to view a list of links.
2 Click Browse Meetings.
The meeting calendar appears.
3 Click the tabs to navigate to different views of the meeting calendar.

You can also view a list that includes past meetings.

You can view a list of meetings that require registration.

To include past meetings in your list of meetings:
1 Select the Today or Daily tab.
2 Select the Show past meetings check box.

The list of meetings displays accordingly for the tab.

To display a list of only meetings that require registration:
1 Select the Today, Upcoming, Daily, or Weekly tab.
2 Select the Show only meetings that require registration check box.

The list of meetings that require registration displays accordingly for the tab.

Selecting a date on the meeting calendar

You can view a list of scheduled meetings for any date on the meeting calendar.

To display a list of scheduled meetings for the previous or next day:
1 If you have not already done so, open the meeting calendar.

2 On the Daily view of the calendar page, click the forward or backward arrow to
navigate to the list of meetings for the next or previous day.

4 Friday, December 3, 2010 »

18
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Note: You can use this procedure on the Register for a Meeting page as well.

To display a list of meetings for a specific date:
1 If you have not already done so, open the meeting calendar.

On the Today, Upcoming, Daily, or Weekly tab on the calendar page, click the
Calendar icon.

The Calendar window appears, showing the calendar for the current month.
2 Optional. Do any of the following:
= To view the calendar for the previous month, click the forward arrow.

= To view the calendar for the next month, click the backward arrow.

= To view the calendar for a specific month, in the drop-down list, select a
month.

= To view the calendar for a specific year, in the drop-down list, select a year.

Su Mo Tu We Th Fr Sa

3 Click the date for which you want to view a list of meetings.

The Daily view for the date that you selected appears.

Note: You can use this procedure on the Register for a Meeting page as well.

To display a list of meetings for a specific date using the Monthly view:
1 If you have not already done so, open the meeting calendar.
2 Click the Monthly tab.

3 Click the forward or backward arrow to navigate to the list of meetings for the
next or previous month.

4 December 2010 F

4 Click a date for which you want to view a list of scheduled meetings.

The Daily view appears for the date that you selected.

19
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Note: Only dates on which an icon appears have at least one scheduled meeting.

Searching for a meeting on the meeting calendar

On the meeting calendar, you can locate a meeting by searching for text in the name
of the host or presenter, meeting topic, or meeting agenda. You cannot search for a
meeting number.

To search for a meeting:

1 If you have not already done so, open the meeting calendar.

2 Type the text for which you want to search in the Search for box.

3 Click Search.

The Search Results page appears, listing all meetings that contain the search text.

Sorting the meeting calendar

By default, meeting lists on the meeting calendar are sorted by hours, in ascending
order. However, you can sort the meeting lists by any column:

Time Sorts the meeting list by hours, in ascending or descending order.

Topic Sorts the meeting list alphabetically by topic, in ascending or
descending order.

Host or Presenter Sorts the meeting list alphabetically by host or presenter name, in
ascending or descending order.

Duration Sorts the meeting list by duration, in ascending or descending order.

To sort the public meeting calendar:

1 If you have not already done so, open the meeting calendar. For details, see
Viewing the meeting calendar.

2 Inalist of meetings on the Today, Upcoming, Daily, or Weekly tab on the
calendar page, click the column heading by which you want to sort the meetings.

20
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An ascending or descending sort indicator appears and the meetings are sorted
accordingly.

Note: You can use this procedure on the Register for a Meeting page as well.

Refreshing the meeting calendar

Information about meetings on the public Meeting Center calendar can change at any
time. Thus, to ensure that you are viewing the most current Meeting Center
information, you can refresh the Meeting Center calendar at any time.

To refresh the public Meeting Center calendar:

1 If you have not already done so, open the meeting calendar.

2 Click the Refresh button.

[S)

Selecting a language and time zone on the
meeting calendar

On the meeting calendar, you can access your Preferences page to select the language
and time zone in which you want to view meeting times. Your site administrator
specifies the default language and time zone that appears on the meeting calendar.
You may need to change the time zone, for example, if you are travelling and
temporarily in another time zone.
To select a language on the public meeting calendar:
1 If you have not already done so, open the meeting calendar.
2 Click the language link on the right side of the page.

The Preferences page appears.
3 Inthe Language drop-down list, select another language.

4 Click OK.

To select a time zone on the public meeting calendar:
1 If you have not already done so, open the meeting calendar.

2 Click the time zone link on the right side of the page.

21
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The Preferences page appears.
3 Inthe Time zone drop-down list, select another time zone.
4 Click OK.

Note:

= Your time zone selection affects only your view of your Meeting Center Web site, not
other users' views.

= If you have a user account, all meeting invitations that you send automatically specify
the meeting starting time in the time zone that you selected.

= If you select a time zone for which daylight saving time (DST) is in effect, your
Meeting Center Web site automatically adjusts its clock for daylight saving time.

Registering for a meeting from the meeting
calendar

If you did not receive an invitation email message for a meeting that requires
registration, you can register for it from the meeting calendar on your Meeting Center
Web site.

About the Register for a Meeting page

22

The Register for a Meeting page lists each meeting that requires registration. Each
page of the meeting calendar displays each meeting occurring on a given day that
requires registration, unless it is unlisted.

To select a scheduled meeting, click the option button to the left of its topic. Once you
have selected a meeting, you can click one of the following buttons on the button bar:

Click this button... To...

Fegister Register for the meeting.

Jain Mow | Join the meeting, if the meeting is currently in progress.

Get Info View detailed information about the meeting.
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Click this button... To...
Agenda | View the agenda for the meeting.

Registering for a meeting

If you find the meeting you want to register for, you can easily complete the
registration form and send it to the meeting host.

To register for a meeting:

1 Select a meeting for which the status is Registration.

2 Click Register.

3 Enter your information and click Register Now.

Once the host approves your registration, you receive a registration confirmation
email message. You can then join the meeting once it starts.

If the meeting is already in progress, and the host has chosen to approve all
registration requests automatically, you join the meeting immediately.

About the Today view

How to access this page

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings >
Today tab.

What you can do here

The Today view lists the live meetings that are scheduled for the present day,
including those in process, those concluded, and those that have not yet begun.

The meeting information displayed in the list can be sorted by clicking the column
headings.

23



Chapter 3: Using the Calendar

24

Options on this page

Option

(S

Language link

Time zone link

Show past meetings

Show only meetings that
require registration check
box

Time
Topic

Host or Presenter

Duration
Join link

P

Register link
2

Start link

»

End link

%]

Description

Click the Refresh icon at any time to display the most current list of
meetings.

Click to open the Preferences page, where you can select the
language setting for your Meeting Center Web site.

Click to open the Preferences page, where you can select the time
zone setting for your Meeting Center Web site.

Select to include concluded meetings in the list of meetings.

Select to display only those meetings that require registration in the

list of meetings.

The Ascending Sort indicator appears next to a column heading,
and the meetings are sorted by the column, in ascending order.

The Descending Sort indicator appears next to a column heading,
and the meetings are sorted by the column, in descending order.

Lists the starting time for each scheduled meeting.

Lists the scheduled meetings by name. Click the topic nhame to get
meeting information.

Lists the host or presenter for the meeting.
Lists the scheduled length of the meeting.

Indicates that the live meeting is in process.

Click the link to join the Meeting Center from the Meeting
Information page.

Click to open the Register for page, where you can enter the
required information to register for the meeting.

(Host only) Click to start your meeting.

(Host only) Click to end your meeting.
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About the Daily view

How to access this page

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings >
Daily tab.

What you can do here

The Daily view lists the live meetings that are scheduled for the present day. From the
Daily view you can navigate to the previous or next day, or use the calendar to view
the schedule for another day.

The meeting information displayed in the list can be sorted by clicking the column
headings.

Options on this page

Option Description
@ Click the Refresh icon at any time to display the most current list of
meetings.

Click to open the Preferences page, where you can select the
Language link language setting for your Meeting Center Web site.

Click to open the Preferences page, where you can select the time

Time zone link zone setting for your Meeting Center Web site.

4 Click the Previous Day icon to display a list of meetings for the
previous day.

b‘ Click the Next Day icon to display a list of meetings for the next
day.
Click the Calendar icon to open the Calendar window for the

= current month. Click on any date to open its schedule.

Show past meetings Select to include concluded meetings in the list of meetings.

Show only meetings that  Select to display only those meetings that require registration in the
require registration check | list of meetings.
box

The Ascending Sort indicator appears next to a column heading,
- and the meetings are sorted by the column, in ascending order.
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Option

Time

Topic

Host or Presenter

Duration

Join link
i

Register link
Ed

Start link
L3

End link
0]

Description

The Descending Sort indicator appears next to a column heading,
and the meetings are sorted by the column, in descending order.

Lists the starting time for each scheduled meeting.

Lists the scheduled meetings by name. Click the topic name to get
meeting information.

Lists the host or presenter for the meeting.
Lists the scheduled length of the meeting.

Indicates that the live meeting is in process.

Click the link to join the Meeting Center from the Meeting
Information page.

Click to open the Register for page, where you can enter the
required information to register for the meeting.

(Host only) Click to start your meeting.

(Host only) Click to end your meeting.

About the Weekly view
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How to access this page

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings >

Weekly tab.

What you can do here

The Weekly view lists the live meetings that are scheduled, but not ended for the

selected week.

The meeting information displayed in the list can be sorted by clicking the column

headings.



Options on this page

Option

(S

Language link

Time zone link

H

Show only meetings that
require registration check
box

Day link
Friday

Time
Topic

Host or Presenter

Duration

Join link
P

Register link
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Description

Click the Refresh icon at any time to display the most current list of
meetings.

Click to open the Preferences page, where you can select the
language setting for your Meeting Center Web site.
Click to open the Preferences page, where you can select the time

zone setting for your Meeting Center Web site.

Click the Previous Week icon to display a list of meetings for the
previous week.

Click the Next Week icon to display a list of meetings for the next
week.

Click the Calendar icon to open the Calendar window for the
current month. Click on any date to open its schedule.

Select to display only those meetings that require registration in the
list of meetings.

Opens the Daily view, which shows the scheduled meetings for the
selected day.

The Ascending Sort indicator appears next to a column heading,
and the meetings are sorted by the column, in ascending order.

The Descending Sort indicator appears next to a column heading,
and the meetings are sorted by the column, in descending order.

Lists the starting time for each scheduled meeting.

Lists the scheduled meetings by name. Click the topic name to get
meeting information.

Lists the host or presenter for the meeting.
Lists the scheduled length of the meeting.

Indicates that the live meeting is in process.

Click the link to join the Meeting Center from the Meeting
Information page.

Click to open the Register for page, where you can enter the
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(zption Description
: required information to register for the meeting.
Start link (Host only) Click to start your meeting.
L4
End link (Host only) Click to end your meeting.
7]

About the Monthly view

How to access this page

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings >
Monthly tab.

What you can do here

The Monthly view shows when the live meetings are scheduled in a monthly calendar
view. You can navigate to a specific day or week within the current month, or
navigate to the previous or next month.

Options on this page

Option Description

4 Click the Previous Month icon to display a list of meetings for the
previous month.

b‘ Click the Next Month icon to display a list of meetings for the next
month.

@ Click the Refresh icon at any time to display the most current list of
meetings.

Click to open the Preferences page, where you can select the
Language link language setting for your Meeting Center Web site.

Click to open the Preferences page, where you can select the time

Time zone link zone setting for your Meeting Center Web site.
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Option Description

Week link Opens the Weekly view, which shows the scheduled meetings for
weekls each day of the selected week.

Day link Opens the Daily view, which shows the scheduled meetings for the
4 selected day.

Appears on the calendar to indicate that one or more meetings are

scheduled on that day.

About the Search Results page

What you can do here

= Find a meeting on your Meeting Center Web site.

= Display past meetings.

= Sort the search results.

= Select a language for your Meeting Center Web site.
= Select a time zone for your Meeting Center Web site.

= Display meetings that require registration.

The meeting information displayed in the list can be sorted by clicking the column
headings.

Options on this page

Option Description
Enter a host name, meeting topic, or any text that may appear in

Search for... the agenda, and click Search.
text box Note: You cannot search for a meeting number.
@ Click the Refresh icon at any time to display the most current list of
meetings.
Click to open the Preferences page, where you can select the
Language link language setting for your Meeting Center Web site.

Click to open the Preferences page, where you can select the time

Time zone link zone setting for your Meeting Center Web site.
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Option
Show past meetings

Show only meetings that
require registration check
box

Navigation links

Date & Time

Topic

Host or Presenter

Duration

Join link
i

Register link
Ef

Start link
L3

End link
0]

Description

Select to include concluded meetings in the list of meetings.

Select to display only those meetings that require registration in the
list of meetings.

Click the page numbers or next to navigate through the search

results.

The Ascending Sort indicator appears next to a column heading,
and the meetings are sorted by the column, in ascending order.

The Descending Sort indicator appears next to a column heading,
and the meetings are sorted by the column, in descending order.

Lists the date and starting time of the meeting.

Lists the scheduled meetings by name. Click the topic name to get
meeting information.

Lists the host or presenter for the meeting.
Lists the scheduled length of the meeting.

Indicates that the live meeting is in process.

Click the link to join the Meeting Center from the Meeting
Information page.

Click to open the Register for page, where you can enter the
required information to register for the meeting.

(Host only) Click to start your meeting.

(Host only) Click to end your meeting.



Scheduling a Meeting

Choosing the scheduler that works for you

Meeting Center provides several ways to set up meetings. Review the details about
the different means of scheduling a meeting and then pick the one that meets your
needs.

Short on time?

Use the one-page Quick Scheduler. Simply enter a few details and you are ready to
host your meeting.

Looking for more meeting options, such as adding additional security?

Use the Advanced Scheduler. Enter the level of detail you need. You can schedule or
start the meeting from any page in the wizard. For details, see Using the Advanced
Scheduler.

Want to reuse the information you saved in the scheduler?

You do not have to type in the same information every time you set up a meeting. If
the meeting recurs on a regular basis, with the same attendees, you can set up a whole
series of meetings. If the meeting details (such as attendees, meeting options) are
constant, you can save those details in a template, which you can apply to any
meeting you schedule.

Note: If you decide to switch from the Advanced Scheduler to the Quick Scheduler (or from the
Quick Scheduler to the Advanced Scheduler) any information you have typed is saved and
available in the other scheduler.
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About the Quick Scheduler

Use this one-page scheduler to set up a meeting with just a few mouse clicks.

Your site administrator decides whether your site displays the Quick Scheduler or the
Advanced Scheduler, a wizard that helps you step through the process of selecting
meeting options.

If your site displays the Advanced Scheduler automatically, you can easily switch to
the Quick Scheduler. Simply click the Return to Quick Scheduler link at the top of the
Required Information page.

About the Quick Scheduler page

How to access this page
On the navigation bar, click Host a Meeting > Schedule a Meeting

If you see the Advanced Scheduler, click the link to display the Quick Scheduler.

What you can do on this page

Set up a meeting quickly, using this one-page scheduler.

Options on this page

Use this option... To...

Set options using template  Select a template and use the settings saved in that
template for this meeting.

You can save time by using a template that includes
the list of attendees you want to invite, a presentation
you want to show before the meeting starts, and other
options you have used in a previous meeting and
saved as a template.

Meeting Topic Enter the topic or a name for the meeting.
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Tracking codes

Password

Confirm password

Date

Time

Duration
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Identify your department, project, or other information
that your organization wants to associate with your
meetings. Tracking codes can be optional or
required, depending on how your site administrator
set them up.

If your site administrator requires you to select a code
from a predefined list, a list of codes appears. Select
a code from the list on the left. Then do one of the
following in the box on the right:

= If alist of codes appears, select a code from the
list.

=  Type a code in the box.

Require participants to enter the password you set to
join your meeting.

Your site may require that all passwords comply with
security criteria, such as a minimum length and a
minimum number of letters, numbers or special
characters. A password:

= Can contain a maximum of 16 characters.

=  Cannot contain spaces or any of the following
characters: \ " “/ & <>==][].

Each participant that you invite to your meeting
receives an invitation email message that includes
the password, unless you request that passwords do
not appear in email invitations.

Set the date you want the meeting to occur. Select

the month, day, and year in the drop-down lists. Or,
you can click the Calendar icon, and then select a

date.

Set the meeting's starting time and the time zone. To
select another time zone, click the time zone link.

Important The time zone you select does not
affect the time zone setting for the meeting
calendar on the Browse Meetings page. You and
each attendee can select the time zone for your
view of the calendar independently, using the
Your time zone option on the Preferences page.
To access this page, on the navigation bar, click
Set Up > Preferences.

Enter the length of time you estimate that the meeting

will continue. The meeting does not end automatically
after the duration that you set.
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Attendees

Send a copy of the invitation
email to me

Audio options

CUVC Meeting ID

Enter the email addresses of the attendees you want to invite to
your meeting.

You can type the addresses, separating them with a comma or
semicolon or you can click Select Attendees to choose attendees
from your address book.

Receive a copy of the invitation you are sending to attendees.
Later, if you decide to invite additional attendees, you can simply
forward this email message to them.

The default settings appear. To select a different option,
click Change audio option.

Enter a custom URL to create a virtual meeting room in which you
can use Cisco Unified Video (CUVC) in your meeting.

If you leave this box empty, the WebEx Meeting ID is used by
default.

When you start your WebEx meeting, the CUVC Video panel
displays automatically.

This is an optional feature that must be enabled by your site
administrator.

About the Change Tracking Code page

How to access this page

On the navigation bar, click Host a Meeting > Schedule a Meeting

If you see the Advanced Scheduler, click the link to display the Quick Scheduler.
Then click Select tracking code.

What you can do on this page

Add or remove tracking codes assigned to this meeting.

Options on this page

Use this option...
Tracking Code

To...
Assign a tracking code to this meeting.

Your site administrator provides the group name,
such as "Division," or "Department" or other
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Use this option... To...
identifier. Depending on how your site is set up,
you have one of these options:

=  Select the tracking codes from a list.

= Enter the tracking codes in the boxes
provided.

=  Both options (either select codes from a list or
type it).

About the Time Zone page

How to access this page
On the navigation bar, click Host a Meeting > Schedule a Meeting

If you see the Advanced Scheduler, click the link to display the Quick Scheduler.
Then click the current time zone link (for example, Pacific ST).

What you can do on this page

Select a different time zone for the meeting you are scheduling.

Important: The time zone you select does not affect the time zone setting for the meeting
calendar on the Browse Meetings page. You and each attendee can select the time hzone for your
view of the calendar independently, using the Your time zone option on the Preferences page. To
access this page, on the navigation bar, click Set Up > Preferences.

About the Select Attendees page

How to access this page
On the navigation bar, click Host a Meeting> Schedule a Meeting

You can select attendees from the Quick Scheduler or the Advanced Scheduler>Invite
Attendees page.

Then click the Use Address book link.

What you can do on this page
= Select contacts in your personal address book and invite them to the meeting.

= Add new contacts to your personal address book and invite them to the meeting.
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= Designate one or more invited attendees as alternate hosts.

Options on this page

Use this option... To...

Address book Select the address book from which you want to
select attendees. The contacts in the address
book that you select appear in the box. These
address books are available:

= Personal contacts: Includes any individual
contacts that you have added to your
personal address book. If you use Microsoft
Qutlook, you can import the personal
contacts that you keep in an Outlook address
book or folder to this list of contacts.

= Company address book: Your
organization's address book, which includes
any contacts that your site administrator has
added to it. If your organization uses a
Microsoft Exchange Global Address List, your
site administrator can import its contacts to
this address book.

= List: Includes any distribution lists that you
have created for your personal address book.

New Contact Add a new contact. Enter the requested
information about the new contact you want to
invite to the meeting. You can also add the new
contact to your personal address book.

Search Search for text in the selected address book. For
example, you can search for all or part of a
contact name or email address.

Invite as Add the selected contacts to the list of attendees.

Attendee: Adds the selected contacts to the list of
attendees.

Alternate Host: Adds the selected contacts as
alternate hosts to the list of attendees. An
alternate host receives an invitation email
message that provides information about acting
as the alternate host. An alternate host can start
the meeting and act as the host. If you join the
meeting after an alternate host has started or
joined it, you do not automatically assume the
host role.

An alternate host must have a user account on
your meeting service Web site.
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New Contact

Remove
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To...

Select the address book from which you want to
select attendees. The contacts in the address
book that you select appear in the box. These
address books are available:

=  Personal contacts: Includes any individual
contacts that you have added to your
personal address book. If you use Microsoft
Outlook, you can import the personal
contacts that you keep in an Outlook address
book or folder to this list of contacts.

= Company address book: Your
organization's address book, which includes
any contacts that your site administrator has
added to it. If your organization uses a
Microsoft Exchange Global Address List, your
site administrator can import its contacts to
this address book.

= List: Includes any distribution lists that you
have created for your personal address book.

Add a new contact. Enter the requested
information about the new contact you want to
invite to the meeting. You can also add the new
contact to your personal address book.

Remove the selected contacts from the list of
attendees.

About the Audio Conference Settings page

How to access this page

On the navigation bar, click Host a Meeting > Schedule a Meeting

If you see the Advanced Scheduler, click the link to display the Quick Scheduler.

Then click Change audio option.

What you can do on this page

Change the preset audio options. Please reference the Cisco WebEx Web
Conferencing Audio Controls Guide for more detailed instructions at
http://www.intercall.com/services/web-conferencing/meeting-center-resources.php.
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Using the Quick Scheduler

1 Log in to your Meeting Center Web site.
2 On the navigation bar, expand Host a meeting to view a list of links.
3 Click Schedule a meeting.

The Required Information page appears.

4 Check whether you are viewing the Advanced Scheduler. Click the Return to
Quick Scheduler link to display the Quick Scheduler.

The Advanced Scheduler consists of several pages, with the links to them on the
right side of the page. The Quick Scheduler is one page.

5 Enter the details about your meeting.
6  Start or schedule the meeting:

= If the meeting's starting time is the current time, click Start to start the
meeting.

= |f the meeting's starting time is after the current time, click Schedule.

The Meeting Scheduled page appears, confirming that the meeting is scheduled. You
also receive a confirmation email message that includes information about the
scheduled meeting.

About the Advanced Scheduler

38

When scheduling a meeting, use the Schedule a meeting wizard to set several options
for your meeting. These options allow you to customize your meeting for your
specific needs, such as additional security. Once you schedule a meeting, you can
change its options at any time, or cancel the meeting.

If another user has granted scheduling permission to you in his or her or her user
profile, you can schedule a meeting on behalf of that user.

Note: If you use Microsoft Outlook 2000 or a later version, you can schedule, start, and join an
online meeting using Outlook. For instructions on using Integration to Outlook, refer the
Integration to Outlook User's Guide, which is available on your Meeting Center Web site.
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Choosing a level of security for a scheduled
meeting

When scheduling a meeting, you can provide security for the meeting using these
means:

= Require a password: Attendees must provide the password you set before
joining the meeting. For more information, see About the Required Information

page.

= Decline to list this meeting on the meeting calendar: An unlisted meeting does
not appear in the meeting calendar on the Browse Meetings page or on your
Personal Meetings page. To join an unlisted meeting, attendees must provide a
unique meeting number. For more information, see About the Required
Information page.

= Exclude the meeting password from email invitations: If you invite attendees
to a meeting, you can prevent the password from appearing in the email
invitations that your Meeting Center Web site sends automatically to attendees.

= Require attendees to log in: You can require attendees to have a user account on
your Meeting Center Web site to join the meeting. Thus, attendees must log in to
your site before they can attend the meeting. For more information, see About the
Invite Attendees page.

= Require attendees to register for the meeting: If you require each attendee to
send a registration request to you before joining a meeting, you can accept or
reject each registration request.

Tip: Choose a level of security based on the meeting's purpose. For example, if you schedule a
meeting to discuss your company picnic, you probably need to set only a password for the
meeting. On the other hand, if you schedule a meeting in which you will discuss sensitive
financial data, you may not want to list the meeting on the meeting calendar. You may also
choose to restrict access to the meeting once all attendees have joined it.

Using the Advanced Scheduler

When scheduling a meeting, you must provide a meeting topic and a starting time.
You can also set options to customize your meeting and enhance its security.

Using the Advanced Scheduler, you can schedule a meeting quickly. You can click
the Start button at any time to start your meeting. If you have questions about the
information requested on a page, click the Help button, which is located in the upper
right corner of each wizard page.
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To start the Advanced Scheduler:

1

2

3

Log in to your Meeting Center Web site.
On the navigation bar, expand Host a meeting to view a list of links.
Click Schedule a meeting.

The Advanced Scheduler appears, showing the Required Information page.

To schedule a meeting:

1

Click Required Information.

Enter the requested information, such as the meeting topic, meeting password,
tracking codes, and whether you want to display this meeting on your meeting list.

For details, see About the Required Information page.
Click Date & Time.

Set the date and time for the meeting. You also set the meeting duration, how
many minutes in advance you will allow participants to join the meeting, whether
the meeting recurs and how often and other information related to meeting times.

Click Teleconference.

Set up a teleconference for the meeting. Select the type of teleconference (call
back or call in) or Integrated VolP (Optional. Please check with your site
administrator if it is enabled on your site).

Click Invite Attendees.

Enter the email addresses of the attendees you want to invite or you can select
them from your contact list. You can also make your meeting more secure by:

= Selecting the option not to send the meeting password in the meeting
invitation.

= Requiring attendees to have an account on your Web site before they can join
a meeting.

For details, see About the Invite Attendees page.
Click Registration.

If you want to have participants register for the meeting, select information to be
requested on registration page.

Click Agenda & Welcome.

Type an agenda for the meeting or a welcome message for attendees, which they
can view before the meeting starts. Select a file that you want to open
automatically in each attendee's Meeting window once he or she joins the
meeting.
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7 Click Meeting Options.

Select the meeting options you want to be available to all participants during the
meeting. You can also choose an alert to play once a participant either joins or
leaves the teleconference.

8 Click Review.

You view all the information you've entered on each page of the Advanced
Scheduler. If you need to make a change, return to that page in the wizard and edit
the information.

9 Optional. Save your meeting settings in a template.

If you may need to use these same meeting settings (for example, with the same
attendees, telephony options, and other meeting details), you can save the settings
in a meeting template.

10 Start or schedule the meeting:

= |If the meeting's starting time is the current time, click Start to start the
meeting.

= If the meeting's starting time is after the current time, click Schedule.

The Meeting Scheduled page appears, confirming that the meeting is scheduled.
You also receive a confirmation email message that includes information about
the scheduled meeting.

Page-by-page guide to the Advanced Scheduler

Scheduling a meeting can be done in one click, or you can take a bit of time and set
up audio conferencing options, invite attendees, assign privileges, and select other
options in advance of the meeting. If you have questions about any options or how to
complete the information requested on any page in the Advanced Scheduler, refer to
these topics:

About the Required Information page

How to access this page

On the navigation bar, click Host a meeting > Schedule a meeting > Required
Information
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What you can do on this page
= Set up a meeting on behalf of someone else.

You can select the hosts you want to include in the Schedule for drop-down list
from the list of hosts available in the Profiles area of My WebEX.

= Select the type of meeting you are setting up.
= Define a topic for the meeting.
= Indicate whether the meeting is listed on the meeting calendar.

= Decide whether the meeting is deleted from My Meetings on My WebEXx after it is
over.

= Set the meeting password, if required.

= Select tracking codes, if your administrator has set them up.

Options on this page

Use this option... To...

Set options using template | Select a template and use the settings saved in that
template for this meeting.

You can save time by using a template that includes
the list of attendees you want to invite, a presentation
you want to show before the meeting starts, and other
options you have used in a previous meeting and
saved as a template.

Meeting type Select the type of meeting you want to schedule.

The list includes the meeting types that are available
for your service website.

Meeting topic Enter the topic or a name for the meeting.

Listed on calendar List this meeting on the meeting calendar.

To enhance meeting security, you can opt not to list
the meeting on the meeting calendar. Just remove the
check mark from this option to:

= Hide information about the meeting, such as its
host, topic, and starting time.

=  Help prevent unauthorized access to the
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Delete from My Meetings
when completed

Meeting password

Confirm password

Tracking codes

CUVC Meeting ID
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To...
meeting.

Remove this meeting from your list of meetings in the
My Meetings area of My WebEXx after the meeting
ends.

If you do not select this option, you must delete this
meeting from My Meetings to remove it from the list.

Require participants to enter the password you set to
join your meeting.

Your site may require that all passwords comply with
security criteria, such as a minimum length and a
minimum number of letters, numbers or special
characters. A password:

= Can contain a maximum of 16 characters.

=  Cannot contain spaces or any of the following
characters: \ " “/ & <>==[].

Each participant that you invite to your meeting
receives an invitation email message that includes the
password, unless you request that passwords do not
appear in email invitations.

Identify your department, project, or other information
that your organization wants to associate with your
meetings. Tracking codes can be optional or required,
depending on how your site administrator set them
up.

If your site administrator requires you to select a code
from a predefined list, a list of codes appears. Select
a code from the list on the left. Then do one of the
following in the box on the right:

= If alist of codes appears, select a code from the
list.

=  Type a code in the box.

Enter a custom URL to create a virtual meeting room in
which you can use Cisco Unified Video (CUVC) in your
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Use this option... To...
meeting.

If you leave this box empty, the WebEx Meeting ID is
used by default.

When you start your WebEx meeting, the CUVC Video
panel displays automatically.

This is an optional feature that must be enabled by your
site administrator.

Questions about required information for setting up a meeting

Why set up an unlisted meeting?

You can prevent a scheduled meeting from appearing on the meeting calendar and any
other publicly accessible pages on your Meeting Center Web site, by setting up an
unlisted meeting. If a meeting is unlisted, the meeting details, such as its host, topic,
and starting time are not available on the calendar and other places. This additional
security may help prevent unauthorized access to the meeting.

To join an unlisted meeting, a participant must provide a unique meeting
number.

If you invite a participant to an unlisted meeting, the participant receives an invitation
email message that includes complete instructions for joining the meeting-including
the meeting number-and a URL that links directly to a Web page on which the
participant can join the meeting.

What are tracking codes?

Your site administrator can include tracking codes in the Advanced Scheduler.
Tracking codes may identify your department, project, or other information that your
organization wants to associate with your meeting. Tracking codes can be optional or
required, depending on how your site administrator sets them up.

How can | learn more about the fields on the Required Information page?

Click the Help link in the top right corner of the Required Information page, or review
About the Required Information page.
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About the Date & Time page

How to access this page

On the navigation bar, click Host a meeting > Schedule a meeting > Date & Time

Date & Time

Raturn to Quick Scheduler

Maating date: [29 #|[December
Meeting tme: m

200w Hequired Information

Data & Time

m Hew York Time

Teleconterence

F Anendees can join |5 %] minutes before star time

P Attendess can also connect to awdio conference

Egtimated duration: |1h  =||0mn =
Emall reminder: |15 =] mirwtes betore meetng starts
Recurrence: & Mone © Daily © Wisakly © Monthly © Yeary

cancal | Save 3% template |

What you can do on this page
= Set the date and time for the meeting.
= Set the duration for the meeting.

= Select the number of minutes before the meeting's starting time during which
attendees can join the meeting.

= Select the number of minutes before the meeting you want to receive a reminder
email message.

= Set a recurrence pattern for the meeting.

Options on this page

Use this option... To...

Set options using template | Select a template and use the settings saved in that
template for this meeting.

You can save time by using a template that includes
the list of attendees you want to invite, a presentation
you want to show before the meeting starts, and other
options you have used in a previous meeting and
saved as a template.

Meeting date Set the date you want the meeting to occur. Select
the month, day, and year in the drop-down lists. Or,
you can click the Calendar icon, and then select a
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Use this option...

Meeting time

Attendees can join [X]
minutes before the starting
time

Attendees can also connect
to audio conference

Estimated duration

Email reminder

Recurrence
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To...
date.

Set the meeting's starting time and the time zone. To
select another time zone, click the time zone link.

Important The time zone you select does not affect
the time zone setting for the meeting calendar on the
Browse Meetings page. You and each attendee can
select the time zone for your view of the calendar
independently, using the Your time zone option on
the Preferences page. To access this page, on the
navigation bar, click Set Up > Preferences.

Allow attendees to join the meeting within a set
number of minutes before the meeting's starting time.

Note: If you clear this check box or set this option to 0
minutes, you must start the meeting before attendees
can join it.

If you allow attendees to join the meeting before the
scheduled starting time, you can also allow attendees
to join the InterCall audio conference before the
meeting starts.

You set up the InterCall Reservationless-Plus audio
conference on the next page.

Enter the length of time you estimate that the meeting
will continue. The meeting does not end automatically
after the duration that you set.

Set the number of minutes before the meeting's
scheduled starting time at which you want to receive
a reminder email message. If you do not want to
receive a reminder, in the drop-down list, select
None.

Set the recurrence pattern for this meeting.

None: Specifies that the meeting does not recur.



Use this option...

Ending

To...
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Daily: Repeats the meeting every day until the ending
date that you select.

Every [x] Days: Repeats the meeting after the
specified number of days passes.

Every weekday: Repeats the meeting each day,
from Monday to Friday.

Weekly: Repeats the meeting after a specified
number of weeks until the ending date that you select.

Every [x] week(s) on: Specifies the day of the
week on which to repeat the meeting and the
number of weeks that must pass before the
meeting repeats.

Sunday - Saturday: Specifies the day on which
the meeting repeats. You can select one or more
days.

Monthly: Repeats the meeting every month until the
ending date that you select.

Day [x] of every [x] month(s): Specifies the
specific day of the month on which to repeat the
meeting, and the number of months that pass
before the meeting repeats.

[x] [x] of every [x] month(s): Specifies the
specific week and day of the week on which to
repeat the meeting, and the number of months
that pass before the meeting repeats.

Yearly: Repeats the meeting every year until the
ending date that you select.

Every [month] [date]: Specifies the specific
month and date on which to repeat the meeting
each year.

[x] [day] of [month]: Specifies the specific
week, day of the week, and month on which to
repeat the meeting each year.

No end date: Repeats the meeting indefinitely.
That is, the meeting recurs until you cancel it.

Ending: Specifies the last day on which the
meeting recurs. You can select the month, day,
and year in the drop-down lists. Or, you can click
Calendar icon, and then select a date.

After [x] meetings: Specifies the number of
meetings after which the meeting stops recurring.
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Questions about setting the date and time for a meeting

Does the meeting end automatically at the time | set?

You can set the time a scheduled meeting starts and the meeting's estimated duration.
This information allows attendees to reserve the appropriate length of time in their
schedules. The meeting does not end automatically after the duration you set.

What happens if | allow participants to join the meeting before the start time?

Participants can see the agenda and other details about the meeting. You can also set
up a presentation to inform or entertain the participants while they wait for the
meeting to start. You set up this option on the Agenda & Welcome page.

The option to let participants join the meeting before the host is available only if the
administrator for your meeting service has turned the option on for your site and you
schedule the meeting for a time in the future.

About the Audio Conference page
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How to access this page:

On the navigation bar, click Host a Meeting > Schedule a Meeting >
Teleconference

Relun to Ouick Scheduler 7]

Integrated VolP: & Ho
© Yos

© Other telaconterence serace Py

€ Hone
Entry and exit tone: | Beep E

What you can do on this page

= Select or modify the InterCall Reservationless-Plus audio account that you want
to use during your web conference. Please reference the Cisco WebEx Web
Conferencing Audio Controls User Guide for more detailed instructions on using
your audio account.



Options on this page

Use this option...

Set options using template

Select conference type

Entry & exit tone
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To...

Select a template and use the settings saved in that template
for this meeting.

You can save time by using a template that includes the list of
attendees you want to invite, a presentation you want to show
before the meeting starts, and other options you have used in
a previous meeting and saved as a template.

Select the type of audio conference option(s) you would like to
use.

For more details about using InterCall Reservationless-Plus
audio integration, see the Cisco WebEx Web Conferencing
Audio Controls User Guide.

This drop down does not select the sound option you want
participants to hear when joining or leaving a meeting while
using InterCall Reservationless-Plus audio integration. To
modify these settings, please go to www.intercallonline.com or
select *3 on your telephone keypad when you have dialed into
the audio conference service.

How can | learn about the fields on the Audio Conference Settings page?

Please reference the Cisco WebEx Web Conferencing Audio Controls User Guide by
going to the Support menu on the left hand navigation bar > User Guides > Cisco

WebEx Meeting Center.

About the Invite Attendees page

How to access this page

On the navigation bar, click Host a meeting > Schedule a meeting > Invite

Attendees.
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What you can do on this page

Invite attendees to your meeting, by entering their email addresses or selecting them

from your address book.

Options on this page

Use this option...

Set options using template

Attendees

Request that attendees
verify rich media players
before joining meeting

Send a copy of the invitation
email to me

To...

Select a template and use the settings saved in that
template for this meeting.

You can save time by using a template that includes
the list of attendees you want to invite, a presentation
you want to show before the meeting starts, and other
options you have used in a previous meeting and
saved as a template.

Enter the email addresses of the attendees you want to
invite to your meeting.

You can type the addresses, separating them with a comma
or semicolon or you can click Select Attendees to choose
attendees from your address book.

Add a request to invitation email messages for attendees to
verify that these components are installed on their
computers for playing a UCF media file:

=  Flash Player for playing a Flash movie or interactive
Flash files.

=  Windows Media Player for playing audio or video files.

This option is useful if you or another presenter plans to
share a UCF multimedia presentation or standalone UCF
media files during the meeting.

Receive a copy of the invitation you are sending to
attendees. Later, if you decide to invite additional attendees,
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Use this option... To...
you can simply forward this email message to them.

Select Attendees/Edit Opens the Select Attendees page. You can select contacts
Attendees button in your personal address book to invite to the meeting.

You can also add a new contact to your address book and
then invite that contact to your meeting.

Security Exclude password from email invitations: If you invite
attendees to a meeting, the meeting password does not
appear in the email invitations that attendees receive. You
must provide the password to attendees by another means,
such as by phone.

Require attendees to have an account on this Web site
to join this meeting: All attendees must have a user
account on your site to attend the meeting.

For information about how attendees can obtain a user
account, ask your site administrator.

Questions about inviting attendees

What is an alternate host?

When inviting attendees to a scheduled meeting, you can designate one or more
attendees as alternate hosts for the meeting. An alternate host can start the meeting
and act as the host. Thus, an alternate host must have a user account on your Meeting
Center Web site.

Once you invite an attendee to a meeting as an alternate host, the attendee receives an
invitation email message that provides information about acting as the alternate host.
Your scheduled meeting appears on the alternate host's My WebEx Meetings page.

Can | invite people using my online address book?

You do not have to type the email address of each person you want to invite to your
meeting. You can select attendees and sales team members (for Sales Center
meetings) from your address book.

You can access your address book from the Invite Attendees page (for Meeting
Center meetings) or the Invite Participants page (for WebEx Sales Center meetings) in
the Advanced Scheduler.

Which information is included in the email invitation to my meeting?

Each attendee that you invited receives an invitation email message, which includes:
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= A link that the attendee can click to join the meeting or obtain more information
about it.

= The meeting password, if you specified one.

= Teleconferencing information, if your meeting includes an integrated
teleconference.

= The meeting number, which the attendee must provide if your meeting is unlisted.

After you start a scheduled meeting, you can invite additional attendees. For details,
see .Inviting attendees to a meeting in progress.

Why should | request that attendees check their systems for UCF
compatibility?

When scheduling a meeting, you can add a request to invitation email messages for
attendees to verify that the following components are installed on their computers for
playing Universal Communications Format (UCF) media files:

= Flash Player for playing a Flash movie or interactive Flash files.
= Windows Media Player for playing audio or video files.

This option is useful if you or another presenter plans to share a UCF multimedia
presentation or standalone UCF media files during the meeting.

Your request automatically appears in any invitation email messages that you send to
attendees using the Advanced Scheduler invitation options. Your request also includes
a link that attendees can click to access the Verify Rich Media Players page on your
Meeting Center Web site. This page allows attendees to automatically verify that the
required players are installed on their computers.

Note: If you intend to allow attendees to share to share UCF multimedia presentations or
standalone UCF media files, ensure that the Enable UCF rich media for attendees check box is
selected on the Meeting Options page in the Advanced Scheduler.

How can | learn about the fields on the Invite Attendees page?

Click the Help link in the top right corner of the Invite Attendees page, or review
About the Invite Attendees page.

Can | use my online address book to invite attendees?

You do not have to type the email address of each person you want to invite to your
meeting. You can select attendees from your address book.

You can access your address book from the Invite Attendees page in the Advanced
Scheduler.
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How can | enhance meeting security?

When scheduling a meeting, you can require all attendees to have a user account on
your site. If you include this requirement (an option on the Invite Attendees page),
attendees must log in to your Meeting Center Web site to attend the meeting, which
enhances meeting security.

Each invited attendee automatically receives an invitation email message. To help
increase the security for your meeting, you can prevent the meeting password from
appearing in these invitations by selecting the Exclude password from email
invitation option on the Invite Attendees page. If you exclude the password in email
invitations, however, you must provide the password to attendees using another
method-for example, by phone.

About the Select Attendees page

How to access this page

On the navigation bar, click Host a Meeting> Schedule a Meeting > Invite
Attendees > Select Attendees.

What you can do on this page:
= Select contacts in your personal address book and invite them to the meeting.
= Add new contacts to your personal address book and invite them to the meeting.

= Designate one or more invited attendees as alternate hosts.

Options on this page

Use this option... To...

Address book Lets you select the address book from which you
want to select attendees. The contacts in the
address book that you select appear in the box.
The following address books are available:

Personal contacts: Includes any individual
contacts that you have added to your personal
address book. If you use Microsoft Outlook, you
can import the personal contacts that you keep in
an Outlook address book or folder to this list of
contacts.

Company address book: Your organization's
address book, which includes any contacts that
your site administrator has added to it. If your
organization uses a Microsoft Exchange Global
Address List, your site administrator can import
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Use this option... To...
its contacts to this address book.

New Contact Opens the New Contact page. Enter the
requested information about the new contact you
want to invite to the meeting. You can also add
the new contact to your personal address book.

Search Lets you search for text in the selected address
book. For example, you can search for all or part
of a contact name or email address.

Invite as Attendee: Adds the selected contacts to the list
of attendees.

Alternate Host: Adds the selected contacts as
alternate hosts to the list of attendees. An
alternate host receives an invitation email
message that provides information about acting
as the alternate host. An alternate host can start
the meeting and act as the host. If you join the
meeting after an alternate host has started or
joined it, you do not automatically assume the
host role.

An alternate host must have a user account on
your meeting service Web site.

Remove Removes the selected contacts from the list of
invitees.

About the Registration page

How to access this page:

On the navigation bar, click Host a Meeting> Schedule a Meeting > Registration
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What you can do on this page

Determine whether attendees must register to attend a meeting.

If attendees must register, select which information attendees must provide on the

registration form.

Accept registration requests automatically.

Options on this page

Use this option... To...

Set options using template

Select a template and use the settings saved in that
template for this meeting.

You can save time by using a template that includes the list
of attendees you want to invite, a presentation you want to
show before the meeting starts, and other options you have
used in a previous meeting and saved as a template.

Registration = None: Specifies that attendees need not register to

attend the meeting.

= Require attendee registration: All attendees must
register to attend the meeting. An attendee cannot
attend the meeting until his or her registration you
accept his or her registration request.

You can accept registration requests in either of two ways:

=  Automatically, by selecting the Automatically accept all
registration requests option on this page.

=  Manually, by using the options on the Registered
Attendees page. For details, see Accepting or Rejecting
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Use this option... To...
Registration Requests.

Obtain detailed attendee Select which information attendees must provide to register

information for the meeting. Information that you do not select still
appears on the form, but attendees need not provide it to
register for the meeting.

Automatically accept all Accept all registration requests automatically, and lets all

registration requests registrants attend the meeting. You do not receive
registration requests. If this option is not selected, you must
accept or reject each registration request individually, using
the options on your meeting service Web site.

Questions about registration

What are the benefits of requiring attendees to register for a meeting?

You can require meeting attendees to register for a meeting before they can join it.
Requiring registration allows you to:

= View a list of attendees to determine whether they have registered for the meeting.

= Obtain attendees' names, email addresses, and optionally additional personal
information before they can join the meeting.

= Accept or reject individual registration requests.
= Increase the security of your meeting.

If you invite an attendee to a meeting that requires registration, the attendee receives
an invitation email message that includes information about the meeting and a link
that the attendee can click to register for the meeting.

Important: If you accept registration requests automatically for a meeting that requires a
password—and an attendee registers after the meeting has already started—the attendee can join
the meeting immediately, without providing the password. Therefore, to secure a meeting from
unauthorized access, you must clear the Automatically accept all registration requests check box,
and manually accept or reject all registration requests.

If you do not accept registration requests automatically for a meeting that requires a password—
and an attendee registers after the meeting has already started—the attendee cannot join the
meeting until he or she receives a registration confirmation email message and can provide the
meeting password. During the meeting, you can check for registration requests in your email
program and accept them to allow attendees to join the meeting.

56



Chapter 4: Scheduling a Meeting

How do | accept or reject registration requests?

If you scheduled a meeting for which attendees must register, you can accept or reject
attendees' registration requests. If you accept a registration request, a registration
confirmation email message which provides the meeting password, if any is sent the
attendee. If you reject a registration request, a registration rejection email message is
sent to the attendee.

Note: If you select the Automatically accept all registration requests check box on the
Registration page, all registration requests are accepted automatically and a registration
confirmation email message is sent to each attendee who registers.

To accept or reject registration requests:

1 Log in to your meeting service Web site. For details, see Logging In to Your
Meeting Service Web Site.

2 On the navigation bar, click My WebEXx.

The My Meetings page appears, showing a list of any meetings that you have
scheduled.

3 Inthe list of meetings, click the meeting topic link for the meeting for which you
want accept or reject registration requests.

The Meeting Information page appears.
4  Click Attendees.

The Registered Attendees page appears, showing a list of attendees who have
registered for the meeting.

5  Select the check box for each attendee for whom you want to accept or reject a
registration request.

= To select all attendees currently appearing in the list, click Select All.
= To clear all selections in the current list, click Clear All.
6 Opt to approve or reject selected registration requests.

= Click Accept to approve the registration requests for all attendees that you
selected.

= Click Reject to reject the registration requests for all attendees that you
selected.

Tip: You can sort the registered attendees list by clicking the column headings.

You can also open the Registered Attendees page by selecting the meeting on the public Browse
Meetings page. Then click Get Info> Attendees.
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About the Agenda & Welcome page
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How to access this page

On the navigation bar, click Host a meeting > Schedule a meeting > Agenda &
Welcome.
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What you can do on this page
= Enter an agenda for your meeting.
= Choose a template for the Info tab in the Meeting window.

= Automatically show a document or presentation to participants once they join the
meeting.

Options on this page

Use this option... To...

Set options using template  Select a template and use the settings saved in that
template for this meeting.

You can save time by using a template that includes
the list of attendees you want to invite, a presentation
you want to show before the meeting starts, and other
options you have used in a previous meeting and saved
as a template.



Use this option...
Agenda

Info tab templates

Automatically share
presentation or document
once a participant joins the
meeting
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To...

Set the agenda for the meeting. You can type up to
2500 characters, including spaces and punctuation. The
agenda appears on the Meeting Information page for
the meeting on your meeting service Web site.

Lets you choose a template for the Info tab, which
appears in the content viewer during the meeting. The
Info tab contains information about the meeting, such
as the:

=  Meeting host
=  Teleconference phone numbers
=  Host key (if you are the host)

If you are using WebEx Sales Center:You can
choose another template only if your site administrator
has provided one or more customized Info tab
templates for your meeting service.

Select a presentation or document to share
automatically after a participant joins the meeting. This
option is useful if you allow attendees to join the
meeting before the host.

The file that you select must:

=  Be in the Universal Communications Format
(UCF). For information about creating UCF files,
refer to the guide, Getting Started with WebEx
Universal Communications Toolkit, which is
available on your meeting service Web site.

= Reside in your personal folders on your meeting
service Web site. You can select a UCF file that
already resides in your folders, or upload a new file
to your folders while scheduling a meeting.
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Use this option... To...

=  Browse Opens the Add/Select Presentation page. You can
select a UCF presentation or document that resides in
your personal folders, or upload a new file to your

folders.

= Delete Delete the selected presentation or document from the
box.

= Start automatically Have presentation slides or document pages advance
automatically in the content viewer at the time interval
you choose.

=  Select this option only if the presentation or
document contains multiple slides or pages.

= Do not select this option if the presentation or
document contains UCF media files.

Continuous play: Available only if you select Start
automatically. Specifies that shared presentation or
document restarts once it is finished, and continues

advancing page automatically.

Advance page every [x] seconds: Available only if
you select Start automatically. Lets you select the
frequency at which slides or pages advance
automatically.

Allow participants to control file: Let participants
navigate the presentation or document independently in
their content viewers. The slides or pages do not
advance automatically.

Select this option if the presentation or document
contains only one slide or page, or if it contains any
UCF rich media objects, such as audio or video objects.

Quick Start Select this option to display the Quick Start page to
host and presenter at the start of the meeting. If not
selected, the Info page displays at the start of the
meeting.

The Quick Start page provides easy access for sharing
a document, application, Web browser or other item
with participants.

About the Add/Select Presentation page

How to access this page

On the navigation bar, click Host a Meeting >Schedule a Meeting >Agenda &
Welcome > Browse
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What you can do on this page

= Upload a new Universal Communications Format (UCF) file to your personal
folders, and then select it.

= Select an UCF presentation or document that already resides in your personal
folders.

The file that you select plays automatically for a participant once the participant joins
the meeting.

Tip: The file that you select must be in the WebEx Universal Communications Format (UCF).

Options on this page

Use this option... To...

Upload a file to My Folders Select a UCF presentation or document that
resides on your computer, and upload it to your
personal folders.

To upload a file, under Select, select the folder in
which you want to upload the file. Click Browse,
select the file on your computer, and then click
Open. Click Upload.

Select a presentation to share Select a UCF presentation or document that
automatically already resides in your personal folders.
Done Save your file selection, and then return to the

Agenda & Customizable Welcome page.

Questions about setting the agenda and welcome message

Can | change how the information on the Info tab displays?

You can choose a template for the Info tab, which appears in the content viewer
during the meeting. The Info tab contains information about the meeting, including
the meeting host, teleconference phone numbers, and host key (for the host only).

Note: You can choose another template only if one or more customized Info tab templates are
available for your meeting service. Your site administrator can add templates for your service.
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What is the Quick Start page?

The Quick Start page allows a presenter to quickly display a document, application or
other item they want to share during a meeting. If the Quick Start option is selected by
the host on the Meeting Agenda & Welcome page, Quick Start is available to
participants throughout the meeting by clicking the Quick Start tab in the content
viewer.

For more details about any of the actions available from Quick Start, click the Learn
More link.

Can | change the meeting agenda or add one after | have set up my meeting

You can easily edit a scheduled meeting. You can edit it from the link in the
confirmation email message you received or from your Meeting Center Web site.

Why share a document before the meeting starts?

When scheduling a meeting, you can select a presentation or document to share
automatically in the content viewer once a participant joins the meeting. If the
presentation or document contains multiple pages, you can also automatically advance
its pages at a specified interval.

You can use this opportunity to share a presentation that informs or entertains
participants while they wait for you to start the meeting.

The presentation or document that you select must:

= Be in the Universal Communications Format (UCF). Reside in your personal
folders in the My WebEx area on your Meeting Center Web site. You can select a
UCF file that already resides in your folders, or upload a new file to your folders
while scheduling a meeting.

Important: If you sharle a UCF multimedia presentation that includes rich media files-such as

audio or video files-follow these guidelines:

= Ensure that each media file is embedded in the presentation file or resides on a publicly
accessible Web server. If the presentation contains a link to a media file that resides on your
computer, participants cannot view that media file.

= Select Allow participants to control file on the Agenda and Welcome page. If you do not
select this option, the pages or slides in the document or presentation will advance
automatically, which may prevent participants from viewing the media files.

=  Ensure that each media file is set to play automatically for participants.
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About the Meeting Options page

How to access this page

On the navigation bar, click Host a Meeting > Schedule a Meeting > Meeting
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What you can do on this page

= Select which options, such as chat, notes, and video are available during the
meeting.

= Allow presenters to transfer files and meeting participants to download these files
of the meeting.

= Specify whether attendees can share UCF rich media files.

Options on this page

Use this option... To...

Set options using template  Select a template and use the settings saved in that
template for this meeting.

You can save time by using a template that includes
the list of attendees you want to invite, a presentation
you want to show before the meeting starts, and other
options you have used in a previous meeting and
saved as a template.
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Use this option...
Meeting Options

Note: A presenter can change the default privileges for all attendees or individual attendees at

64

To...

Select which meeting options are available during the
meeting. If an option is not selected, it is unavailable
during the meeting.

A presenter can turn any option on or off during the
meeting.

Chat: Specifies that chat options are available in the
Meeting window during the meeting.

Video: Specifies that video options are available in the
Meeting window during the meeting.

=  Single-point: Lets only the presenter send live
video during the meeting.

=  Multipoint: Lets the presenter and up to three
other participants send live video during the
meeting.

=  Single-point and Multipoint options appear only
if your meeting service Web site has the
multipoint video option. To turn on the multipoint
video option for your site, please contact your
InterCall sales representative.

Notes Specifies that note-taking options are available
in the Meeting window during the meeting.

. Allow participants to take notes: Lets all
participants take their own notes during the
meeting, and save them to their computers.

. Single note taker: Lets only one participant take
notes during the meeting. By default, the host is
the note-taker, but can designate another
participant as the note-taker during the meeting. A
note-taker can publish notes in all participants'
Meeting windows at any time during the meeting.
The host can send a transcript of the notes to
participants at any time.

File transfer: Specifies that the presenter can publish
files and attendees can download them during a
meeting.

Enable UCF rich media for attendees: Allows
attendees to share Universal Communications Format
(UCF) media files during the meeting, either in a UCF
multimedia presentation or as standalone UCF media
files. A meeting host who is also the presenter can
always share UCF media files, whether or not you
select this check box.
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any time during a meeting.

Questions about setting meeting options

What are some rules of thumb for sharing UCF media files?

When scheduling a meeting, you can allow attendees to share Universal
Communications Format (UCF) media files during the meeting, either in a UCF
multimedia presentation or as standalone UCF media files.

You can also prevent attendees from sharing UCF media files during a meeting. If
you do so, only the meeting host can share UCF media files when also acting as the
presenter.

You may want to prevent attendees from sharing UCF media files, for example, if you
intend to allow attendees to share presentations or documents but want to prevent an
attendee from inadvertently sharing a very large media file.

Note: The alerts options are applicable only if you select an integrated teleconference on the
Teleconference page in the Advanced Scheduler.

About the Attendee Privileges page

How to access this page

On the navigation bar, click Host a meeting > Schedule a meeting > Attendee

Privileges
Attendee Privileges St options using femplate; | 50T D0
Retuss (o Quick Schedule !_-i:_l
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[F] Wirs siteades &
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What you can do on this page

= Select the meeting privileges that attendees have once the meeting starts.

Note: A presenter can grant any privileges to or remove them from attendees during a meeting

Options on this page

Use this option... To...

Set options using template | Select a template and use the settings saved in that
template for this meeting.

You can save time by using a template that includes
the list of attendees you want to invite, a presentation
you want to show before the meeting starts, and other
options you have used in a previous meeting and
saved as a template.

Privileges Select privileges that you want attendees to have
when meeting begins.
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Save

Print

Annotate

View participant list

View thumbnails

Control applications,
Web browser, or
desktop remotely

View any document

View any page

Contact operator
privately

Participate in private
chat with:
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To...

Save any shared documents, presentations, or
whiteboards that appear in their content viewers.

Print any shared documents, presentations, or
whiteboards that appear in their content viewers.

Annotate any shared documents or presentations, or
write and draw on shared whiteboards that appear in
their content viewers, using the toolbar that appears
above the viewer. An attendee's annotations are
visible to all participants.

View the participant list on the Participants panel.

Display miniatures of any pages, slides, or
whiteboards in any document, presentation, or
whiteboard that appear in their content viewers.

However, attendees with this privilege cannot display
a miniature at full size unless they also have the View
any page privilege.

Request that the presenter grant them remote control
of a shared application, Web browser, or desktop.

View any document, presentation, or whiteboard that
appears in the content viewer, and navigate to any
pages or slides in documents or presentations.

View any pages, slides, or whiteboards that appear in
their content viewers. This privilege allows attendees
to navigate independently through pages, slides, or
whiteboards.

Dial 00 at any time during a teleconference to contact
the operator for your teleconferencing service.
Available only if your site includes the private operator
option.

Send private chat messages to another participant.
Private chat messages appear only in the recipient's
Chat viewer.

Host: Chat privately with the meeting host.
Presenter: Chat privately with only the presenter.

All attendees: Chat privately with any other attendee.
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Questions about attendee privileges

Besides the host, who can grant and remove attendee privileges?

A presenter can grant any privileges to or remove them from attendees during a
meeting.

Can | change attendee privileges during a meeting?

Yes, you can. On the Meeting menu, choose Attendees Privileges. Make any changes
to the privileges you set when you scheduled the meeting.

About the Review page

How to access this page

On the navigation bar, click Host a Meeting > Schedule a Meeting > Review

What you can do on this page

= Review all the information you've entered on each page of the Advanced
Scheduler.

= If you want to make any changes, return to the page where you entered the
information and enter new information.

= Rather than using the settings and options you have just selected in the scheduler,
replace these setting with those in one of the meeting templates.

When you have finished making changes, click Schedule or Start.

Managing and maintaining your scheduled
meetings
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You can easily invite more participants to a scheduled meeting, change the day or
time, or even add the meeting to your calendar program.
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Adding a scheduled meeting to your calendar program

Once you schedule a meeting, you can add the meeting to your calendar program,
such as Microsoft Outlook. This option is applicable only if your calendar program
supports the iCalendar standard, a common format for exchanging calendaring and
scheduling information across the Internet.

To add a scheduled meeting to your calendar:

1 Do one of these tasks, as appropriate:
= On the Meeting Scheduled page, click Add to My Calendar.
= On the Meeting Updated page, click Update My Calendar.

= On the Meeting Information page for the meeting, click Add to My
Calendar.

= In the confirmation email message that you receive once you schedule or edit
a meeting, click the link to add the meeting to your calendar.

A meeting item opens in your calendar program.

2 Select the option to accept the meeting request. For example, in Outlook, click
Accept to add the meetingitem to your calendar.

Note:

= If you cancel a meeting, the Meeting Deleted confirmation page and the confirmation email
message that you receive contains an option that lets you remove the meeting from your
calendar program.

= |If you invite attendees to a meeting, the invitation email message that they receive contains
an option to add the meeting to their calendar programs.

Editing a scheduled meeting

Once you schedule a meeting, you can make changes to it at any time before you start
it-including it’s starting time, topic, password, agenda, attendee list, and so on.

If you update any information about a meeting, including adding or removing
attendees, you can choose to send attendees a new invitation email message that
informs them that you have modified information about the meeting. Attendees whom
you removed from the attendee list receive an email message informing them that you
have retracted their invitations.

You can modify a meeting from the confirmation email message that you received
after you scheduled the meeting or from your meeting list in My WebEXx.
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To edit a meeting from the confirmation email message:
1 Open your confirmation email message, and then click the link.

If you are not already logged in to your Meeting Center Web site, the Log In page
appears.

2 Ifthe Log In page appears, provide your account user name and password, and
then click Log In.

The Meeting Information page appears.
3 Click Edit.

4 Modify the meeting. For more information about the options that you can modify,
see Using the Advanced Scheduler.

5 To save your changes to the meeting, click Save.

If you invited attendees, a message appears, asking you whether you want to send
an updated email invitation to attendees.

6 If a message box appears, click the appropriate update option, and then click OK.
The Meeting Updated page appears.

You receive a confirmation email message that includes information about the
changes that you made to the meeting.

7 Optional. If you added the meeting to your calendar program, such as Microsoft
Outlook, on the Meeting Updated page, click Update My Calendar.

To edit a scheduled meeting from your meeting list on your Meeting Center
Web site:

1 Log in to your Meeting Center Web site.
2 On the navigation bar, click My WebEXx.

The My Meetings page appears and displays each meeting that you have
scheduled.

3 In the meeting list, under Topic, click the topic for the meeting.
4 Click Edit.

5 Modify the meeting. For more information about the options that you can modify,
see Using the Advanced Scheduler.

6 Click Save.

If you invited attendees, a message appears, asking you whether you want to send
an updated email invitation to attendees.

7 If a message box appears, click the appropriate update option, and then click OK.
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If you click Cancel in the message box, the meeting is not updated.

The Meeting Updated page appears. You receive a confirmation email message
that includes information about the changes that you made to the meeting.

8 Optional. If you added the meeting to your calendar program, such as Microsoft
Outlook, in the confirmation email message, click Update My Calendar.

Starting a scheduled meeting

A meeting does not start automatically at the scheduled time. If, when scheduling the
meeting, you did not select the option that allows participants to join the meeting
before the host, you must start the meeting before participants can join it.

After you schedule a meeting, you receive a confirmation email message that includes
a link that you can click to start the meeting. Or, you can start the meeting from your
meeting list in My WebEXx.

To start a meeting from the confirmation email message:
1 Open your confirmation email message, and then click the link.

If you are not already logged in to your Meeting Center Web site, the Log In page
appears.

2 Ifthe Log In page appears, provide your account username and password, and
then click Log In.

The Meeting Information page appears.
3 Click one of the following:
= Start Now. Appears if the meeting is not in progress.

= Join Now. Appears if you allowed participants to join the meeting before its
starting time and participants have already joined the meeting.

The Meeting window appears.

To start a scheduled meeting from your meeting list on your Meeting Center
Web site:

1 Log in to your Meeting Center Web site.
2 On the navigation bar, click My WebEXx.

The My Meetings page appears, displaying a list of each meeting that you have
scheduled.

3 In the meeting list, under Status, click one of the following:

= Start. Appears if the meeting is not in progress.
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= Join Now. Appears if you allowed participants to join the meeting before its
starting time and participants have already joined the meeting.

The Meeting window appears.

Starting a meeting from your iPhone

A meeting does not start automatically at the scheduled time. If, when scheduling the
meeting, you did not select the option that allows participants to join the meeting
before the host, you must start the meeting before participants can join it.

Note: To start a WebEx meeting from your iPhone, you must have set up your WebEXx account
from the Profile page in your iPhone application.

To start a meeting from an email invitation link:
In your email invitation, tap the meeting link.

The WebEx Meeting Center application launches.

To start a meeting from your My Meetings page:
1 Tap the meeting you want to start.

2 On the next page, tap on the Join/Start button.
The WebEx Meeting Center application launches.

Canceling a scheduled meeting
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You can cancel any meeting that you have scheduled. Once you cancel a meeting, you
can choose to send a cancellation email message to all attendees whom you invited to
the meeting. Canceling a meeting deletes it from your personal meeting list.

You can cancel a meeting from the confirmation email message that you received
after you scheduled the meeting or from your meeting list in My WebEXx.

To cancel a meeting from a confirmation email message:
1 Open your email confirmation message, and then click the link.

If you are not already logged in to your Meeting Center Web site, the Log In page
appears.

2 Ifthe Log In page appears, provide your account user name and password, and
then click Log In.

The Meeting Information page appears.
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Click Delete.

If you invited attendees, a message appears, asking you whether you want to send
a cancellation email message to all attendees whom you invited to the meeting.

In the message box, click Yes or No, as appropriate.
If you click Cancel in the message box, the meeting is not canceled.
The Meeting Deleted page appears.

Optional. If you added the meeting to your calendar program, such as Microsoft
Outlook, on the Meeting Deleted page, click Remove From My Calendar to
remove the meeting from your calendar.

To cancel a scheduled meeting from your meeting list on your Meeting Center
Web site:

1

2

Log in to your Meeting Center Web site.

On the navigation bar, click My WebEXx.

The My Meetings page appears, showing your scheduled meeting list.
In the meeting list, under Topic, click the topic for the meeting.

Click Delete.

If you invited attendees, a message appears, asking you whether you want to send
a cancellation email message to all attendees whom you invited to the meeting.

In the message box, click Yes or No, as appropriate.
If you click Cancel in the message box, the meeting is not canceled.
You receive a cancellation confirmation email message.

Optional. If you added the meeting to your calendar program, such as Microsoft
Outlook, in the confirmation email message, click the link to remove the meeting
from your calendar.

Saving time when scheduling a meeting
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Using meeting templates

If you meet with the same group of people and often schedule a meeting with the
same tracking codes, audio settings and other meeting options, you can save these
settings in a template. When you set up the first meeting, you can save your settings in
a template. Later, when it is time to schedule another meeting, you can select that
template from any page on the Quick Scheduler or Advanced Scheduler.

You have three ways to use an existing meeting template:
= Use the template, without saving any changes to it.

You can use the template as is or make changes to the settings without saving
these changes to the template itself.

= Make changes to the template settings and save the changes in the template.

You can save these changes in the template, if you want to make permanent
changes to the template.

= Make changes to the template settings and save them in a new template.

You can make changes to the template as you schedule your meeting. Then save
your changes in the template, if you want to make a permanent change to the
template.

Using an existing template for scheduling

You can use the template without making changes to any details, or you can make
changes on any page in the scheduler.

1 Log in to your Meeting Center Web site.
2 On the navigation bar, expand Host a meeting to view a list of links.
3 Click Schedule a meeting.

The meeting scheduler appears.

4 Select the template you want to use in the Set options using template drop-down
list.

Look for the list on any title bar in the Quick Scheduler or Advanced Scheduler.

These templates are available. You can select one from this list

Wendor meeting . X ;
and use it to quickly schedule your meeting

Customer meeting
Department meeting
Team meeting

“Wendor meeting

The template in brackets is the default template provided by your
site administrator.

— Standard Templates —
[Meeting Center Default]
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5 Optional. Make changes to the settings on any page.

For instance, you can add or remove attendees or show a new presentation as
attendees join the meeting. Just go to the page in the scheduler that you want to
change.

6 Start or schedule the meeting:

= If the meeting's starting time is the current time, click Start to start the
meeting.

= If the meeting's starting time is after the current time, click Schedule.

The Meeting Scheduled page appears, confirming that the meeting is scheduled.
You also receive a confirmation email message that includes information about
the scheduled meeting.

Using an existing meeting template and overwriting the template
settings

You can open an existing meeting template and change the settings. You can save
your changes to the template.

1 Log in to your Meeting Center Web site.
2 On the navigation bar, expand Host a meeting to view a list of links.
3 Click Schedule a meeting.

The meeting scheduler page appears.

4 Select the template you want to use in the Set options using template drop-down
list.

These templates are available. You can select one from this list and use it

|\/endnrmeeting
' to quickly schedule your meeting.

Customer meeting
Department meeting
Team meeting

Wendor meeting

The template in brackets is the default template provided by your site
administrator.

— Standard Templates —
[Meeting Center Default]

5 Make changes to the details on any page.

For example, you can add or remove attendees, change the meeting time, add a
multimedia document to display before the meeting starts.

6 Click Save as Template.
You see a list of templates you can assign these new settings to.

7 To update an existing meeting template with your changes, select the template
you want to change and click Save.
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A message box appears, asking if you want to replace the template you have
selected with the edited template.

8 To save your changes in the template, click OK.

Save as template... Type a name for this new version of the
template here.

Ta save your current settings to
an existing template (to
overyrite), choose t from the
list.

— My Templates —
Customer meeting
Diepartment meetin

Then click Save.

Note: You have not changed the original
template.

“endor meeting

Template name: Team mesting
I” Save as a standard template Save Cancel

Using an existing meeting template and saving the changes in a new
template

You may host a meeting series with the same agenda, but different attendees. To save
time, you can reuse the settings in a template, make changes (such as adding or
removing attendees) and then save the updates in a new template.

Find the existing meeting template with similar settings. You can save the changes in
a new template.

1 Log in to your Meeting Center Web site.
2 On the navigation bar, expand Host a meeting to view a list of links.
3 Click Schedule a meeting.

The meeting scheduler appears.

4 Select the template you want to use in the Set options using template drop-down
list.

Customer meeting

Department meeting
Team meeting
Wendor meeting

— Standard Templates —
[Meeting Center Default]

5 Make changes to the details on any page.

For example, you can add or remove attendees, change the meeting time, add a
multimedia document to display before the meeting starts.
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7

Click Save as Template.
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In the Template Name box, type a name for this new template.

Save as template...

To save your current settings to
an existing template (o
overvrite), choose t from the
list.

— by Templates —
Customer meeting
Diepartment meetin

“endor meeting

Tearm mesting

I™ Save as a standard template

Template name:

Save Cancel

8

Click Save.

Setting up a recurring meeting

For a meeting that occurs on a regular basis, such as a monthly company meeting or
weekly status meeting, you can set up a recurring meeting. You set up the meeting
one time and include the email addresses of attendees, the teleconferencing details,
the time and interval (for instance, daily, weekly, or monthly). You send out one
invitation for the entire series.

To set up a recurring meeting:

1

2

3

Log in to your Meeting Center Web site.

On the navigation bar, expand Host a meeting to view a list of links.

Click Schedule a meeting.

The Schedule a meeting Wizard appears, showing the Required Information page.

Click Date & Time.

Set the date and time for the meeting. Review the information below about the
options for a recurring meeting.

Add other details about your recurring meeting.

When you have finished scheduling your meeting, click Schedule or Start.
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Options for setting up a recurring meeting

Option Description
Daily Repeats the meeting every day until the ending date that you select.

= Every [x] days: Repeats the meeting after the specified number of
days passes.

= Every weekday: Repeats the meeting each day, from Monday to
Friday.

=  Weekly: Repeats the meeting every week until the ending date that
you select.

= Sunday - Saturday: Specifies the day on which the meeting
repeats every week. You can select one or more days.

Monthly Repeats the meeting every month until the ending date that you select.

= Day [x] of every [x] months: Specifies the specific day of the
month on which to repeat the meeting, and the number of months
that pass before the meeting repeats.

= [x] [x] of every [x] months: Specifies the specific week and day of
the week on which to repeat the meeting, and the number of
months that pass before the meeting repeats.

Yearly Repeats the meeting every year until the ending date that you select.

= Every [month] [date]: Specifies the specific month and date on
which to repeat the meeting each year.

= [x] [day] of [month]: Specifies the specific week, day of the week,
and month on which to repeat the meeting each year.

Ending = No end date: Repeats the meeting indefinitely. That is, the meeting
recurs until you cancel it.

= Ending: Specifies the last day on which the meeting recurs. You
can select the month, day, and year in the drop-down lists. Or, you
can click Calendar icon, and then select a date.

After [x] meetings: Specifies the number in the meeting series after
which the meeting stops recurring.

Allowing another user to schedule meetings for you
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You can grant permission to one or more Meeting Center users to schedule meetings
on your behalf. A user to whom you grant permission to schedule meetings must have
an account on your Meeting Center Web site.



Chapter 4: Scheduling a Meeting

Once a user schedules a meeting for you, the meeting appears in your list of meetings
on your My Meetings page. You can then start the meeting and host it as you
normally do when you schedule meetings yourself.

To allow another user to schedule meetings for you:

1

2

3

)]

Log in to your Meeting Center Web site.

On the navigation bar, click My WebEXx.

Click My Profile.

The My Profile page appears.

Under Session Options, do either or both of the following:

= In the Scheduling permission box, type the email addresses of the users to
whom you want to grant scheduling permission. Separate multiple addresses
with either a comma or semicolon.

= Click Select From Host List to select users from a list of all users who have
accounts on your Meeting Center Web site.

Click Update.

About the Meeting Scheduled page (for meeting

hosts)

This confirmation page appears after you have scheduled a meeting successfully.

What you can do on this page

Add this meeting to your meeting calendar (MS Outlook or Lotus Notes).

Edit the details about the meeting you have just scheduled.

Click this button... To...

Add to My Calendar Add this meeting to your calendar program (MS
Outlook or Lotus Notes only).

Make changes to the meeting you have just

Edit | scheduled. For example, you can change the day

and time or invite additional attendees
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About the Meeting Information page (for meeting

hosts)
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This page provides the details about a meeting you have scheduled.

What you can do on this page

= Review the date, time, duration, and other helpful information about the meeting.

Edit the details about the meeting you have just scheduled.

=  Start the meeting.

Add the meeting to your calendar, if you haven’t already done so.

Click this button... To...

Start this meeting immediately.
Start Mo g y

Appears only if the meeting is not yet in progress.

: Edit the details about this meeting. For example,
Edit you can add attendees, change the agenda,
change the date, time, and duration.

Delete Cancel this meeting.

View the list of registered attendees.

Aftendees Appears only if the meeting requires attendees to
register.

Review the meeting agenda.

Agenda To edit or add an agenda, click Edit and then go
to the Edit and Customizable Welcome page.

i JEE|

Add this meeting to the calendar program, such
as Microsoft Outlook.

Add to My Calendar To use this feature, your calendar program must
conform with the iCalendar standard, a format
used widely across the Internet for exchanging
calendar information.

Go Back Return to the meeting calendar.

i
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About the Meeting Information page (for

attendees)

This page provides the details about a meeting you have scheduled.

What you can do on this page

= Review the date, time, duration, and other helpful information about the meeting.

= Add the meeting to your calendar, if you haven’t already done so.

Click this button...

Join Mow |

Agenda

Add to by Calendar

Go Back |

To...

Join this meeting.

If this meeting requires you to register, the
registration form for this meeting appears.

Appears only if the host has started this meeting.

Review the meeting agenda.

Add this meeting to the calendar program, such
as Microsoft Outlook.

To use this feature, your calendar program must
conform with the iCalendar standard, a format
used widely across the Internet for exchanging
calendar information.

Return to the meeting calendar.

About the Meeting Updated page

This confirmation page displays after you have updated a meeting successfully.

What you can do on this page

= Add this meeting to your meeting calendar (MS Outlook or Lotus Notes).

= Make additional changes to the meeting you have just updated.
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Click this button...

Lpdate iy Calendar

Edit |

To...

Add this updated meeting to your calendar
program (MS Outlook or Lotus Notes only).

Make changes to the meeting you have just
updated. For example, you can change the day
and time or invite additional attendees.



Assigning Sounds to
Participant Actions

Host only

During a meeting, you can assign sounds to play when a participant:
= Joins the meeting

= Leaves the meeting

= Clicks Raise Hand on the Participants panel

To assign sounds to participant actions:
1 Open the Preferences dialog box by performing these steps:
= Windows: On the Edit menu, choose Preferences.

= Mac: On the Meeting Center menu, choose Preferences.

N

Depending on your operating system, follow one of these steps:
= Windows: Click the Participants tab.
= Mac: Select the Alerts button.

3 Select the check box for each action for which you want to play a sound.

N

Select a sound from the appropriate drop-down list.

By default, the drop-down list contains the names of all sound files that reside at
the default location on your computer.

5 To select a sound that does not appear in the drop-down list, follow one of these
steps:

= Windows: Click Browse, and then select a sound file that resides in another
folder.
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= Mac: Select Other in the drop-down list.
6 Windows only. To play the currently selected sound, click the button =,
7 Click OK.

Note:

= Meeting Center saves your sound preferences on your computer. However, if you start or join
a meeting on another computer, you need to set your preferences again on that computer.

= |f you are using Windows, sound files must have a .wav extension.

= In most cases, the default location for sound files is C:\WINDOWS\Media. You can copy
other sound files to the default folder or any other directory to make them available in the
Preferences dialog box.
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Granting Privileges During a
Meeting

Once a meeting starts, all participants are automatically granted meeting privileges
either by host specification or by default:

= If the host scheduled the meeting and specified privileges, participants receive
those privileges.

= If the host scheduled the meeting but did not specify privileges, participants
receive default privileges.

= If the host started an instant meeting, participants receive default privileges.

The following table describes the privileges a host can grant and those that are granted
by default.

Privileges

; = |F\.h-bn.p:|us | 3 A host can g_ra_mt the following privileges to one
or more participants:

g Aoy

! =  Chat-who a participant can chat with and

srorrtied :mf’ ; | whether that chat can be private.
z :’:’ e . = Document-whether a participant can draw
- Gither peafickiarts on a document or save or print it.
Commuicts  Paopants = View-what a participant can view in the

meeting: participant list, document,

Selact the presieges that you mant bo smgn ko 8 partcipanks.

| Domment Ve Hesting thumbnails, or pages.
[ Pk [+ & bt ™ Shars documents . ..
Eei ) || s e = Meeting-whether a participant can record
¥ docLenit u .
I savm e Ak thon the meeting, share documents, or control
[ st e sharing.
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Selecting participants

During a meeting, you can grant privileges to or remove them from all participants at
once or to an individual participant.

To choose
B} 7 ticioar - Commuricate |p,,t.cw = all participants-select All Participants.
ET
Maeiah = anindividual participant-expand All
Commirication .. . e
Participants, and select the a participant name.

Particpant can chat:
Priwately with

W Hest

¥ Presenter

[¥ Cithier partio
Publichy with

¥ Everyone

¥ assion al predleges J

T A e S S S SN T PR

About Default privileges

If the host does not specify privileges when scheduling a meeting, or starts an instant
meeting, a set of default privileges are automatically assigned to a participant:

= All chat privileges
= Viewing the participant list

= Controlling shared applications, web browser, or desktop remotely

Granting or removing privileges

To grant participant privileges during a meeting:

1 In the Meeting window, on the Participant menu, choose Assign Privileges.
The Participants Privileges dialog box appears.

2 Grant or remove a privileges, as follows:
= To grant a specific privilege, check its box.

= To grant all privileges, check the Assign all privileges check box.
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= To remove a privilege, clear its check box.
= To reset to the preset meeting privileges, select Reset to Meeting Defaults.

Select Assign.

Granting or removing Chat privileges

As host, you can grant or remove chat privileges for one or more participants.

Granting

To grant or remove a chat privilege:

CoMmTunicake |F's|ﬁl.i|.|e| L ]

i 200 0 b e md iyl 2 et el et g ﬁ--dn-—--in---u.lulJ

4 You can chat with participants privately or
*} publicly.

Commmunication 4 Select or clear the checkbox for each

Participart: can chat: oo b privilege you want to grant.
Privakehy vath r

¥ Hast

T e a———

W Presenter
¥ cther participants
Publchy with

W Everyona
L

Chat privileges:

Host-chat privately with the meeting host. Your chat message appears in only the
host's Chat viewer.

Presenter-chat privately with the presenter. Your chat message appears in only
the presenter's Chat viewer.

Other participants-chat privately with another participant. Your chat message
appears in only that participant's Chat viewer.

Everyone-Chat publicly with all participants. Your chat message appears in
everyone's Chat viewer.

Contact operator privately-Available only if your site includes the private
operator option. Participants dial 00 at any time during a teleconference to contact
the operator of the teleconferencing service.

or removing document privileges

As host, you can assign privileges for saving, printing, and annotating documents,
whiteboards, and presentations that are shared in the content viewer.
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To grant or remove a document privilege:

Communicate  Participants |

s
a-Du:ume;t e
™ Print W Participant list
[T Arnotats ™ &ny document
[T Zave ™ Thumbnails
r &Ny page

@5 that you weant b0 assion to al particpants

Masbireg
[~ Share documents

¥ Conbrol shared
applcations,
‘e browser, or
deskbop remobely

[T Recard & meeting

Select or clear the checkbox for each
privilege you want to grant.

A participant uses the Annotation toolbar that appears whenever a document is being

shared to:

=  Draw on shared elements.

= Point to items on shared elements.

Granting or removing viewing privileges
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To grant or remove a viewing privilege:

Comimunicate  Participants

Seleck: thee privieges that you want bo assion
Document Vigw ———
™ Print ¥ Participant list
[ Brnotate I &y document
M save T Thumbnails

r Any page

1o al participants
~Masbirg

[~ Share documents

¥ Conbrol shared
applcations,
e browser, o
deskbop remobely

I Recard & meeting

Select or clear the checkbox for each
privilege you want to grant.

Viewing privileges you can grant to participants:

= Participant list-view the names of all other participants on the Participants panel.
If this option is not selected, participants can view the names of only the meeting
host and the presenter on the Participants panel.

=  Thumbnails-display miniatures, or thumbnails, of any pages, slides, or
whiteboards in the center viewer. This privilege allows participants to view
miniatures at any time, regardless of the content that appears in the presenter's
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content viewer.If participants have this privilege, they can display any page at full
size in the content viewer, regardless of whether they also have the Any page
privilege.

Any page-view any pages, slides, or whiteboards that appear in the content
viewer. This privilege allows participants to navigate independently through
pages, slides, or whiteboards.

Any document-view any document, presentation, or whiteboard that appears in
the content viewer, and navigate to any pages or slides in documents or
presentations.

Granting or removing meeting privileges

To grant or remove a viewing privilege:

Select or clear the checkbox for each

Comimunicale  Participants e
- perllege you want to grant.

Selack the privileges that you weant bo assion bo 3l parbidpents

Dszummsnt Wiaw Mastireg

I Print ¥ Partiopant list [~ Share dacuments
[ Brnotate | &nv document ¥ Conbrol shared
[ save [~ Thumbnsits akcations,

“Wieh browser, o

[ Ay page dskbop remaobeh

[T Record & meeting

Document privileges you can grant:

Share documents-share documents, presentations, and whiteboards, and copy
and paste any pages, slides, and whiteboards in the content viewer. Participants
can share UCF rich media presentations or files only if the host selected the option
to enable UCF rich media for participants when scheduling the meeting.

Control shared applications, Web browser, or desktop remotely-request
remote control of a shared application, Web browser, or desktop. If this privilege
is cleared, the command to request remote control is unavailable to participants.

Record a meeting-record all interactions during a meeting and play them back at
any time.
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Using Integrated Voice
Conferences

An Integrated VVoice Conference allows participants to speak to each other using voice
over Internet Protocol (\VolP)-an Internet-based way of connecting through the
computer.

Your user role in an Integrated Voice conference determines your level of
participation. Whichever role you take, the following table describes the basic tasks
associated with that role.

Task description:
Start and manage a voice conference:

=  Fine tune your microphone and speaker seetings.

= Allow a participant to speak mute or unmute
participant microphones.

Conpeiber Gt for B |
| Irdwgrates Yorn Crdewn

To start a voice conference:

ik} TPvaolo

bt =  Select Voice Conference on the Quick Start page.

= or, select Integrated Voice Conference > Start
Conference from the Audio menu.

@ To end a voice conference:

Select Integrated Voice Conference > End
Conference from the Audio menu.

Wi Conlersnce
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Asking

92

Task description:

Participant Participate in a voice conference:
{2 s = Join or leave a conference.

E [ I = Mute or unmute your microphone.
J% e M i | = Ask to speak.

To join a voice conference:

=  Select Yes in the dialog box that automatically

@ appears when the host starts the conference.
=  Or, select Integrated Voice Conference > Join
Yoler Conforance Conference from the Audio menu.

T —— To leave a voice conference:

R oo T AL b A L8 Corpenanc Select Integrated Voice Conference > Leave
s wand b paatiopabat !
Conference from the Audio menu.

Note: For better audio quality and greater convenience, use a computer headset with a high-
quality microphone, rather than speakers and a microphone.

to speak

Participant only

During a voice conference, you can indicate that you want to speak. If you do request
to speak, you can cancel the request at any time. Speaking in an Integrated voice
conference.
To request to speak, or to cancel a request to speak:

On the Participants panel, click Raise Hand or Lower Hand, respectively.

r} Raize Hand

= If you ask to speak, the raised-hand indicator appears on the Participant panel for
the host and presenter.

= If you cancel a request to speak, the raised-hand indicator is removed from the
Participant panel for the host and presenter.
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Allowing a participant to speak

Host only

Once you start a voice conference, participants can join the conference and listen to
the meeting audio. Up to seven participants can speak at a time.

You can specify which participants can speak, by passing the microphone.

To allow a participant to speak in a voice conference:

1 On the Participants panel, select the name of the participant whom you want to
allow to speak.

2 At the bottom of the panel, select Pass Mic.
/2 Pass Mic

An indicator appears near the participant's name on the panel.

The participant can now speak until you either pass the microphone to another
participant or mute the participant's microphone.

Note: A request to speak can be made at any time during a meeting, by clicking Raise Hand on
the Participants panel.

f} Raige Hand

Speaking in a voice conference

If you are a current speaker, the method by which you speak depends on the speaker
setup option that is currently selected for your meeting:

= Desktop speakers (default): If this option is selected, the following appears in
the bottom-right corner of your Meeting window:

A Press to speak |

Press the Ctrl key on your keyboard while speaking. Pressing this key mutes your
speakers, thereby preventing your voice from echoing in the conference.

= Headset: If this option is selected, the following appears in the bottom-right
corner of your Meeting window:
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I

Speak Now

Simply speak into your microphone.

Tip: Before you join a voice conference, you can use the audio setup wizard to select you audio
device and adjust its settings.

Muting and unmuting microphones in an audio
conference

94

The following table illustrates how to quickly mute and unmute microphones in your
meeting depending on your user role.

Role Task description:
Host Windows: Right click in the Participants =  Mute on Entry to mute all
panel microphones automatically when
participants join a meeting.
Particapant s Cheat (X} Mikes w
* 2% parbicipants T3 * Mute or Unmute to mute or
o unmute your own or a specific
participant's microphone .
w D Rplsacco Coe fdces ool .
Change Rale Ta " = = Mute All to mute or unmute all
i a - )
. | _ participant microphones
oM [ | simultaneously at any time
sissign Privieges. . during a meeting .
Mute
idnmipta Al
Participant Select the Mute or Unmute icon to
Mac:Ctrl + click in the Participants panel | mute or unmute your own
o microphone.
10 (e l;
& 1 Rebecos Com Gdes)
1 Mariah

The microphone icon to the right changes state.
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Muting and unmuting all participant microphones
simultaneously

Host and presenter only

You can mute or unmute all participant microphones simultaneously.

This option does not affect the host's and presenter's microphones.

Partiopants Chat @ rotes ” To mute or unmute all participants:
= L5 VO Bl = Wwindows: Right click on the participants
peaing panel.
T e — || = Mac: Ctrl + click on the participants panel.
Charge Role Ta ®
oo E#  Select Mute All or Unmute All.
o &3
Asmgn Frivieges. .

Liremiita &

The microphone icon to the right of each participant's name changes state.

Understanding the speaker queue for a voice
conference

During an Integrated Voice conference, a participant can request to speak.

After a participant requests to speak, the participant's place in the speaker queue is
indicated by a number to the right of the Integrated Voice indicator.

The speaker queue lets you keep track of the order in which participants have
requested to speak. To let a participant speak, you can pass the microphone to the
participant.

Once you pass the microphone to a participant, the speaker queue renumbers the
remaining participants. For example, speaker 2 in the queue becomes speaker 1.
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Fine tuning your microphone and speaker
settings

96

The first time you use an integrated voice conference, the audio wizard walks you
through selecting your sound device, and setting your speaker volume and
microphone level.

Any time before you start or join a meeting, you can manually open the wizard to test
your device again, or make further adjustments, as necessary.

To open the wizard and adjust your sound settings:
1 From the meeting window menu, select Audio > Computer Setup for Audio.

2 Follow the wizard instructions.



Setting Up a One-Click
Meeting

About setting up a One-Click Meeting

Setting

WebEx One-Click allows you to start a meeting instantly from your desktop (desktop
version) and from your WebEXx service Web site (Web version). You can set up one or
both versions, depending on your needs.

Web version: allows you to start a One-Click Meeting from your WebEXx service Web site. Doing
so does not require you to download any application. Desktop version: if this feature and the
Productivity Tools feature are enabled by your site administrator, allows you to start and join
meetings and send meeting invitations without logging in to your WebEXx service site or navigating
Web pages.

up your One-Click Meeting on the Web

The One-Click Meeting Setup page allows you to specify options a One-Click
Meeting. You can return to the One-Click Meeting Setup page at any time to modify
your meeting.

The settings you specify apply to both the One-Click Web version and the desktop
version.

To set up your One-Click Meeting:
1 Log in to your WebEx Service Web site.
2 Click My WebEx > Productivity Tools Setup (on the left navigation bar).
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4

5

The Productivity Tools Setup page appears.

On this screen, you can also download WebEx Productivity Tools, which include
the desktop version of One-Click and its shortcuts.

Click Set Up Now.

The One-Click Setup page appears.

Specify the meeting information and settings on the page.
Click Save.

Tip: Whenever you want to edit options for your One-Click Meeting, return to the One-Click
Settings page by clicking My WebEx > Productivity Tools Setup > Edit Settings.

About the One-Click Settings page
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How to access this page:

On your WebEXx service Web site, do one of the following:

If you are setting up your One-Click Meeting for the first time, on your WebEXx
service Web site, click My WebEx > Productivity Tools Setup (on the left
navigation bar) > Set Up Now.

If you already set up your One-Click Meeting, on your WebEXx service Web site,
click My WebEx > Productivity Tools Setup (on the left navigation bar) > Edit
Settings.

What you can do here:

Set options for your One-Click Meeting.

Meeting Options

Use this option... To...

Service type Select the type of WebEXx session for which you want to start a

One-Click Meeting.

This option lists only the session types available for your site and
user account.



Use this option...

Meeting template

Topic
Meeting password
Confirm password

Listed on calendar

CUVC Meeting ID

Tracking Codes

Use this option...

Tracking code

Audio Conference

Use this option...
Use

Chapter 8: Setting Up a One-Click Meeting

To...

Select the meeting template you want to use to set options for
your One-Click Meeting. The drop-down list of templates includes:

Standard templates: Templates that your site administrator set
up for your account.

My Templates: Any personal templates that you created by
saving the settings for a meeting you previously scheduled, using
the scheduling options on your site.

Specify the topic for the meeting.
Specify the password for the meeting.
Type the password again to prevent typing errors.

Specify that the meeting appears on the calendar on your site.
Available for meetings and sales meetings only.
(CUVC Integration to Meeting Center only) Enter a custom URL to

create a virtual meeting room in which you can use Cisco Unified
Video (CUVC) in your meeting.

If you leave this box empty, the WebEx Meeting ID is used by
default.

When you start your WebEx meeting, the CUVC Video panel
displays automatically.

To...

Identify your department, project, or other information that
your organization wants to associate with your meetings.
Tracking codes can be optional or required, depending on
how your site administrator set them up.

If your site administrator requires you to select a code from a
predefined list, click the link Select Code, and then select a
code from the list or enter one in the box above.

To...
Select your InterCall Reservationless-Plus audio account to
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Use this option... To...
use.

Installing WebEx Productivity Tools

100

If your site administrator has enabled you to download WebEXx Productivity Tools,
you can start you can start or join meetings instantly using One-Click; start meetings
instantly from other applications on your desktop, such as Microsoft Office, Web
browsers, Microsoft Outlook, IBM Lotus Notes, and instant messengers; and schedule
meetings using Microsoft Outlook or IBM Lotus Notes without going to your WebEx
service site.

Before installing WebEx Productivity Tools, ensure that your computer meets the
following minimum system requirements:

= Microsoft Windows 2000, XP, 2003, Vista
= Microsoft Internet Explorer 6.0 SP1 or 7.0, or Firefox 3.0 or later
= Intel x86 (Pentium 400MHZ +) or compatible processor

= JavaScript and cookies enabled in the browser

To install WebEx Productivity Tools:

1 Log in to your WebEXx service Web site.

2 Click My WebEx > Productivity Tools Setup (on the left navigation bar).
The Productivity Tools Setup page appears.

3 Click Install Productivity Tools.
The File Download dialog box appears.

4 Save the installation program to your computer.
The name of the installation file has an .msi extension.

5 Run the installation file and follow the instructions.

6 Once you complete installation, log in using your WebEx account information and
then verify your WebEx settings for Productivity Tools, including One-Click, in
the WebEXx Settings dialog box.

After you have logged in, the WebEx One-Click panel and shortcuts appear.
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The Help in the WebEx One-Click panel also provides detailed information about
how to use the One-Click panel and shortcuts.

Open One-Click

Skart Meeting MNow
Start Audio Only Meeting
Start a Scheduled Meeting. ..

Schedule a Meeting. ..
Join a Meeting...

Connect to My Computers, .,

WebEx Settings. ..

Help F1
Abouk ‘WebEx One-Click., ..

Exxit

Starting a One-Click Meeting

Before you start a One-Click Meeting from your WebEx Service Web site, ensure that
you set up One-Click settings.

To start a One-Click Meeting from your WebEX service Web site:
1 Log in to your WebEx Service Web site.
2 Click My WebEXx > Start One-Click Meeting.

My WebEx Meetings

o Go to My Personal Meeting Room [, _Start a One-Click Meeting

Your meeting starts.

If your site includes Meeting Center, you can also start a One-Click Meeting from this
specific service.

To start a One-Click Meeting from the Meeting Center service:
1 Log in to your WebEXx service Web site, and click Meeting Center.

2 On the left navigation bar, click Host a Meeting > One-Click Meeting.
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= Host a Meeting
Schedule a Meeting

My Meetings

One-Click Meeting

My Recorded
Meetings

Your meeting starts.

To start a One-Click Meeting using the WebEx One-Click panel:
1 Open your WebEx One-Click panel by doing any of the following:
= Double-click the WebEx One-Click shortcut on your desktop.

= (o to Start > Programs > WebEx > Productivity Tools > WebEx One-
Click.

= Right-click the WebEx One-Click icon on the taskbar of your desktop.

QEE N gy EY 1206RM

If you did not specify automatic login, enter the required WebEx account
information in the dialog box, and then click Log In.

2 On the WebEx One-Click panel, click Start Meeting.
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("™ WebEx One-Click

Meet Mo

E& - |Enter email or mobile of meeking number -

ﬁ Join Meeting

Qi Skark Meeting

Skark Scheduled Meeting
Meet Later

g Schedule Mesting

&2 Edit WebEx Settings

To start a One-Click Meeting using a One-Click shortcut:

Click one of the following shortcuts:

Shortcut Description
Open One-Click Right-click menu of taskbar icon shortcut:

= Right-click the WebEx One-Click taskbar
icon and then click Start meeting now to
start an instant meeting.

=  Right-click the WebEx One-Click taskbar
Schedule a Meeting. .. icon and then click Start a Scheduled
Meeting to start a previously scheduled
meeting, or click Start Personal

Connect to My Cornpukers, ., Conference meeting to start a previously
scheduled Personal Conference meeting.

Skart Meeting MNow
Start Personal Conference Meeting
Skart a Scheduled Meeting. ..

Jaoin a Meeting. ..

\WebEx Settings. .. . .
Note: You can also right-click the WebEx One-

Help Fi Click taskbar icon and then click Schedule a
Abaut WebEsx One-Click, .. meeting to schedule a WebEx meeting using
Microsoft Outlook or Lotus Notes.

Exxit
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Shortcut

B Calendar - Microsoft Outlook
! Ele Edt Wew Go Tooks Actions Help
| Hnew + | 4 X i gH | Teday [ TI0ay] 3]

éﬁwmlﬁmmﬂf

MiehErfe: S
Start Personal Conference Meeting
Start a Scheduled Maeting...

Join a Meeting..

My WebEx

Account Settings...

Megting Templates..,

Set Scheduling Permission..

Help

About

% Windows Messengen
File Actions Tools Help

Start WebEx Meeting Chrl+5

h tonlin. yyepey Settings
€ Click here tojoin t|  Hide Start Button

=S all Contacts (0 About

. (@) share Browser  WebEx - |

WebEx | -

Start Meebing Mow
Start Personal Conference Meeting
Start & Scheduled Mesting

Schedule a Meeting. ..
Join a Meeting...

‘WebEx Settings...

Help
Abaut WebEx Productivity Tooks

Description

Email and Scheduling shortcut: Click One-
Click Meeting in Microsoft Outlook or Lotus
Notes to start a One-Click meeting.

Note: You can also click Schedule Meeting in
Microsoft Outlook or Lotus Notes to schedule a
WebEx meeting using Outlook or Lotus Notes.

Instant messenger shortcut: Click WebEx >
Start WebEx Meeting to start a One-Click
meeting in your instant messenger, such as
Skype, AOL Instant Messenger, Lotus
SameTime, Windows Messenger, Google
Talk, or Yahoo Messenger.

Available for meetings, sales meetings,
training sessions, and support sessions only.

Web browser shortcut: Click this icon to start
your meeting.

Note If you previously customized your
Internet Explorer toolbar, the shortcut button
may not automatically appear on the toolbar.
Instead, it is added to the list of available
toolbar buttons in Internet Explorer. In this
case, you must add the button to the toolbar,
using the Internet Explorer Customize option.
To access this option, on the View menu, point
to Toolbars, and then choose Customize.

Available for meetings, sales meetings,
training sessions, and support sessions only.
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Shortcut

| WebEx =

Share As Document..,

Share As Application...

3

E el s Application. ..
WinZip

Send To

Cut
Copy

Create Sharteut
Delete

Propertiss

Star

Description

Microsoft Office shortcut: In Microsoft Word,
Microsoft Excel, and Microsoft PowerPoint,
select Share This File. This command starts
the meeting and automatically shares the
application you are using, including all files
that are already open in that application. You
can still work in the application during the
meeting.

Available for meetings, sales meetings,
training sessions, and support sessions only.

Right-Click menu shortcut: Right-click the
icon for an application or document file on your
computer, and then point to Share in WebEx
Meeting > As Application. This command
starts the meeting and automatically shares
the application, including all files that are
already open in that application. You can still
work in the application during the meeting.

Available for meetings, sales meetings,
training sessions, and support sessions only.

Once you start a One-Click Meeting, it appears on your Personal Meeting Room page, unless
you specified it to be an unlisted meeting. If you provide others with the URL for this page,
they can quickly join your meeting by clicking the link for the meeting on this page.

You can control which shortcuts are available in the WebEx Settings dialog box.

Removing WebEx Productivity Tools

You can uninstall WebEx Productivity Tools at any time. Uninstalling Productivity
Tools removes all Productivity Tools, including the WebEx One-Click panel and
One-Click shortcuts, from your computer.

To uninstall WebEx Productivity Tools:

1

2

Click Start > Programs> WebEx > Productivity Tools > Uninstall.

Click Yes to confirm that you want to uninstall WebEx Productivity Tools.

To uninstall WebEx Productivity Tools from the Control Panel:

1

2

Click Start > Settings > Control Panel.

Double-click Add/Remove Programs.
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3 Click WebEx Productivity Tools.
4 Click Remove.

5 Click Yes to confirm that you want to uninstall WebEx Productivity Tools.

Note: Uninstalling Productivity Tools removes all Productivity Tools and shortcuts from your

computer. If you want to keep using some Productivity Tools but disable others, edit the options
in the WebEX Settings dialog box.
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A Quick Tour of the Meeting
Window

The Meeting window provides a forum for you to share information and interact with
attendees via documents, presentations, whiteboards, applications, and more.

You share or view content using the tools in the Meeting window. You can use panels
to chat, take notes, and perform other tasks.

When you start or join a meeting, your meeting window opens with the Quick Start
area on the left and a panel area on the right. Nearly everything you want to
accomplish in a meeting can be done from these areas:

Select an audio device

Invite or remind people
Share your desktop

Share content from a file,
application, or browser

Share a whiteboard

Record the meeting

OO 6 @6 6

Interact with other participants
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Working with panels

Your service selects which panels display initially.

Windows @ To display the Panels menu, on the icon tray,
select the down arrow.

@ Select an icon from the icon tray to open or
close a panel.

v 2N Participants Restore Layou 0 *

Spaaking: Hide Panels

@ (O Becky Cox (Host ] @ In this example, the Notes and Polling panels
A il are collapsed. Select the arrow on the title bar to
i expand or collapse the panel.

Manage Panels. ..

(1 Mariah
Tip: To access panel options, right-click in the panel
| + Make Fresenter || Audio ‘ |EE' || o | title bar.

from Becky Cox to Everyone:

Welcome everyone

from Becky Cox to Everyone:

‘el skart with introductions and then get started with agenda
terms,

Send ta: | Everyone - |

‘ ‘ | Send |
» B Notes 6 x
» [l Polling *

Note: In sharing mode, you can have one or more panels sit independently on top of the shared
document, presentation, Web browser, or other shared item.

CD To display the Panels menu, on
the icon tray, select the options icon.

@ Select an icon from the icon tray to
open or close a panel.

@ In this example, the Notes panel is
collapsed. Select the arrow on the title
bar to expand or collapse the panel.

Tip: To access panel options, right-
click in the panel title bar.
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1 il (el L :[_
| W 01 Mecky Cox (Haowt

1 Mariah

| & [ augio = &
T

| o Bachy Can B Everyane

| Welome

| EVErDNE
| broen Baciky Con o Everyong
| Wi 1l e with ATOouCEoNE Bnd then it Faned with Sgends Wend

| Send to | Backy Cox (Host & Presenter) ]

(2)

[ \
i
il || Restore Layout

Hide Panels

Manage Panels..

Using panels to interact with other participants

After you start or join a meeting, the meeting window opens and on the right side, you
can see all participants who are in the meeting. As other people join, you will see their
names appear in the list.

You can interact with other participants in the meeting in different ways, depending
on your role:
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110

Role What you can do
Host Parti pants Chat Ld messrder = 1) View the list of meeting
Windows participants.
2) Use video to see others and
have them see you.
3) Make someone else the
presenter.
4) Chat with a specific participant
or with everyone.
5) Invite someone else or remind
an invitee to join the meeting.
Participant * I respen 1) View who is in the meeting.
Mac ' - ¢

|| 2) Use video to see others and
have them see you.

. 3) Chat with other participants.

=X el
Loh £ Mariab @!JL‘:’I.E--
el o mmme = 1
I

v -|I1|
Sentte N oy lost & Presenen L
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Managing panels

You can determine which panels are displayed in the meeting window, and in which
order they will be displayed:

To manage the display of panels:
1 Click this button.

E'! for Windows

[ -:::-v‘ for the Mac

2 Choose Manage Panels from the menu.

= Use the Add or Remove buttons
to specify which panels should

SohCk pmieks you vani Lo weiobh display in your meeting window.
i : ‘ = =  Use the Move Up or Move Down
Chet buttons to specify the order of the
il 2 | s o panel display.
Mokes *

|
I
! = Click the Reset button to restore
| the panel view to the default
| ‘ layout.

ey Dowe | = Clear the check box beside Allow
participants to change the
*These panals are avalsbls bo participarts with sppecgriate privieges. sequence of panels if you want
Moke: On the floating icon tray, only the First four parsks will be displayed, to permit attendees to manage

T remairing paresks wal be svadable from the mer,
¥ Aows participants bo change the ssquence of panels,

meser | O Cancel
b v##&“MWW

their own display of panels.

Restoring the panel layout

If you have closed, expanded or collapsed panels, you can restore the display to the
layout.

= You specified in the Manage Panels dialog box.

= That existed when you first joined the meeting (if you did not specify a layout via
the Manage Panels dialog box).
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To restore the panel layout:
1 Click this button.

|L|_ for Windows

#£~ for the Mac

2 Choose Restore Layout.

Accessing panel options
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Each panel provides a menu of commands related to the panel. For example, Expand
Panel and Close Panel are two common commands for all the panels.

Depending on what operating system you are using, access the commands for a panel
by following these steps:

= Windows—Right-click the panel title bar to see a menu of commands related to

the panel.

= Mac—Select ctrl and then click to see a menu of commands related to the panel.

Panels with
options

Participants

Chat

Options

Sound Alerts: Lets you choose a sound to play when a participant:
= Joins a meeting.

= Leaves a meeting.

=  Selects the Raise Hand icon on the Participants panel.

Assign Privileges: Displays the Participant Privileges dialog box.

Sound Alerts: Lets you choose the kinds of chat messages for which you want
a sound to play. Select a sound from the drop-down list or click Browse to find a
sound in a different location on your computer.

Assign Privileges: Displays the Participant Privileges dialog box.
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Panels with
options Options
Notes Notes: Displays the Meeting Options dialog box, where you can set note-taking

options as well as other options.

= Allow all participants to make notes: Lets all participants take their own
notes during the meeting, and save them to their computers.

= Single note taker: Lets only one participant take notes during the meeting.
By default, the host is the note-taker, but can designate another participant
as the note-taker during the meeting. A note-taker can publish notes to all
attendees at any time during the meeting. The host can send a transcript of
the notes to participants at any time.

= Enable Closed Captioning: Lets only one participant-the closed captionist-
take notes during the meeting.

Resizing the content viewer and panels area

When you are sharing a document or presentation, you can control the size of the
content viewer by making the panel area narrower or wider.

Note: This feature is unavailable when you are sharing your desktop, an application, or a Web
browser.

To change the size of the content viewer and panels:
Click the dividing line between the content viewer and the panels.
= Drag the line to the left to make the area devoted to the panels wider.

= Drag the line to the right to make the content viewer larger.

E
Send to: All Participants | - |

Anglindtadidie oy, B i i i tniott ot ke

For details about hiding, minimizing, and closing the panels, see Accessing panels in
full-screen view.
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Accessing panels from the Meeting Controls
Panel

While you are sharing a document in full-screen view, or sharing an application,
desktop, or Web browser, you can access panels from the Meeting Controls Panel:

] - o = rd -

-
s Shaim Amign % Padidpants That et Anralsts }
1 el ars sharrg e monkor, 2
g )

Control
@ Displays icons for working with attendees.
@ Displays a maximum of 4 panel icons. You can open any remaining panels from the

menu that appears when you select the down arrow.

lO Stops sharing and returns to the Meeting window.
b

Provides access to meeting controls and panels that are not usually displayed on
the Meeting Controls Panel, such as Polling and Notes.

p:':'ﬂ Displays the Participants panel.
i Displays the Chat panel.

a...:,. Displays the Annotation Tools panel.
= Displays the Recorder panel.

Bincomder
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Viewing Panel alerts

You will see an orange alert if a panel is collapsed or closed and requires your
attention.

Some reasons for seeing alerts:

= A participant arrives or leaves a meeting

= A participant starts or stops sending video

= A Raise Hand indicator appears in the Participants list
= The note taker publishes notes

= An participant sends a chat message

= A poll opens or closes

= Poll answers are received

For example, if a participant joins or leaves your meeting, and you have collapsed or
closed the participant panel, the following table shows you different ways you can be

alerted.
Participants panel alerts ways to see alerts
Windows Meeting window-panel is closed.

B ¥ Chat

¢ B motes

Windows Meeting window-panel is collapsed.

W 2 participants
v B Notes

Mac
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Windows Meeting Controls Panel (during sharing)-
: panel is closed .

- a-
.

The panel remains in the alert status until you open and view the change.
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Managing a Meeting

All the prep work is done, and you have started your meeting. Here are some of the
most common tasks you can perform as you host the meeting:

= Edit your welcome message
Invite more people

i L

= Remind invitees to join

Topic: 1 Jep's Iretant Meeting
=  Change presenters before

sharing

= =  Change presenters during
""'"'-"""j""' TR Sharing

=  Make someone else the host

Wl ety D - =  Send a transcript

O — " End the meeting

T e, TR B LA AR | v e AT G ST PRl P

Inviting more people to your in-progress meeting

After you start your meeting, you may find that you forgot to invite a stakeholder or
someone else who should be in the meeting.
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To invite someone after you start your meeting:

Select Invite & Remind on the Quick

ﬁ ﬁ Start page.

=

Invite & Remind

The Invite and Remind dialog box appears.

® Invibe and Remind M8 You can invite someone to the
meeting by:
1 . il invi
g |! tj 'E' Email: invite by WebEx or your
Ernail Phona 5 m Ramind own email.

= IM: Invite by WebEx or your

Separ abe Addresses with 0omMmas o Semicolons own IM

Enviess:

=  SMS: Enter the invitee mobile
number and select Send.

=  Phone: Enter the invitee name
and phone number and select
Call.

Irrvite withs: your local el

Meading URL:  hibtpa:] go. sesbes, comigois, phamAT="WMEEvent.., Lt ST

Inviting people by instant message to a meeting in progress
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You can invite more people to your in-progress meeting by WebEx IM or another
instant messenger.

To invite more people using WebEx IM:

Note: Start your WebEx IM if it is not currently running.
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* Invite and Remind = 1) From the Quick Start page,
open the Invite and Remind
dialog box.

Emal e s 1™ Fsmind 2) Onthe IM tab, select Invite.

| Irrte using Cisen WebEx 1M,

In & hrry b get someons into tha mesting? Srply salect Copy at tha

bottom of the scraen, then pashes tha mesting LAL deactly inko your [

rANCY

Mesting URL:  hitps: mobieqa. webe o comimobilsgale. phptaT=. Copy
The Invite More dialog box appears.
& Invite Mare x 1) Type a screen or domain name for the an
@ attendee.

Bl Attendees — Traihg 2) Click the_ Plus button to add the name to the list

BIaE mericbe.. | M = of participants.

= RE roandav.. | M -

Inwite Message:

Maatins Topic: Status mesting ]
Start Tine: Friday, June 20, 2006 2!12 pm, Pacific
DCoaylight: Tarren {San Franciscn, GMT-07:00)

It Cancel
To quickly find screen names:
1 Click the Address Book button to open your address book.
2 In the Method drop-down list, select IM.

If the an attendee is not currently available, you can send an email invitation
instead. Simple select Email in the drop-down list.

3 Click Invite.
Each an attendee receives an IM message, which includes:

= Alink that the an attendee can click to join the meeting
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= Meeting topic

= Meeting start time

Tip: If you invite attendees by instant messenger, and your meeting requires a password,

remember to provide the password to attendees.

To invite more people using another IM:

* Invite and Remind

Emal

| It

M5

wsing Cisoo WebEx IM

Q

Rgimireg

Inv & harry ko gat someons inko the mesting? Simply salect Copy at tha
bottom of the scraen, then paste the masting LPL deactly inbo your 4

rANCY

Memtig LURL:

hittpessf mobilega, webs s comimobilsgale. phpPaT=. ,

Copy

Inviting people by email to a meeting in progress

Open the
Invite and
Remind db
from the
QuicksStart

page.

Select
Copy at the
bottom of
the db, then
paste the
URL into
your own
IM and
send it.

Each person that you invite receives an invitation email message, which provides
information about the meeting-including the password, if any-and a link that the

participant can click to join the meeting.
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To send an email invitation:

® Invite and Remind MIES 1) From the Quick Start page, Open
the Invite and Remind dialog box.
'\. 5 !j @' 2) On the Email tab do one of the
Email Phoares: SHE ™ Eiarrind fo”owing:

[0 Enter one or more email
addresses and select Send to
have WebEx send the
invitation emails.

O Click the link to send
invitations using your own
email program (MS Outlook
or Lotus Notes only).

Separate addmsses with Commas o semicolons

Inerkees:

Brnvite with: vour Iocd ernal

Membing LRL:  Blbges: figo. sebex, comyigofs. php & T=WHIBEwent. .. Ciopey

Inviting participants by phone to a meeting in progress

You can invite participants by phone to a meeting in progress.

To invite participants by phone:

open the Invite and Remind

K.\ !| .I,? 'B' dialog box.

o s azy v 2) On the Phone tab, enter the
invitee name and phone
Irwiten Mame:  Dhome user 1 number.
3) Select Call.

Loty FRegion
Phone Mumber: 24 |

Mastirg URL:  hetps: fgo.webes, comfgale. phpT A T=WMHIBEvert, Copy

You can speak to the invitee privately, then add the invitee to the general meeting.

If you are not yet connected to the audio conference, the participant receives a phone
call to join the audio conference.
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Inviting participants by text message (SMS) to a meeting in
progress

You can invite participants by text message (SMS) to a meeting in progress. This
feature must be enabled by your site administrator.

To invite a participant by text message from the meeting:

Invite and Remind dialog box.

K‘ g] r ‘G‘ 2) On the SMS tab, enter the invitee

; mobile phone number.

Emal Phore i ™ Reamirg
3) Select Send.

CourtryRegion

Irvitee Mobils Musbsr: =1

Mesting URL:  Retps: oo websx. comjgofe.phpt & T=\WIEE vert., Capy

Each participant receives a text message, which includes:
= A number the participant can call to join the meeting
= The account code

= Meeting topic

= Meeting start time

= The host name

= Areply code to receive a call from the meeting

Reminding invitees to join your meeting

After the meeting starts and you see that some invitees have not yet joined, you can
send an email reminder.
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To remind someone to join your meeting:

Select Invite & Remind on the
Quick Start page.

Yo,
e

Invite & Remind

The Invite and Remind dialog box appears.

(W invite and Remind Select the Remind tab. All invitees
who are not in the meeting are
1 automatically chosen to receive the

reminder.

Email

1) Uncheck the box beside any
person you don't want to
remind.

Ths Tollovang peopls have ol el jared the masbing,
Which invibess shoild recere mesbing resinders?

[#] jadk treben@yahon. com

g 2) Select Send Reminder.

Srttin, g apt,, fly o u-*-mj

An email reminder is sent to each person selected.

Making a participant the presenter when you are
In the meeting window

As the meeting host, you are initially the presenter as well. The WebEx ball appears
to the left of your name. However, during a meeting, you can designate any meeting
participant as the presenter - also referred to as passing the ball. Any presenter can
also pass the ball to make another meeting participant the presenter.

There are numerous ways to make someone else the presenter depending on how you
are viewing participants.
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Here are a couple of quick ways to make another participant the presenter:

If you are viewing a list of participants, do either
of the following:

=  Drag the ball from the last presenter to the
next presenter.

Partsipuant s That LI Rrcorder =

= Choose a name and select Make
Presenter at the bottom of the panel.

” : i - If you are viewing participant
thumbnails, do either of the
following:

= Mouse over a thumbnail and select Make
Presenter.

= Choose a thumbnail, then select Make
Presenter at the bottom of the panel.

[+ Mabs Presentes || Auda | I - LRIN

The participant becomes the presenter with all associated rights and privileges for
sharing information.
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Note: Use the docked tray at the top of your screen to change presenters when you are sharing.

Making someone else the presenter when you
are sharing

When you are sharing your desktop, an application, or files in full screen mode, the
docked tray at the top of your screen provides an easy way to change presenters.

To make someone else the presenter using the docked tray:

=  Mouse over the bottom of

; the docked tray to expose

Pan gty Chak Beover Ll P )

@ Pde poenter o I =  Select Assign, then Make
5 Presenter.

=  Select a participant.

The participant becomes the presenter with all associated rights and privileges for
sharing information.

Note: You can make someone else the presenter from the participant list when you are in the
meeting window.

Making someone else the host

As a meeting host, you can transfer the host role - and thus control of the meeting - to
an attendee at any time. This option can be useful if you need to leave a meeting for
any reason.

To make another participant the host:

1 Do one of the following:
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Pl ipeand 5. Chat Ll Recorder w =  Right-click on a participant
= 3 Participants name or participant
thumbnail.

=  Select the Participant menu.

LY | 1 M day (Host, me - g

5 ‘:“ Aurmsie Lopaz .|| Change Role To [ ™) P'IE'EEI't-Ef
|
||_U" flow ta Agnotats |
|

u-"dr.ﬂi‘rem seahy Bl &

2 Select Host from the Change Role To menu. The selected participant is now the
host.

The word (host) appears to the right of the attendee’s name in the participant list.

Transferring the host role

As a meeting host, you can transfer the host role - and thus control of the meeting - to
an attendee at any time. This option can be useful if you need to leave a meeting for
any reason.

To transfer the host role to an attendee:

1 Optional. If you plan to reclaim the host role later, write down the host key that
appears on the Info tab in the content viewer in the Meeting window.

2 Display the Participants panel.

3 In the participant list, select the name of an attendee to whom you want to transfer
the host role.

4 On the Participant menu, choose Change Role To> Host.

A confirmation message appears, in which you can verify that you want to
transfer control of the meeting to the participant whom you selected.

5 Click OK.

The word (host) appears to the right of the participant's name in the participant list.
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Reclaiming the host role

To take over the role of meeting host:

If a participant has control of a meeting, you can assume control of the meeting by
reclaiming the host role.

Important: If you leave a meeting—whether intentionally or inadvertently—and then log back in
to your meeting service Web site, you automatically become the meeting host once you rejoin the
meeting. You can rejoin a meeting using either the public meeting calendar or your private
meeting calendar.

To reclaim the host role:

1 In the Meeting window, open the Participants panel.

2 In the participant list, select your own name.

3 On the Participant menu, choose Reclaim Host Role.
The Reclaim Host Role dialog box appears.

4 Type the host key in the Host key box.

‘™ Reclaim Host Role

Hast Key: |

2k, | Cancel

5 Click OK.

In the participant list, the word (host) appears to the right of your name.

Tip: If you did not write down the host key before transferring the host role to another participant,
you can ask the current host to send you the host key in a private chat message. The host key
appears on the current host's Info tab in the content viewer.
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Obtaining information about a meeting after it

starts

Editing

128

To obtain information about a meeting in progress:
In the Meeting window, on the Meeting menu, choose Information.

The Meeting Information dialog box appears, listing general information about the
meeting, including the:

= Meeting name or topic

= Location, or URL, of the Web site where the meeting is taking place
= Meeting number

= Teleconferencing information

= Current host

= Current presenter

= Current user-that is, your name

= Current number of participants

a message or greeting during a meeting

When scheduling a meeting, you can create a message or greeting for participants, and
optionally specify that the message or greeting automatically appears in participant
windows once they join the meeting. During a meeting, you can edit the message or
greeting that you created, or edit the default greeting.

In your message or greeting, you can welcome the participant to the meeting, provide
important information about the meeting, or provide special instructions.

To edit a message or greeting during a meeting:
1 Inthe meeting window, on the Meeting menu, choose Welcome Message.

The Create an Attendee Greeting page appears.
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_’o [ Display this messoge when attendees jon the meetmg
Mestage
Welcome ©o By meeCing.
You can chae, sharce
pressncactions, doCumenta, oT
applications right in yous
browser !
Fegards,

Marie Broaks

(255 characters mpe) (U] | Lance |

2 Optional. Select the Display this message when attendees join the meeting
check box.

The message or greeting automatically appears once the participant joins the
meeting.

3 Type a message or greeting in the Message box.

A message or greeting can contain a maximum of 255 characters.
4 Click OK.

Note: Participants can view the message or greeting at any time by choosing Welcome Message
on the Meeting menu.

Restricting access to a meeting

Once a host starts a meeting, the host can restrict access to it at any time. This option

prevents anyone from joining the meeting, including participants who have been

invited to the meeting but have not yet joined it.

To restrict access to a meeting:

1 Inthe Meeting window, on the Meeting menu, choose Restrict Access.
Participants can no longer join the meeting.

2 Optional. To restore access to the meeting, on the Meeting menu, choose Restore
Access.

129



Chapter 10: Managing a Meeting

Removing a participant from a meeting

The meeting host can remove a participant from a meeting at any time.

To remove a participant from a meeting:

1 In the Meeting window, open the Participants panel.

2 Select the name of the participant whom you want to remove from the meeting.
3 On the Participant menu, choose Expel.

A confirmation message appears, in which you can verify that you want to remove
the participant from the meeting.

4 Click Yes.

The participant is removed from the meeting.

Tip: To prevent an expelled participant from rejoining a meeting, you can restrict access to the
meeting.

Leaving a meeting

You can leave a meeting at any time. If you are participating in an audio conference,
Meeting Manager disconnects you from the conference automatically once you leave
the meeting.

To leave a meeting:
1 Inthe Meeting window, on the File menu, choose Leave Meeting.

A confirmation message appears, in which you can verify that you want to leave
the meeting.

2 Click Yes.

The Meeting window closes.

Note: If you are the meeting host, first transfer the host role to another participant before leaving
the meeting.
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Sending a meeting transcript to participants

You can send a transcript of a meeting to all participants at any time during the
meeting. The transcript is an email message that contains the following general
information:

Meeting topic
Meeting number
Meeting starting and ending times

URL for the Meeting Information page for the meeting on your meeting service
Web site

List of participants who have joined the meeting (audio-only participants are not
listed)

Meeting agenda
Any public notes that you took during the meeting

You can optionally attach any of the following files to the transcript, if you saved
them during the meeting:

Shared documents
Chat

Poll questionnaire
Poll results

Public notes or closed captions that you took or that the note taker or closed
captionist published during the meeting

To send a meeting transcript to participants:

1

In the Meeting window, on the File menu, choose Send Transcript.

If you have saved any files during the meeting, the Send Transcript dialog box
appears, allowing you to attach the files to the transcript email message.

If you have not saved any files during the meeting, a transcript email message
opens.

If the Send Transcript dialog box appears, select the check box for each file that
you want to attach to the transcript, and then click OK.

The transcript email message opens.

Review the email message and make any changes that you want.
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Ending

132

4 Send the email message.

Note: The transcript is sent to all participants who provided their email addresses when joining
the meeting, whether or not they are still attending the meeting when you send the transcript.
Audio-only participants will not be listed on the transcript.

For security purposes, a participant who receives a transcript email message cannot see the email
addresses for the other participants.

The transcript contains notes only if you are the meeting host, the public note taker, or the closed
captionist, and you have saved the notes to a file. If all participants can take private notes, the
transcript email message does not include your private notes, and the option to attach your notes
in a file is not available.

If you saved notes or closed captions to a file, the transcript email message and the attached notes
file contain the latest version of notes that you saved.

If you are the meeting host and end the meeting-and you have not sent a transcript-a message
appears, asking you if you want to send a transcript.

a meeting

Once you end a meeting, the Meeting window closes for all participants. If the
meeting includes an integrated voice teleconference, the conference also ends.

Note: If your site administrator has enabled the Teleconference Keep-Alive feature for your site,
you will be prompted whether you want to continue the teleconference after the web meeting
ends.

To end a meeting:
1 Inthe Meeting window, on the File menu, choose End Meeting.

A confirmation message appears, in which you can verify that you want to end the
meeting.

2 Click Yes.

The Meeting window closes.

Note: If there is any meeting information that you have not yet saved - including shared
documents, chat messages, a poll questionnaire, poll results, or notes - Meeting Manager asks you
whether you want to save it before ending the meeting. If you choose to save a file, Meeting
Manager uses the default file name for the file. Thus, if you have already saved the file using
another name, Meeting Manager does not overwrite that file.
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Tip: Alternatively, as the meeting host, you can leave a meeting without ending it. Before you
leave a meeting, you should first transfer the host role to another participant.
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Managing Recorded
Meetings

The My Recorded Meetings page allows you to view and manage your meeting
recordings. Meetings that you recorded on the server are automatically listed on your
My Recorded Meetings page. You can also upload recordings of meetings that were
recorded on your local computer.

My Recorded Meetings page Task description:
"y = o % = Open_ the My Recorded
e J Meetings page.
| Smanch -
—, =) L2 = Upload a recorded
Tonkl ] releriag . .
b e e i meeting file.
:-:I;I‘- I — SOIMB NLOST & pE 80 mindte ARF [ - - Edit information about a
recording.
Hal meeilng SN0 K1 2B TORTAS pem & minubes ARF G : .
Slabe mesting OMORMLEIN 145 okE KRAREAMpm dmiees  AEF (4] 4 = Send an email to share a
{ recording.
] M."-ll":m .-. i Priywoed mepuned
o L I i SR f

Opening the My Recorded Meetings Page

To open the My Recorded Meetings page:
1 Log in to your WebEx Meeting Center service Web site.

2 On the left navigation bar, under Host a Meeting, click My Files > My
Recordings.
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The My Recorded Meetings page appears, showing your recording files.

About the Recording Information page

How to access this page

On your Meeting Center Web site, from the left navigation bar, click My Recorded
Meetings > [topic of a recording].

What you can do here

= View information about the recording.

= Play back the recording.

= Send an email to share the recording with others.
= Download the recording.

= Enable or disable the recording.

= Open the Edit Recorded Meeting page, on which you can edit information about a
recording.

Options on this page

Option Description
Topic The name of the recording. You can edit the topic at any time.
Create time The time and date the recording was created.
Duration The length of the recording.
Description A description of the recording.
File size The file size of the recording.
Create time The date and time at which the recording was created.

The status of the recording. The possible options are Enable or
Status .

Disable.

Indicates whether a user must provide a password to view the
Password )

recording.

Clicking the link lets you play the recording (available only for
Stream recording link recording files with the .arf extension that were recorded by

NBR).
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Option Description

Download recording link | Clicking the link lets you download the recording.

Clicking the button lets you play the recording (available only for
recording files with the .arf extension that were recorded by

Play Mow NBR).

If you want to download the recording, you can also click the
link for downloading under Play Recorded a meeting Now.

Clicking the button opens the Share My Recording window,
which allows you to send an email message to selected
recipients, inviting them to play your recording.

Send Email L .
If you want to send the email with your local email client

instead, click the link for using the email client under Share My
Recording.

Clicking the button opens the Edit Recording page.

Delete Clicking the button deletes the recording.

Clicking the button disables the recording everywhere it is
Disahble published on your WebEx Service Web site. (available only for
enabled recordings).

Clicking the button enables the recording everywhere it is
Enable published on your WebEx Service Web site. (available only for
disabled recordings).

=

S—.

=
=)

Back to List ] Clicking the button returns you to the recording list.

About the My Recorded Meetings page

How to access this page

Log in to your WebEXx service Web site. From the left navigation bar, click My Files
> My Recordings.

What you can do here

Manage, upload, and maintain recording files of meetings you host.
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Options on this page

Option
[S]

Search

You are currently using X
% of Y GB

Site storage X % of Y GB

Topic

Size
Create Time/Date

Duration

Format

Description

Refreshes the information on the page.

Allows you type text to search for within recording names. Click
Search to start the search.

The percentage of available personal storage space on your
WebEx Service Web site that is being used by your recordings.
This field appears only if your site administrator has turned on
the option to show personal recording storage allocation usage.
If this field does appear, and you exceed your personal storage
allocation, you will not be able to record meetings until some
recordings are deleted or the storage allocation is increased by
your system administrator.

The percentage of total available storage space on your WebEx
Service Web site that is being used by all recordings on your
site. If your site exceeds its storage allocation, users will not be
able to record meetings until recordings are deleted or the
storage allocation is increased by your system administrator.

The name of the recording. If you record a meeting on the
server, the WebEXx server automatically uploads the recording to
this page. In this case, the topic of the recording is the topic of
the meeting. You can edit the topic at any time.

The size of the recording.
The date and time the recording was created.
The length of the recording.

The format of the recording file.

A recording file can be in WebEx Advanced Recording Format
(ARF) or WebEx Recording Format (WRF). You can also store
recording files that are in Windows Media Audio/Video (WMV)
or Shockwave Flash Object (SWF) format.

Lets you play the recording (available only for recording files
with an .arf extension that were recorded by the Network-Based
Recorder).

If playback of the file requires a password, you must provide the
password.

Lets you send an email to share this recording with others.



Chapter 11: Managing Recorded Meetings

Option Description
Displays a menu with more options for your recording:

] +% Download: Lets you download the recording to your
local computer.

If downloading the file requires a password, you must
provide the password.

] g Modify: Lets you edit information of the recording.
= '@ Disable: Lets you disable the recording in all locations.

= 5 Delete: Lets you delete the recording from this page.

Lets you upload a new recording.

Add Recording

=) Indicates that a recording is password-protected.

Uploading a recorded meeting file

Editing

If you recorded meeting using the integrated or standalone WebEx Recorder, you can
upload the recording meeting file, with a .wrf extension, from your local computer to
the My Recorded Meetings page.

Note: If you recorded a meeting using the WebEx Network-Based Recorder (NBR), the WebEx
server automatically uploads the recording file, with an .arf extension, to the appropriate tab on
the My Recorded Meetings page once you stop the Recorder. You do not need to upload it
yourself.

To upload a recording file:

1 Go to the My Recorded Meetings page.

2 Click Add Recording.

3 On the Add Recorded Meeting page, enter information and specify options.

4  Click Save.

Information about a recorded meeting

You can edit information about a recorded meeting at any time.

To edit information about a recorded meeting:

1 Go to the My Recordings page or the My Recorded Meetings page.
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2 Click the following icon for the recording that you want to edit.
71
The Edit Recorded Meetings page appears.

3 Make your changes.

4 Click Save.

About the Add/Edit Recorded Meetings page
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How to access this page

If you are adding a recording...

1 Log in to your WebEx Meeting Center service Web site.

2 On the left navigation bar, under Host a Meeting, click My Recordings.
3 Click Add Recording.

If you are editing information about a recording...
1 On your WebEXx service Web site, under Host a Meeting, click My Recordings.

2 Click the More button in the row of the recording that you want to edit.

3 Click Modify.

L Download
L& Modify

L@ Disable

L¢ Be-assign

[ Delete

What you can do here
= Edit general information about a recording, including the topic and description.
= Require a password to play or download the recording.

= Specify playback control options, such as panel display options and recording
playback range and whether to include Network Recording Play controls.



Chapter 11: Managing Recorded Meetings

Options on this page

Use this option....

Topic
Description

Recording file

Duration

File size

Set password

Confirm password

To....
Specify the topic of the recording.

Provide a description of this recording.

Click Browse to select the recording file that resides on your
local computer.

Specify the duration of the recording.

Displays the size of the recording file (available only when
editing recording information).

Set an optional password that users must provide to view the
recording.

Confirm the password that users must provide to view the
recording.

Sending an email to share arecorded meeting

You can send an email one or more people to share your recorded meeting with them.

To send an email to share a recorded meeting with others:

1 Go to the My Recorded Meetings page.

2 Open the Share My Recording window:

= Click the following icon for the recording that you want to share with others.

=]

= Click the linked name of the recording you want to share. On the Recording
Information page, click Send Email.

Send Email

The Share My Recording window appears.
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3 Select recipients for your email:
= Click Select Recipients to select contacts from your Contacts list.
= Type email addresses in the Send to list, separated by commas.

4 (Optional) Type a message in the Your message box.

5 Click Send.

Your email message will be sent to the selected recipients, and will include
information about the recording and a link to play it.
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Sharing Presentations,

Documents, and
Whiteboards

Your user role in a meeting determines your level of sharing. Whichever role you
take, the following table describes the basic tasks associated with that role. For
detailed instructions on a particular task, click “More” by the task description.

Host

File Edi BB Yiew Aodio  Parbicipant

Quick { My Desktop b

Document Fram My Computes, ..

Application »

Rebect | yitgeboard | crrtvamn

Participant with granted permissions

fle  Edt Share  Wiew Audo  Paticipant  Meetng  Help

4 |02 Agerda hd

;::"'T/'L'_.}"!J'-/?'

Task description:

Open and share a document or
whiteboard

= Learn about tools for sharing
= Start sharing

= Assigning sharing privileges to
participants

=  Save a document

View and interact with shared
documents and whiteboards

= Display slides or pages
= Use tools to annotate a document

= Synchronize your view with the
host

143



Chapter 12: Sharing Presentations, Documents, and Whiteboards

Granting sharing privileges

To grant or remove participant privileges during a meeting:
1 In the Meeting window, on the Participant menu, choose Assign Privileges.
The Participant Privileges dialog box appears.
2 Grant or remove a privileges, as follows:
= To grant a specific privilege, select its check box.
= To grant all privileges, select the Assign all privileges check box.
= To remove a privilege, clear its check box.
= To revert to the preset privileges, click Reset to Meeting Defaults.

3 Click Assign.

Content viewer tools

Content Viewer Tools

T e R LT

e e e e ey

0 The tools on the content viewer toolbar
T allow you to share and perform actions on

D M — ; .. = presentations, documents, and
B Whiteboards.

‘ Select this button at the top right of the

e hieteond content viewer to start a new whiteboard.

Annotation toolbar-Select a drawing tool
2T/ ~O0-~¢ "-B-5- for directing attention onscreen, using
pointers, a highlighter, or drawing a shape.
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Content Viewer Tools

[T Show Thumbnal

) Rotate Page Left Viewing toolbar and menu-Change to full-
% Ratate Page Right screen rotate pages zoom in or out using
A | G Svmc Display For Al | these tools.

=1 Pullscreen | [115% «| B =L | view |-

Changing views in a file or whiteboard

You can switch views in the content viewer by clicking the view icons and selecting
from the View menu in the bottom left corner of the content viewer:

[E7 Show Thumbnal

) Rotabe Page Left
% Rotske Page Right View tools

i [ty Sync Display For &Il |

=1 Pull Screen | |115% < | St SL | View |-

Tool Icon Description

Show To display thumbnails, or miniatures, of shared pages, slides, or
Thumbnails Ii whiteboards to the side of the content, click Show Thumbnails.
This tool helps you locate a page or slide quickly.

Displays shared content in a full-screen view. Helps to ensure that
participants can view all activity on your screen. Also helps to

Full-Screen View Ei prevent participants from viewing or using other applications on
their screens during a presentation.

Click ESC to return to the content viewer.

Rotate page For documents in landscape orientation, you can rotate the pages
pag to the left or right so they appear correctly in the content viewer.

Lets you display shared content at various magnifications. Click

Zoom In/ o this button, and then click the page, slide, or whiteboard to

Zoom Out = change its magnification. For more magnification options, click the

downward-pointing arrow.
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Tool Icon Description

3 For presenters, synchronizes all participants' displays with your
0 display. Helps to ensure that all participants are viewing the same

Synchronize O
t
page or slide, at the same magnification, as in your display.

Displays for All

Using annotation tools on shared content

In an online meeting, you can use annotation tools on shared content to annotate,
highlight, explain, or point to information:

= -T / ~[]- f - -7~ Basic annotation tools

Annotation
Tool Icon Description

Lets you point out text and graphics on shared content. The pointer
displays an arrow with your name and annotation color. To display the

Pointer |:> laser pointer, which lets you point out text and graphics on shared
content using a red “laser beam,” click the downward-pointing arrow.
Clicking this button again turns off the pointer tool.

Lets you type text on shared content. Participants can view the text
once you finish typing it and click your mouse in the content viewer,
Text T outside the text box.

To change the font, on the Edit menu, choose Font. Clicking this button
again turns off the text tool.

Lets you draw lines and arrows on shared content. For more options,
Line / click the downward-pointing arrow. Clicking this button closes the
Rectangle tool.

Lets you draw shapes, such as rectangles and ellipses on shared
Rectangle |:| content. For more options, click the downward-pointing arrow. Clicking
this button again closes the Rectangle tool.

Lets you highlight text and other elements in shared content. For more
Highlighter ‘& options, click the downward-pointing arrow. Clicking this button again
closes the Highlighter tool.

Displays the Annotation Color palette, on which you can select a color

églnoortatlon .J to annotate shared content. Clicking this button again closes the
— Annotation Color palette.
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Annotation
Tool Icon Description
Erases text and annotations or clears pointers on shared content. To
o erase a single annotation, click it in the viewer. For more options, click
Eraser { y 9 P

the downward-pointing arrow. Clicking this button again turns off the
eraser tool.

Sharing presentations or documents

File sharing is ideal for presenting information that you do not need to edit during the
meeting, such as a slide presentation.

You can share almost any type of file that you can print from your computer.
Participants view shared files in their content viewers without the need for the
application with which it was created. Participants can also view any animation and
transition effects on shared Microsoft PowerPoint slides.

After a meeting starts, you can open a presentation or document to share. You do not
need to select it or “load” it before the meeting.

While sharing a file, you can:

= Draw on the screen

= Use a pointer to emphasize text or graphics
=  Printit

= Display it at various magnifications, in miniature (thumbnails), and in a full-
screen view

= Synchronize all participants' displays with the display in your content viewer

= Saveittoafile

At any time during a meeting, you can grant participants privileges that allow them to
annotate, save, print, and display different views of shared presentations or
documents.

Sharing a document or presentation

You can share a document or presentation that resides on your computer. Participants
view the shared document or presentation in their content viewers.
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To share a document or presentation:

1

2

3

On the Share menu, choose Presentation or Document.
The Share Presentation or Document dialog box appears.
Select the document or presentation that you want to share.
Click Open.

The shared document or presentation appears in the content viewer.

Tips for sharing documents and presentations

These tips can help you share documents or presentations more effectively.
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To import slide presentations quickly:
= Limit the number of animations and slide transitions.

=  Minimize the number of screen shots that you add to slides, especially bitmap
graphics. Bitmaps do not compress well.

To improve the speed at which shared pages or slides appear in participant content
viewers, save the document or presentation as a .ucf (Universal Communications
Format) file before the meeting starts. Then share the .ucf file instead of the
document or presentation itself.

You can annotate shared presentations or documents in the content viewer;
however, you cannot edit them. If you want to edit shared information, you can
use application sharing instead.

T=TE If you are sharing a PowerPoint presentation, you can open
| PowerPojnt Notes | the PowerPoint Notes panel and view any notes you have
added to the slide in the presentation.

Reset ko lagl:ault

Minimize al

B e - Ly

To save time during a meeting, begin sharing the document or presentation before
the meeting's starting time. That way, after participants join the meeting, they can
begin viewing your presentation.
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Choosing an import mode for document or presentation

sharing

For Windows users only

Before you share a document or presentation, you can choose one of the following
import modes:

Universal Communications Format (UCF)-The default mode. Lets you display
animations and slide transitions in Microsoft PowerPoint presentations. In the
UCF mode, Meeting Manager imports documents and presentations more quickly
than it does in the printer driver mode. However, pages or slides may not appear
consistently in Meeting Manager across platforms.

Printer driver-Displays shared documents and presentations as they appear when
you print them, providing a consistent appearance of pages and slides in Meeting
Manager across platforms. However, this mode does not support animations or
slide transitions. In this mode, the first page or slide may appear quickly, but the
total import time for all pages or slides is usually longer than it is in the UCF
mode.

Note: Changing the import mode does not affect any presentations or documents that you are
currently sharing. To apply a new import mode to a shared document or presentation, you most
close it first, and then share it again.

To choose an import mode for shared documents and presentations:

1

In the Meeting window, on the Meeting menu, choose Options.

The Meeting Options dialog box appears, with the Options tab selected by
default.

Click the Import Mode tab.

options appear.
General l True Color Made  Import Mode I

To ensure good-guality imaging For document and presentation sharing,
seleck the appropriate impork mode.,

Import: mode:

f* Universal Communications Format
Supports animations and slide transitions in shared Microsoft{R)
PowerPoink(R) presentations

" Prinker driver
Provides better cross-platform imaging, but displays presentations without
animations and shide transitions

oK Cancel
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3 Select either Universal Communications Format or Printer driver.

Sharing a whiteboard

Sharing a whiteboard allows you to draw objects and type text that all Participants can
see in their content viewers. You can also use a pointer to emphasize text or graphics
on a whiteboard.

Other things you can do while sharing a whiteboard:

= Display it at various magnifications, in miniature (thumbnails), and in a full-
screen view

= Copy and paste images into it

= Reorder its position in reference to any other whiteboards

= Printit

= Synchronize Participants' displays with the display in your content viewer

=  Save it

If you allow participants to annotate slides and pages, you and participants can draw
and type on a whiteboard simultaneously. You can also allow participants to save,
print, and display different views of shared whiteboards.

Starting whiteboard sharing
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You can share a whiteboard on which you can draw and write. Participants can view a
shared whiteboard in their content viewers.

To share a whiteboard:

On the Share menu, choose Whiteboard.

Note:
= You can add multiple pages to a shared whiteboard.

= You can share multiple whiteboards. For each whiteboard that you share, you see a new
Whiteboard tab in the content viewer.
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Navigating presentations, documents, or
whiteboards

When sharing a document, presentation, or whiteboard, you can:

Navigate slides, pages, or whiteboards using the toolbar
Advance pages or slides automatically, at an interval of time that you specify
Perform animations and slide transitions in a presentation

Use keys on your computer's keyboard to navigate a presentation and display
animations on the slides

Navigating slides, pages, or whiteboards using the toolbar

You can navigate to different pages, slides, or whiteboard “pages” in the content
viewer. Each document, presentation, or whiteboard being shared appears on a tab at
the top of the content viewer.

To display pages or slides in the content viewer:

1

In the Meeting window, in the content viewer, select the tab for the document,
presentation, or whiteboard that you want to display.

If there are more tabs than can appear at one time, select the down arrow button to
see a list of remaining tabs, or use your keyboard arrows forward and back
through all the tabs.

Select the down arrow

Bo Gt e e auo Batcoarbewing b
i ¢ to view remaining tabs.

Cuick Shart Maatig Info Customer Care

BT -0~ ~W-3 | 4 |12Apndd telarkebrg
- EEEs

On the toolbar, click a button to change the page or slide you are viewing.

Select the:
Customer Care ¥ .

P

Drop-down arrow to choose any page or slide

4 |07 Inibatives ~| ¥ = Leftarrow to see the previous page or slide

= Right arrow to see the next page or slide

If Microsoft PowerPoint slides are being shared, the drop-down list also displays
the title of each slide.
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Note:

= Alternatively, you can navigate to different pages or slides in a shared document,
presentation, or whiteboard by opening the thumbnail viewer.

= You can advance pages or slides automatically at a time interval that you specify.

= You can also use the keys on your computer's keyboard to display different pages or slides
and perform animations and slide transitions.

= |f your presentation includes animations or slide transitions, you can use the toolbar or
keyboard shortcuts to perform them.

Advancing pages or slides automatically
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When sharing a document or presentation in the content viewer, you can

automatically advance pages or slides at a specified interval. Once you start automatic

page or slide advancement, you can stop it at any time.

To automatically advance pages or slides:

1 Inthe Meeting window, in the content viewer, select the tab for the document or
presentation for which you want to advance pages or slides automatically.

2 On the View menu, choose Automatically Advance Pages.
The Automatically Advance Pages dialog box appears.
3 To change the time interval for advancing pages, do one of these:
= Click the up or down buttons to increase or decrease the interval

= Type a specific time interval

Automatically Advance Pages Optional: To restart page or slide
advancement once all pages or slides
Advance to next page every: |D1 100 3: are displayed, select the Return to

beginning and continue advancing

v Return to beginning and continue advancing pages
v S 2R pages check box.

Start | Cancel |

4 Click Start.

5 Optional. Close the Automatically Advance Pages dialog box by clicking the
Close button in the upper-right corner of the dialog box.

The pages or slides continue to advance at the specified interval.
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To stop automatic page or slide advancement:

1 Ifyou closed the Automatically Advance Pages dialog box, on the View menu,
choose Automatically Advance Pages.

The Automatically Advance Pages dialog box appears.
2 Click Stop.

Animating and adding effects to shared slides

When sharing a Microsoft PowerPoint slide presentation in the content viewer, you
can animate text and slide transitions, just as you can when using the Slide Show
option in PowerPoint.

Note: To show slide animations and transitions, you must share the presentation as a Universal
Communications Format (UCF) file (.ucf). The UCF import mode automatically converts a
PowerPoint file (.ppt) to a UCF file when you share it.

=  For best results when sharing a presentation created using Microsoft PowerPoint 2002 for
Windows XP, use a computer with an Intel Celeron or Pentium 500 MHz or faster processor.

= Alternatively, use the keys on your computer keyboard to show animations and slide
transitions in a PowerPoint slide presentation.

= If at least one meeting participant is using the Java Meeting Manager, animations and slide
transitions will not display during the meeting. The meeting host can prevent participants
from joining a meeting using the Java Meeting Manager when scheduling the meeting.

To show slide animations and transitions in a shared presentation:

1 Ensure that the content viewer has input focus by clicking in the viewer.

The content viewer has input focus if a blue border appears around the outside of
the slide in the viewer.

2 On the toolbar, select the appropriate arrows to move through your presentation.

Select the:
Customer Care ¥ .

P -

Drop-down arrow to select any page or slide

4 |07 Initiatives * B = Leftarrow to see the previous page or slide

=  Right arrow to see the next page or slide
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Using keyboard shortcuts to control a presentation

154

When sharing a document or presentation in the content viewer, you can use the keys
on your keyboard to display pages or slides. If you are sharing a Microsoft
PowerPoint slide presentation, you can also use keyboard keys to show animations on
the slides and in slide transitions, just as you can when using the Slide Show option in
PowerPoint.

Note: Before using keyboard shortcuts, click in the viewer to set the input focus in the content
viewer. A blue border around the shared page or slide indicates that the viewer has input focus.

Sharing a Presentation

Use these keystrokes to move quickly through your presentation.

To... Press...
Display the next slide or perform the next Space Bar, Page Down, Right Arrow, or
animation or slide transition Down Arrow

Display the previous slide or perform the previous Page Up, Left Arrow, or Up Arrow
animation or slide transition

Display the first slide Home

Display the last slide End

Note: To show animations and slide transitions, you must share the presentation as a Universal
Communications Format (UCF) file. The UCF import mode automatically converts a PowerPoint
file to a UCF file when you share it.

Sharing a Document

Use these keystrokes to move quickly through your document.

To... Press...

Display the next page Space Bar, or Page Down, Right Arrow, or
Down Arrow
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To...

Display the previous page

Display the first page

Display the last page

Working with pages or slides

Press...

Page Up, Left Arrow, or Up Arrow

Home

End

When sharing a document, presentation, or whiteboard, you can:

= Add new, blank pages or slides for annotation.

= Paste images that you copy to your computer's clipboard into a new page or slide
in a shared document, presentation, or whiteboard.

Adding new pages to shared files or whiteboards

When sharing a file or whiteboard in the content viewer, you can add a new, blank

page for annotation.

To add a new page or slide:

1 Inthe content viewer, select the tab for the document, presentation, or whiteboard

to which you want to add a page or slide.
2 Select Add Page from the Edit menu.

A new page appears in the content viewer at the end of the currently selected

document, presentation, or whiteboard.

Tip: If you have added multiple pages to a shared file or whiteboard tab, you can view thumbnails
to make it easy to view and navigate around your added pages.

Pasting images in slides, pages, or whiteboards

If you copy any bitmap image to your computer's clipboard, you can paste the image
into a new page, slide, or whiteboard in the content viewer.

For example, you can copy an image on a Web page or in an application, then quickly
share that image by pasting it in the content viewer.
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To paste an image in a page, slide, or whiteboard in the content viewer:

1 Inthe content viewer, select the tab for the document, presentation, or whiteboard
in which you want to paste an image.

2 On the Edit menu, choose Paste As New Page.

The image appears on a new page in the content viewer, at the end of the currently
selected document, presentation, or whiteboard.

Note: You can paste any type of bitmap image, such as a GIF, JPEG, BMP, or TIF image in the
content viewer. However, you cannot paste other types of images-such as EPS or Photoshop
(PSD) images-in the content viewer.

Managing views of presentations, documents, or
whiteboards

Zooming
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All shared presentations, documents, or whiteboards appear in the content viewer in
the Meeting window. A tab at the top of the content viewer appears for each
document, presentation, or whiteboard that is being shared.

Depending on your role and the privileges that you have, you can do the following
when viewing shared content in the content viewer:

= Magnify slides, pages, or whiteboards.
= View thumbnails of slides, pages, or whiteboards.
= Display a full-screen of a page, slide, or whiteboard.

= Synchronize all participant views of a page or slide with the view that appears in
your content viewer.

in or out

Using the tools on the content viewer toolbar, you can:

= Zoom in to or out from on a page, slide, or whiteboard.

= Adjust the size of a page, slide, or whiteboard to fit the content viewer.

= Adjust the size of a page, slide, or whiteboard to fit it width in the content viewer.

=  Turn off the Zoom tool at any time.

To zoom in to or out from a page, slide, or whiteboard:

On the content viewer toolbar:
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= Select the Zoom In or Zoom In button and then drag your mouse to the area.
Release your mouse button.

= To zoom in or out to a preset percentage, select the downward-pointing arrow to
the left of the Zoom In/Zoom Out button, and then choose the percentage.

| EFL.IISEFEEI'I ].15“.-’1 'I =N =,
P —

To adjust the size of a page, slide, or whiteboard within the content viewer:

On the toolbar, select the downward-pointing arrow to the left of the Zoom In/Zoom

Out buttons.

Fit in Viewer " Choose a viewing option.
Fit bo wwidth
25%:
0%
EE=x
100%%:
200%:

4| 400%

Full Screen | 7% v l’u‘ = |'u'iew -

To turn off a zoom tool:

On the toolbar, click the Zoom In/Zoom Out button.

Controlling full-screen view

You can maximize the size of a page, slide, or whiteboard in the content viewer to fit
your monitor's entire screen. A full-screen view replaces the normal Meeting window
view. You can return to a normal view at any time.

Note: If a meeting presenter displays a full-screen view of a page, slide, or whiteboard,
participant screens automatically display a full-screen view as well. However, participants can
control full-screen view independently in their Meeting windows.

157



Chapter 12: Sharing Presentations, Documents, and Whiteboards

To display a full-screen view:

Ei On the content viewer toolbar, select the Full Screen icon.

To return to a normal view:

icon to return to the main window.

Hagan % Farirpin

= g g On the Meeting Controls Panel, select the stop

Vi e shanng Custome Cae

Viewing thumbnails

You can view thumbnails of the shared pages, slides, and whiteboards that appear in
the content viewer. Viewing thumbnails can help you to locate quickly a shared page
or slide that you want to display in the content viewer.

To view thumbnails of slides, pages, or whiteboards:

1 Inthe content viewer, select the tab for the document, presentation, or whiteboard
for which you want to view thumbnails.

2 On the content viewer toolbar, select Show Thumbnails from the View menu.

| [ show Thumbnal

¥} Rotabs Page Left
%  Rotate Page Right

Al B Sync Display Far Al

5 Fusrn X = |yl

Thumbnails of all pages or slides in the selected document, presentation, or
whiteboard appear in the thumbnail viewer, in the left column.
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3 Optional. To display any page or slide in the content viewer, double-click its
miniature in the thumbnail viewer.

Note: Participants must have both the View thumbnails and View any page privileges to display
a miniature of a page or slide at full size in the content viewer.

To close the thumbnail viewer:

On the content viewer toolbar, select Hide Thumbnail from the View menu.

Synchronizing all participant views

You can synchronize the display of a shared page, slide, or whiteboard in all
participant content viewers with the display in your viewer. Once you synchronize
displays, the page, slide, or whiteboard in participant content viewers appears at the
same magnification as in your content viewer.

To synchronize participant views of slides, pages, or whiteboards:

On the View menu at the bottom of the window, select Sync Display for All.

-0

E| Sync Display for All.
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Clearing annotations
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You can clear any annotations that you or another attendee makes on a shared page,
slide, or whiteboard in the content viewer. You can clear:

= All annotations at once
= Only specific annotations

= If you are the presenter or host, clear all annotations you have made

T /-~ ~g¢ ~ MW~ P ~| annotation tools

To clear all annotations on a shared page, slide, or whiteboard:

1 On the annotation toolbar, click the downward-pointing arrow to the right of the
Eraser Tool icon.

I/-f Eraser tool

2 Choose Clear All Annotations.

Note: Only annotations on the page or slide that currently appears in your content viewer are
cleared. Annotations on other pages or slides are not cleared.

If you are the host or presenter, you can clear all the annotations you've made.

To clear all annotations you have added to a shared page, slide, or
whiteboard:

1 On the annotation toolbar, click the downward-pointing arrow to the right of the
Eraser Tool icon.

I/-f Eraser tool

2 Choose Clear My Annotations.

To clear specific annotations on a shared page, slide, or whiteboard:

1 On the toolbar, click the Eraser Tool icon.
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I/"f Eraser tool

Your mouse pointer changes to an eraser.

2 Click the annotation you want to clear.

To turn off the eraser tool:

On the toolbar, click the Eraser Tool icon.

l/"f Eraser tool

Clearing pointers

You can clear your own pointers on all shared slides, pages, or whiteboards in the
content viewer. If you are a presenter, you can also clear all participant pointers.

B T /-0 M- - Annotation tools

To clear your own pointer on all shared slides, pages, or whiteboards:

1 On the toolbar, click the downward-pointing arrow to the right of the Eraser Tool
icon.

I-/- 7 Eraser tool

2 Choose Clear My Pointer.

Saving, opening, and printing presentations,
documents, or whiteboards

Meeting participants (hosts, presenters, and participants with privileges) can access
and print documents, presentations, and whiteboards shared in a meeting. For
example, you can:

= Save a shared presentation
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= Open a saved document

= Print a whiteboard

Saving a presentation, document, or whiteboard
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You can save any shared document, presentation, or whiteboard that appears in the
content viewer. A saved file contains all the pages or slides in the document,
presentation, or whiteboard that is currently displayed in the content viewer, including
any annotations and pointers that you or other attendees added to them.

Files that you save are in the Universal Communications Format (UCF), which have
an .ucf extension. You can open a .ucf file either in another meeting or at any time
outside of a meeting.

Once you save a new document, presentation, or whiteboard to a file, you can save it
again to overwrite the file or save a copy to another file.

To save a new document, presentation, or whiteboard that appears in the
content viewer:

1 On the File menu, choose Save > Document.
The Save Document As dialog box appears.
2 Choose a location at which to save the file.

3 Type a name for the file in the File name box.

To save changes to a saved document, presentation, or whiteboard that
appears in the content viewer:

On the File menu, choose Save > Document.

Meeting Manager saves the changes to the existing file.

To save a copy of a document, presentation, or whiteboard:
1 On the File menu, choose Save As > Document.

The Save Document As dialog box appears.
2 Do either or both of the following:

= Type a new name for the file.

= Choose a new location at which to save the file.
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Opening a saved document, presentation, or whiteboard

If you saved a document, presentation, or whiteboard that appeared in the content
viewer during a meeting, you can do either of the following:

= Open file in the content viewer during another meeting for sharing. Only a
presenter or participants who have the Share documents privilege can open a
saved file during a meeting.

= Open the file at any time on your computer's desktop. If you open a saved file on
your desktop, it appears in the WebEx Document Manager, a standalone, or
“offline,” version of the content viewer.

A saved document, presentation, or whiteboard is in the saved Universal
Communications Format (UCF) and has a .ucf extension.

To open a saved document, presentation, or whiteboard file in the content
viewer:

1 On the File menu, choose Open and Share.

The Share Document dialog box appears.
2 Select the document, presentation, or whiteboard file that you want to open.
3 Click Open.

To open a saved document, presentation, or whiteboard on your computer's
desktop:

Double-click the saved file.

The document, presentation, or whiteboard opens in the WebEx Document Viewer.

Printing presentations, documents, or whiteboards

You can print any shared presentations, documents, or whiteboards that appear in
your content viewer. A printed copy of shared content includes all annotations and
pointers that you or other participants added to it.

To print shared content:

1 Inthe content viewer, select the tab for the document, presentation, or whiteboard
that you want to print.

2 On the File menu, choose Print > Document.

3 Select the printing options that you want to use, and then print the document.
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Note: When printing shared content in the content viewer, Meeting Manager resizes it to fit on
the printed page. However, for whiteboards, the Meeting Manager prints only the content that lies
within the dashed lines on the whiteboard.

If you are a meeting participant...

If you are participating in a meeting, (and have not taken on another role, such as host
or presenter), you can move around independently in shared documents and
presentations, if the host has assigned these privileges to you. For shared documents,
presentations, and whiteboards, you can:

Display any page

Synchronize your view with the host's view
Save shared documents

Open shared documents

Print shared documents

Displaying pages, slides, or whiteboards
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For participants

If you have been granted the necessary privileges, you can navigate to different pages,
slides, or whiteboard “pages” in the content viewer. Each document, presentation, or
whiteboard being shared appears on at the top of the content viewer.

1

2

In the Meeting window, in the content viewer, select the tab for the document,
presentation, or whiteboard that you want to display.

If there are more tabs than can appear at one time, select the down arrow button to
see a list of remaining tabs, or use your keyboard arrows forward and back
through all the tabs.

Select the down arrow

Chck Skt U T e - ¢ to view remaining tabs.
T A =O0=~@ ~MW-3 | ¢ |[02Agpndd Markebrg |
.. .

On the toolbar, click a button to change the page or slide you are viewing.
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Select the:
Customer Care - = Drop-down arrow to choose any page or slide
Pl 4 |07 Initiatives * # = Leftarrow to see the previous page or slide

=  Right arrow to see the next page or slide

If Microsoft PowerPoint slides are being shared, the drop-down list also displays the
title of each slide.

Synchronizing your view of pages, slides, or whiteboards

During a meeting, you can synchronize the display of shared content in your content
viewer with the display in the presenter's viewer. This option is useful, for example, if
you are viewing a previous slide in a presentation and want to quickly return to the
actual slide that the presenter is discussing. Synchronizing your display also resizes it
to that in the presenter's content viewer.

To synchronize your view of shared content in the presentation viewer:
On the View menu at the bottom of the window, select Sync Display With
Presenter.

[13¥  Sync Display With Presenter
t0
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About sharing Web content

You can share Web content that resides on:

= The public Internet or Web.

= Your company's intranet.

= Your computer or another computer on your private network.
Web content includes:

= Web pages, including pages that contain embedded media files, such as Flash,
audio, or video files.

= Standalone media files, such as Flash, audio, or video files.

The Web content that you share opens in the content viewer on each participant's
screen. If you share a Web page, participants view and interact independently with the
content on the page. If the page contains links to other pages, they can also navigate
independently to those pages.

If you use Web content sharing, then, participants can experience audio and video
effects on a Web page. However, unlike Web browser sharing, this option does not
allow you to guide participants to other Web pages.

Important: If you share content that requires a media player, participants can view and interact
with the content only if the appropriate player is installed on their computers.
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Sharing Web content

You can share a Web page that contains multimedia effects. The page opens in the
content viewer on each participant's screen.

To share Web content:
1 On the Share menu, choose Web Content.
The Share Web Content dialog box appears.
2 Inthe Address box, enter the address, or URL, at which the content resides.
Or, if you have previously shared the content, select it in the drop-down list.
3 Inthe Type box, select the type of Web content that you want to share.
4 Click OK.

Tip: You can copy a URL from any source, such as another browser window, and then paste it in
the Address box.

Differences between sharing Web content and
sharing a Web browser

Meeting Center provides two options for sharing Web-based information. You can
share Web content or share a Web browser with meeting participants. Choose the
feature that better suits your needs.

Sharing option Advantages Disadvantages

Web browser sharing = Lets you guide =  Does not display media
participants to various effects or transmit
Web pages and sites on sounds on Web pages.
the Web. = Does not let participants

= Lets you grant attendees interact with Web pages

control of your Web independently.
browser.

=  Lets you and other
participants annotate
Web pages.
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Sharing option Advantages Disadvantages
Web content sharing = Displays Web pages, Does not let you guide
and lets participants participants to other Web

experience media effects  pages.
on Web pages, including
video and sound.

= Lets participants interact
with Web pages
independently in their
content viewers.
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Sharing Software

Sharing a tool, like a software application, works differently from sharing a document
or presentation. When you share software during a meeting, a sharing window opens
automatically on all participant screens. You can show, in this special sharing
window:

= An application (for example, you want to edit a document as a group or show
your team how a tool works)

= Computer desktop (for easily sharing several applications at once and for
sharing file directories open on your computer)

= Web browser (useful for sharing particular Web pages with participants or
showing a private intranet)

= Any application or the desktop on a remote computer with Access Anywhere
installed on it (for example, you are on the road, and the computer in your office
has the infomation you need)

Your user role in a meeting determines your level of participation in sharing software.
Whichever role you take, this table describes the basic tasks associated with that role.
For detailed instructions on a particular task, select "More" by the task description.
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Role Task description:
Host and Share software:
presenter hare Yo Ak Barticipant: =  Share applications
Eresentation or Document..,  ChrH-Ak+0 =  Share your desktop (if this feature
Apphcation. ., is available)
Deskiop Cirk+ak+D =  Share a Web browser
whitehiard ChrivAk+N =  Control the appearance of shared
software
Wieb Content. .
Web Brovser =  Annotate shared software
= = Let a participant control your
. shared software
'MM M #““— &

Participant s 1 View and work with shared software:
P Ve = Control the appearance of shared

Fit toaeth: software
Fuy 9
: . =  Ask to control shared software

ip
s Maruage Fareks = Annotate shared software

3
100 Ak to Control =  Stop participating in software
00 dudo ’ sharing
A W

Mashrg Opbons L]

} i
-~ |
Cicach. Misstrng Control - I

Sharing applications

You can use application sharing to show all meeting participants one or more
applications on your computer. Application sharing is useful for demonstrating
software or editing documents during a meeting.

Participants can view the shared application, including all mouse movements without
having to run the application that you are sharing on their computers.

Here are just a few tasks you can perform:

= Start sharing an application and open more applications to share
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= Control the appearance and viewing of shared software (pausing, changing to full-
screen view, and so on)

= Annotate and draw on a shared application and allow participants to draw

= Learn about sharing application effectively

= Stop sharing an application

Starting application sharing

Host or Presenter only

You can share any application on your computer with meeting participants.

To share an application:

1 On the Share menu, choose Application.

The list of all applications currently running on your computer is displayed.

Meeting  Help

| Wiew  pAudio  Parkicipant
i My Deskiop Chel+alk+0
Docurment From My Computer, .,
| Application
: whiteboard Ctrl+alt+h
Web Content. ..
\Weh Browser
Remote Computer, ..
My [Meeting YWindow

2 Do one of the following:

Running Application:

‘w srv-termsics - Remaoke Deskkop

E;' Microsaft Excel - Merge, xls:x

E 'ebEx Meeting Center - Google Chrome
vj My Compuker

1 windaws Explorer

Qther Application. ..

= |f the application you want to share is currently running, select it in the list to

begin sharing it.

= |f the application you want to share is not currently running, select Other
Application. The Other Application dialog box appears, showing a list of all
applications on your computer. Select the application, and then select Share.

Your application appears in a sharing window on participant screens.
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Sharing several applications at once

Host or Presenter only

If you are already sharing an application, you can share additional applications
simultaneously. Each application that you share appears in the same sharing window

on participant screens.

To share an additional application:

Select the application you want to share:

= |f that application is currently running: Select the Share button.

Each application you have open on your

(SSHARE Qg desktop has these buttons in the upper right

corner.

Tip: When you open any application that you have minimized, it opens with the sharing
buttons in the upper-right corner.

= If that application is not currently running: Select the Share Application
button in the Meeting Controls Panel. You can also fnd it using File Explorer
or any other tool you use to locate applications on your computer. When you
open it, it appears with the Share button.

Your application appears in a sharing window on participant screens.

Meeting Center tracks the number of applications you are currently sharing:

s 8 The Share button to the
=T ek right of Pause lets you
§ ‘Asign \,  FPamidpanty select the different types of
o ate sharing 2 applcations content ou want to share.

Tip: Alternatively, you can share multiple applications by sharing your computer's desktop.

Stopping application sharing for all participants
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Host or Presenter only

You can stop sharing an application at any time. Once you stop sharing an
application, participants can no longer view it.

If you are sharing multiple applications simultaneously, you can stop sharing either a
specific application or all applications at once.
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To stop sharing a specific application when sharing multiple applications:

On the title bar of the application that you no longer want to share, select the Stop
button.

i E- = - nd (e | 4 -

Pasta Ehaa ALTHR 1 Faticpamn e Bacprder A ,

s g shairsg Mcmmolft Excel - Me....

To stop sharing all applications:

In the Meeting Controls box, select the STOP button.

I =3 ]
il R S - el (W F A =
Pt Shane daTign N Pasichanis Chat Racorder furonate |
Vou ara sharing 3 apploations

You can also pause sharing: Select the Pause button (located next to the Stop button).

Sharing your desktop

You can share the entire content of your computer, including any applications,
windows, and file directories that reside on it. Participantscan view your shared
desktop, including all mouse movements.

Tasks related to sharing your desktop:
= Start sharing your desktop

= Manage how participants view your shared software (pausing, changing to full-
screen view, and so on)

= Annotate and draw on your desktop and allow participants to annotate
= Read a few tips for sharing your desktop effectively
= Stop sharing your desktop

= Allow a participant to control the shared desktop
Starting desktop sharing

Host or Presenter only

You can share your computer's desktop with meeting participants.
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To share your desktop:
1 On the Share menu, choose Desktop.

If you have more than one monitor, a submenu shows the available monitors.

File  Edit Wiews Audio  Participant  Meeting  Help
Iy Deskkop Monitor 1
- Document From My Computer, ., Manitar 2
Application k
Rebecc|  whirehoard Chrl+AlE+r

TDPiC Web Content. ..

Web Browser

Py Meeting Window

2 Select the monitor to share.

Your desktop appears in a sharing window on participants' screens.

Note: If your desktop has any background images or patterns, or wallpaper, your Meeting
Manager software may remove them from participant views to improve the performance of
desktop sharing.

Stopping desktop sharing

You can stop desktop sharing at any time.

To stop sharing your desktop:

In the Meeting Controls box, select the Stop button.

| il S~ 2. o You can also pause sharing: Select the Pause
. Puar | tem | e P button (located next to the Stop button).
i i s o ek

If you are a participant, rather than the presenter, select the Return button to leave the
sharing session.
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= wd o = You do not leave the meeting, just the sharing
e e portion of it.
Wiswmg i Feshareeni's desdon

Sharing a Web browser

A presenter uses Web browser sharing to show all meeting participants all Web pages
that he or she accesses in a browser. Web browser sharing is useful for showing
participants Web pages on the Internet, or the presenter's private intranet or computer.

Participants can view the presenters Web browser, including mouse movements, in a
sharing window on their screens.

Tasks related to sharing a Web browser:
= Start sharing a web browser
= Manage how participants view the shared Web browser

= Annotate and draw on a shared Web browser and let a participant draw on a
shared Web browser

= Learn how to share Web browsers effectively

= Stop sharing a Web browser

Starting Web browser sharing
Host or Presenter only
You can share a Web browser with meeting participants.
To share a Web browser:
1 On the Share menu, choose Web Browser.

Your default Web browser opens.

2 Goto a Web page in your browser.

Note: Participants view all new Web browser windows that you open. You can show
participants several Web pages simultaneously
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Stopping Web browser sharing

You can stop sharing a Web browser at any time.

To stop Web browser sharing:

On the title bar of the application that you no longer want to share, select the Stop
button.

Tip: You can temporarily pause Web browser sharing, rather than stopping Web browser sharing.

Controlling views of shared software

Role Task description:
Host or el Yiew  Audio Participant P =  Pause or resume sharing
Presenter .
My Desktop ChlAlE+D = Control full-screen view of
- shared software
Ciocurment From My Computer, .. = Synchronize views
application r
whiteboard CErlAlE

Web Conkent. .,

Weh Browser

Remote Corputer...

My Meeting Window
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Participant E tiates
Manage Panek...
Ak o Conbrod
Audio Conference. .,
i
Meating Irfo...

Fostum bo Mesting YWindow

Chapter 14: Sharing Software

Task description:

= Control your view of shared
software Close your
sharing window

Full Screen

®  Fit in iewser

Fit to Width

The presenter can control participant views of a shared desktop, remote computer
(if available), application or Web browser.

Participants can manipulate their individual displays of the shared software.

Pausing and resuming software sharing

Host or Presenter only

While sharing software, you can temporarily pause sharing to freeze attendees' views.

If you want to return attendees to the Meeting window while sharing software,
pausing shared software conserves resources on your computer and bandwidth for
your Internet connection. This option is also useful if you do not want attendees to see
certain actions that you take with shared software.

You can resume sharing to restore attendees' views of shared software at any time.

To pause software sharing:

Select the Pause button, located to the right of the Stop button.

W~ 2
Share Sszign % Pa

-1|j You are sharing 2 applic
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The word "Paused™ now appears in the panel. A short message is displayed indicating
that the participant view would be frozen until you resume sharing. Additonally, the
Pause button text changes to Resume.

oo 29
gy il v . v
Resurne Share SEsign

| Paused
.

To resume software sharing:

Select the Resume button.

Controlling full-screen view of shared software
Host or Presenter only

You can switch participant views of a shared application, remote computer (if
available), or Web browser between a standard window and a full-screen view.

A full-screen view of shared software fits participant entire screens and does not
include a title bar or scroll bars.

Participants can override your setting to control full-screen view or to zoom in or out
on the shared software on their computers.

To display shared software in a full-screen view:

On the Meeting Controls Panel, select the down arrow (the last button on the
panel)and then choose View. Then choose Full screen for Participants.

To see panel controls, select the gray
RS | - — down-arrow button (it is the last
— button).

Plarusge Fae

dgde e

Frobe ard Beenrd

[ [ Ell-sraen N Rardicipais
Sop Apple mee. Tharrg Trctionss for AL

Erd Ysmrg I’

Synchronizing views of shared software
Host or Presenter only

While sharing an application, desktop (if desktop sharing is available), or Web
browser, you can synchronize all participant views of the software with your view.

180



Chapter 14: Sharing Software

Synchronizing views of shared software ensures that the sharing window appears as
the active window on participant screens. For example, if a participant has minimized
the sharing window, or moved another window on top of it, the sharing window
becomes the active window when you synchronize views.

Note: Synchronizing views has no effect on the size in which the shared software appears on
participant screens. Participants can control the size of their views independently.

To synchronize your view with participants:

On the Meeting Controls Panel, select the down arrow (the last button on the panel)
and then choose View. Then choose Synchronize for All.

-
AgHign Partdzans Chae Foerdes Annaiace l -
i i

=T ! tiied - 14 I &l Hhotes

Manage Panels...

Sudia Conference...

Trrvhe and Remied. .,

| Wherat Eull-screen for Participants

Stop Applcatin Sharng || Synchrorvos for Al
Ersd Meeting [

Selecting a monitor to share

To select a monitor to share:
1 Start sharing your desktop:
= On the Quick Start page, select Share Desktop.

If two or more monitors are detected on your system, a window appears and
allows you to select one of the monitors.

Sedect a momtor bo share

1

= On the Share menu, select Desktop.

A submenu shows the available monitors.
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File Edit ELTUW View
| My Deskiop

Dioowmert from My Camputer...

fuedio  Particpart  Meeting  Help

Monkor 2

application oy
Rebect)  wijteboard Chrk+Ak+H
Topic|  web coment...

Wb Browssr

My Maeting Window

2 Select the monitor you want to share.

The Meeting Controls Panel indicates which monitor you are sharing. If you are
sharing the same monitor where the Meeting Controls Panel is, it says, "You are
sharing this monitor."

If you are sharing a monitor that is not the same monitor where the Meeting Controls
Panel is, it says, "You are sharing monitor <number>."

Il & &- a8

Fwes Shim Asgigh DAt Chal.

L

i

In addition, a green border appears around the monitor you are sharing.

To select a different monitor to share:

1 On the Meeting Control Panel, select the Select Content to Share button.

2 In the submenu that appears, select Share Desktop.

A submenu shows you the available monitors.
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T
i D
Ll

1
Shae Dogyment #f|

Shae w‘ casbon  #

3 Select the monitor number you want to share.

The Meeting Controls Panel indicates which monitor you are sharing. In addition, a
green border appears around the monitor you are sharing.

Controlling your view as a participant
Participant only

When viewing or remotely controlling shared software, you can set these options,
which determine how shared software appears on your screen:

= Display the shared software in a full-screen view or a standard window. A full-
screen view of a shared application or desktop fits your entire screen and does not
include a title bar or scroll bars.

= Scale, or resize, a shared desktop or application to fit the full-screen view or
standard window in which it appears.

To control your view of shared software:

On the Meeting Controls Panel, select the down arrow (the last button on the
panel)and then choose View. Then choose an option from the menu.

=T
Marage Pansk.. .
Aak. o Conbro

Audio Confarance, ,,

bl Full Screen

Mieting Info. ..

Rstum to Mesting Window | © FILIN Viewer
Fit ba Wickh
25%

E%
=%
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0%
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Tip: To switch quickly from the standard window to a full-screen view of shared software,
double-click the shared software.

Closing your participant sharing window

Participant only

While viewing or remotely controlling shared software, you can close the sharing
window in which the software appears at any time. Closing a sharing window returns
you to the Meeting window. If you close a sharing window, you can reopen it at any
time.

To close a sharing window:

1 On the Meeting Controls Panel, select the down arrow (the last button on the
panel)and then choose Stop <option> from the menu. The following graphic
shows the Stop Application Sharing option because an application has been
shared. If you have shared your desktop or Web Browser, the menu would show
Stop Desktop Sharing.

sl e zL]

RETLIRMN
b Farteosanis Chat Aarisat ahe |
wievang Sandesp Ealalmshna's agplic.... o lotes

Manage Paneks

Audo Confarence
Irwite and Ramind.. .

Wi

[ Stop Applcation Shanng
End Mes=ting

2 Choose the appropriate option.

The sharing window closes. The Meeting window then automatically opens.

To return to the sharing window at any time:

In the Meeting window, on the Sharing menu, select a sharing option (desktop,
remote computer, application or Web browser).

Switching your participant view

Participant only
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While a presenter is sharing software, you can return to the Meeting window at any
time. The sharing window remains open on your computer, so you can return to
viewing the shared software at any time.

To return to the Meeting window while the presenter is sharing software:

On the Meeting Controls Panel, select the Return to Meeting Window icon.

- ——

s |98/

-
\ Participants Chat Annotate '

I

Yiewing Sandeep Balakrishnia's applic. ..

The Meeting window then appears.

To return to a sharing window:

In the Application Share dialog box, which appears in the Meeting window, select
Return to Sharing.

* Application Share

¥au are nao langer viewing the presenter's shared cantent,

|<§ Return to Sharing |

Annotating shared software

Task description:
=  Start or stop annotation mode
= Use annotation tools

Host or Presenter
= Let a participant use annotation

!Omu.'h-.:.- & ¢ @m /| s ,
A P e e W Peien | R e i | =  Save annotations

. o ot s g L - g T
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Task description:

= Ask for permission to use

.. annotation
Participant )
| . = Use annotation tools
%@ ) b / = =  Save annotations
., \  Puwscpan chu Anriias |
| Miewing Sanclesn Balzhiishna's spplc. . =  Give up annotations

You can annotate a shared desktop, application or Web browser during a meeting,
using the highlighter or other annotation tool.

Meeting participants can see annotations in their sharing windows.

Starting and stopping annotation
Host or Presenter only

When you are sharing a desktop, application or Web browser, you can make
annotations on the software.

Participants can see all your annotations.

To start annotating shared software:

1 On the Meeting Controls panel, select the Annotate button.

. - a pencil on it.
Amign % Parligasn ch Bgryecier Annalyg
i man anhotats

The Tools panel appears.

of i The Annotation button has the image of
Ae | s B @ . .
L

|~/ amotationToos x|
BT/ -0 -"H-7- @

[& allow to snnotate | g8 Stop Annotating |

2 Select a tool for making annotations.

Note:
= You can let one or more participants annotate the shared software.

= Once you or a participant makes annotations, you can save an image of the software,
including the annotations.

186



Chapter 14: Sharing Software

To stop making annotations on shared software and return your mouse to a normal
pointer, you must stop annotation mode.

To stop annotation mode:

Select the Stop Annotating button in the Tools panel.

|~/ annotationtools x|
B-T/-0O-2-m-5- @

[& allow to snnotate: = | &8 Stop Annotating |

Using annotation tools

If, while sharing software, you are the presenter or the presenter allows you to
annotate, you can use the Annotation Tools panel that appears to make annotations.
The Annotation Tools panel provides a variety of tools for annotating a shared
desktop or application.

R A
5-T /-0O0-2 -W-5- @

[& allow to snnotate: = | &8 Stop Annotating |

Annotation
Tool Icon Description

Lets you point out text and graphics on shared content. The pointer
displays an arrow with your name and annotation color. To display the

Pointer |::> laser pointer, which lets you point out text and graphics on shared
content using a red “laser beam,” click the downward-pointing arrow.
Clicking this button again turns off the pointer tool.

Lets you type text on shared content. Participants can view the text
once you finish typing it and click your mouse in the content viewer,
Text T outside the text box.

To change the font, on the Edit menu, choose Font. Clicking this button
again turns off the text tool.

Lets you draw lines and arrows on shared content. For more options,
Line / click the downward-pointing arrow. Clicking this button closes the
Rectangle tool.
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Annotation
Tool Icon

Rectangle

Annotation
Color

]
Highlighter Sﬁ‘
| ]

Eraser

Q

Description

Lets you draw shapes, such as rectangles and ellipses on shared
content. For more options, click the downward-pointing arrow. Clicking
this button again closes the Rectangle tool.

Lets you highlight text and other elements in shared content. For more
options, click the downward-pointing arrow. Clicking this button again
closes the Highlighter tool.

Displays the Annotation Color palette, on which you can select a color
to annotate shared content. Clicking this button again closes the
Annotation Color palette.

Erases text and annotations or clears pointers on shared content. To
erase a single annotation, click it in the viewer. For more options, click
the downward-pointing arrow. Clicking this button again turns off the
eraser tool.

Letting a participant annotate shared software

Host or Presenter only

You can let one or more meeting participants annotate a shared desktop (if available),
application or Web browser.

You can let several participants annotate shared software at the same time.

To let a participant annotate shared software:

1 On the Meeting Controls Panel, select the Annotate icon.

3 ks = w
= i
!

Arign Particzasiy

Yoid san anrotate

v @ B -

L Annalas

The tools panel appears.

[~/ amotationtoos %]
BT /=0 -AN-9 -8

[& allow to snnotate | g8 Stop Annotating |

2 Select the down arrow on the Allow to Annotate button.
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3 On the menu that appears, choose which participants can annotate the shared
software:

You can choose "All" or select someone from the list.

Note:
= You can stop a participant from annotating shared software at any time.

Requesting annotation control of shared software
Paprticipant only

If a presenter is sharing a desktop, Web browser or application, you can ask the
presenter to allow you to annotate the shared software.

After you have permission, you can:

= Make annotations by highlighting areas on the software, drawing lines and shapes,
typing text, and using pointers.

= Clear annotations at any time.
= Change the color that you are using to make annotations.

= Save an image of your annotations on the shared software.

To request annotation control of shared software:

1 Inthe Meeting Controls Panel, select the Annotate button.

T F. A o P = The Annc.)tate. button has the image
3 . %, Patdpant Chit ATl e ofa penC|I on it.
N — (e

Wigwing Sandesn Balakrishna's appic,

A request message appears on the presenter's screen.

After the presenter allows you to annotate, the Annotation Tools panel appears:

BT /020N~ -|@®

[ allowe b Annatate = | (€8 Stop Annakating |

2 Select the tool you want to use.
Optional. Choose another annotation tool.

Note: If you are controlling shared software remotely, the presenter must take back control to
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turn on annotation mode. You and the presenter can then annotate the shared software
simultaneously.

Giving up annotation control

Participant only

If the presenter has granted permission to you to annotate, you can stop annotating at
any time.

To stop annotating:

In the Annotation Tools panel, select the Stop Annotating button.

Stopping an participant from annotating shared software

Host or Presenter only

If a participant is annotating shared software, you can turn off the annotation feature.

To turn off the drawing feature:
1 On the Meeting Controls Panel, select the Assign Control button.

a- |\ - 9@
azzign . Paticpams Chat Faander A
RS ¢ Maks Preserbar ]
' Pass Eavbosad and Modse Control B
| # alow s agnotate al

2 On the menu that appears, choose Allow to Annotate.

A check mark appears next to the names of those who can annotate the shared
software.

3 Choose the name of the participant to cancel the selection.

Taking a screen capture of annotations on shared software

If you make annotations on shared software, you can save an image of the shared
software, including all annotations and pointers, to a WebEx Universal
Communications Format (.ucf) file. You can open an .ucf file on your computer
desktop or in the content viewer in a meeting.
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Note: Participants cannot use this option unless the Host or Presenter grants the Screen Capture
privilege to them. As Host, if you are sharing proprietary software, you may want to ensure that
this privilege is turned off.

To take a screen capture of annotations on shared software:

1 On the Tools panel, select the Screen Capture button.

¥ / Annotation Tools

BT -0-2m-®-|

[€8 allow bo Annotate » | |£8 Stop Annatating | [Screen Capture

The Save As dialog box appears.

2 Choose a location at which to save the file, and then select Save.

Note: The file you save is an image of your entire desktop.

Granting participants control of shared software

While sharing the following types of software, the presenter can let a participant
control it remotely:

= Application
= Desktop (if available)

= \Web browser

A participant who has remote control of shared software can interact with it fully.
While a participant is controlling shared software, the presenter's mouse pointer is
inactive.

Rules of thumb for controlling shared software:
= Any participant can send a request to control the software remotely.
= The presenter can then grant control to the paticipant.

= Alternatively, the presenter can automatically grant control of shared software to
any participant who requests remote control.

= The presenter can stop a participant from remotely controlling shared software at
any time.
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Caution: A participant who has remote control of the presenter's desktop can run any programs
and access any files on the computer that the presenter has not protected with a password.

Requesting remote control of shared software

Participant only

If the presenter is sharing an application, desktop, or Web browser, you can ask the
presenter to grant remote control to you.

Once you assume remote control of shared software, you can interact with it fully.

To request remote control of shared software:

On the Meeting Controls Panel select Ask to Control.

Rl wm sl
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A request message appears on the presenter's screen.

Tip: While remotely controlling shared software, you can request the presenter to allow you to
annotate it.

Letting a participant remotely control shared software

192

Host or Presenter only

If you are sharing software, you can let a participant control it remotely.

To let a participant remotely control shared software:

1 On the Meeting Controls Panel select the down-arrow button on the Assign
button.
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sk " This button is the third button from the
Mo o * 3 / = left on the Controls panel.
gl NS LN R R
i & Mhske Presenter v |
|
L
& Alicws to Aprotate b Testing
[t

2 On the menu that appears, choose Pass Keyboard and Mouse Control > [name of
participant].

Automatically letting participants remotely control shared
software

Host or Presenter only

While sharing software, you can automatically grant control of the software to a
participant who requests control. In this case, a participant who requests remote
control automatically takes control of the software that you are sharing. While
automatic remote control is turned on, any participant can take control away from any
other participant by requesting remote control.

To automatically let participants control shared software:

1 On the Meeting Controls Panel select the down-arrow button on the Assign
button.
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2 On the menu that appears, choose Pass Keyboard and Mouse Control > Auto
Accept All Requests.

To stop letting participants control shared software automatically:

1 On the Meeting Controls Panel select the down-arrow button on the Assign
button.

193



Chapter 14: Sharing Software

2 On the menu that appears, choose Pass Keyboard and Mouse Control. Then
select Auto Accept All Requests to remove the check mark and cancel the
selection.

Stopping remote control of shared software
Host or Presenter only

While a participant is remotely controlling a shared application, desktop, or Web
browser, you can take back control of the shared software at any time. You can do
either of the following:

= Take back remote control of shared software temporarily, allowing a participant to
take control at any time.

= Prevent a participant from further controlling shared software.

To take back control a shared software temporarily:
On your computer's desktop, select your mouse.
You can now control the shared software.

The participant who was controlling the shared software can take back control at any
time by clicking his or her mouse.

To prevent a participant from further controlling a shared software:
1 Onyour computer's desktop, click your mouse.
You can now control the shared software.

On the Meeting Controls Panel select the down-arrow button on the Assign
button.

)
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2 On the menu that appears, choose Pass Keyboard and Mouse Control.

A menu appears, containing a list of all participants in the meeting. A check mark
appears to the left of the participant who has remote control.
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3 Choose the participant's name to remove the check mark and cancel the selection.

Sharing applications with detailed color
(Windows)

For Windows users only

By default, Meeting Manager sends images of shared software using 16-bit color
mode, which is the equivalent of your computer's “High Color” (16-bit) setting. This
mode provides an accurate representation of color for most shared applications.
However, if your shared application contains detailed color images-such as color
gradients-the color may not appear accurately on participants' screens. For example,
color gradients may appear and color “bands.”

If the accuracy and resolution of color in a shared application is important, you can
turn on True Color mode in Meeting Manager. Using this mode, however, may affect
the performance of application sharing.

When using True Color mode, you can select one of the following options:
= Better imaging (no image compression)
= Better performance (some image compression)

“Performance” refers to the “speed” at which images appear on participant screens,
and “imaging” refers to the quality of the color in shared images.

Note: Before turning on True Color mode, ensure that your monitor display is set to True Color
(either 24- or 32-bit color). For more information about setting options for your monitor, refer to
Windows Help.

To turn on True Color mode:
1 If you are currently sharing an application, stop your sharing session.
2 On the Meeting menu, choose Meeting Options.
The Meeting Options dialog box appears.
3 Select the True Color Mode tab.
4 Select Enable True Color mode.
5 Select one of the following options:
= Better imaging
= Better performance

6 Select OK or Apply.

195



Chapter 14: Sharing Software

Sharing applications with detailed color (Mac)

196

For Mac users only

Before sharing an application or your desktop, you can choose one of the following
display modes:

= Better performance: The default mode. Lets you display your content faster than
you do using the better image quality mode.

= Better image quality: Lets you display your content with better image quality. In
this mode, your shared content may take longer time to display than in the better
performance mode.

Note: Changing the display mode does not affect presentation or document sharing.

To choose a display mode for your shared desktop or applications:
1 In the Meeting window, on the Meeting Center menu, choose Preferences.
The Preferences dialog box appears.

2 Select Display.

A Preferences The display mode options

/ A B appear.
A Toois [ENREIES

Select an option for displaying shared content with atbendees

=) Better performance
() Better image guality

"-_Cantei_\ ([ ok )

3 Select Better performance or Better image quality, as appropriate.
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Tips for sharing software

The following tips can help you to share software more effectively:

Application sharing only: To save time during a meeting, ensure that any
applications you intend to share are open on your computer. At the appropriate
time during the meeting, you can then quickly begin sharing an application,
without waiting for the application to start.

If participants cannot see all of the shared software without scrolling their sharing
windows, they can adjust their views of the shared software. They can reduce the
size of the shared software in decrements, or scale it to fit inside their sharing
windows.

To improve the performance of software sharing, close all applications that you
do not need to use or share on your computer. Doing So conserves processor usage
and memory on your computer, thus helping to ensure that Meeting Manager can
send images of shared software quickly during a meeting. Also, to ensure that a
maximum amount of bandwidth is available for software sharing, close any
applications that use bandwidth, such as instant messaging or chat programs, and
programs that receive streaming audio or video from the Web.

If you are sharing an application for which the rendering of color on participants’
screen is important, you can improve color quality by turning on True Color
mode.

Application and Web browser sharing only: Avoid covering a shared application
or Web browser with another window on your computer's desktop. A
crosshatched pattern appears in participant sharing windows where the other
window is covering the shared application or browser.

Application and Web browser sharing only: If you want to switch your display
between shared software and the Meeting window, you can pause software
sharing before you return to the Meeting window, and then resume sharing once
you return to the shared application. Pausing software sharing conserves processor
usage and memory on your computer while you view the Meeting window.

Application and Web browser sharing only: If you have more than one monitor,
when you share an application or web browser, the participants can see it on
whichever monitor you are displaying it. If you move the application or Web
browser to another monitor, it is still visible to the participants. If you are sharing
more than one application, the participants will see the best view if you make sure
the applications are displaying on the same monitor.

Because software sharing requires additional bandwidth during a meeting, it is
recommended that you use a dedicated, high-speed Internet connection when
sharing software. However, if participants are using dial-up Internet connections,
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they may notice a delay in viewing or controlling shared software. If you want to
share a document, such as a Microsoft Word or Excel document, you can improve
the meeting experience for these participants by using document sharing instead
of application sharing.
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Using Chat

Chat is useful during a meeting if you want to:
= Send brief information to all participants
= Send a private message to another participant

= Ask a question but do not want to use the Q & A option, which provides a formal
procedure for asking and answering questions

All chat messages that you send or receive appear on the Chat panel in the meeting
window.

The Chat function allows you to perform these tasks:
= Send chat messages

= Assign sounds to incoming messages

=  Print chat messages

= Save chat messages

= Open a chat file during a meeting

Sending chat messages

During a meeting, the presenter can specify chat privileges for participants. These
privileges determine to whom participants can send chat messages.

To send a chat message:
1 Open the Chat panel.
2 Inthe Send to drop-down list, select the recipient of the message.

3 Enter your message in the chat text box.
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4 Depending on the operating system you use, follow this step:
= Windows: Click Send.

= Mac: Select enter on your keyboard.

Note: If you join a meeting in progress, you can see only the chat messages that participants send
after you join the meeting

Assigning sounds to incoming chat messages

200

You can choose to play a sound for one of these occasions:
= If you are not viewing the Chat panel
= For only the first chat message that you receive in a thread

= Whenever you receive a chat message

To assign sounds to incoming chat messages:
1 Open the Preferences dialog box by performing these steps:
= Windows: On the Edit menu, choose Preferences.

= Mac: On the Meeting Center menu, choose Preferences.

N

Depending on your operating system, follow one of these steps:

= Windows: Click the Chat tab.

= Mac: Select the Alerts button.

3 Select the check box for each action for which you want to play a sound.
4 Select a sound from the appropriate drop-down list.

By default, the drop-down list contains the names of all sound files that reside at
the default location on your computer.

5 To select a sound that does not appear in the drop-down list, follow these steps:

= Windows: Click Browse, and then select a sound file that resides in another
folder.

= Mac: Select Others in the drop-down list.
6  Windows only. To play the currently selected sound, click the button 1)
7 Click OK.

Note:
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= Meeting Center saves your sound preferences on your computer. However, if you start or join
a meeting on another computer, you need to set your preferences again on that computer.

= |If you are using Windows, sound files must have a .wav extension.

= In most cases, the default location for sound files is Cz\WINDOWS\Media. You can copy
other sound files to the default folder or any other directory to make them available in the
Preferences dialog box.

Printing chat messages

You can print all the chat messages that appear on the Chat panel.

To print chat messages:

1 Inthe Meeting window, on the File menu, choose Print > Chat.
A print dialog box appears.

2 Optional. Specify printer options.

3 Print.

Saving chat messages

You can save chat messages that appear on the Chat panel to a .txt file. You can then
reopen the file for use in any meeting or view the file's content outside a meeting by
opening the file in a text editor.

Once you save chat messages to a file, you can save changes to the messages or save a
copy of them to another file.

= Save chat messages for the first time in a meeting.
= Save change to a chat file

= Create a copy of a chat file

Saving chat messages to a new file
You can save chat messages you have sent or received to a new chat file.
To save chat messages to a new file:
1 In the Meeting window, on the File menu, choose Save > Chat.

The Save Chat As dialog box appears.

2 Choose a location at which you want to save the file.
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3 Type a name for the file.
4  Click Save.

Meeting Manager saves the chat messages in a .txt file at the location you selected.

Saving changes to a chat file

If you make changes to the messages on your Chat panel, you can save them to an
existing chat file.

To save changes to a chat file:
1 Inthe Meeting window, on the File menu, choose Save > Chat.

2 Meeting Manager saves the changes to the existing chat file.

Creating a copy of previously saved chat messages

If you have saved chat messages and want to create another copy of the messages, you
can do so by saving the chat messages to a chat file with a different name.

To create a copy of chat messages that have been previously saved:
1 Inthe Meeting window, on the File menu, choose Save As > Chat.
The Save Chat As dialog box appears.
2 Do either or both of the following:
=  Type a new name for the file.
= Choose a new location at which you want to save the file.
3 Click Save.

Meeting Manager saves the file at the location you chose. The file name has a .txt
extension.

Opening a chat file during a meeting

If you saved chat messages to a .txt file, you can display those chat messages on your
Chat panel by opening the file.

To open a chat file in a meeting:

1 Inthe Meeting window, on the File menu, choose Open > Chat.
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The Open Chat dialog box appears.
2 Select the chat file that you want to open.
3 Click Open.
The chat messages appear on the Chat panel.

If there are already chat messages in your chat viewer, Meeting Manager appends the
messages from the chat file to the existing messages.
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Polling Attendees

During a meeting, you can poll attendees by presenting them with a questionnaire.
Conducting a poll can be useful for gathering feedback from attendees, allowing
attendees to vote on a proposal, testing attendees' knowledge of a topic, and so on.

During the meeting, the presenter is responsible for:
= Preparing a poll questionnaire

= Conducting a poll during the meeting

After closing a poll, the presenter can:

= View poll results

= Share poll results with attendees

= Save poll results for viewing outside a meeting

Preparing a poll questionnaire

When preparing a poll questionnaire, you can:
= Create a questionnaire
= Edit a questionnaire

= Set a timer for polling

Creating a poll questionnaire

Presenter only
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To conduct a poll, you must first create a poll questionnaire. You create a
questionnaire in a meeting. To save time during a meeting, you can start the meeting
earlier than the scheduled time, create a questionnaire on the Polling panel, save it,
and then open it during the actual meeting.

To create a questionnaire (for Windows):

1 Open the Polling panel in a meeting.
2 In the Question section, select one of these question types:

= To create a multiple-answer guestion, select Multiple choice, and then select
Multiple Answers in the drop-down list.

= To create a single-answer question, select Multiple choice, and then select
Single Answer in the drop-down list.

= To create a text question, select Short answer.

3 Click New.

4 Type a question in the box that appears.

5 Inthe Answer section, click Add.

6 Type an answer in the box that appears.

7 To type another answer, click Add once you finish typing an answer.
The question and answers appear in the Poll Questions area.

8 Toadd questions, repeat steps 2 to 7.

This figure shows an example of a poll questionnaire.

Foll Questions:

1 What is your favorite color?
) ablue
O bred

) c.ogreen
) d.black

2Mhat do you enjoy doing st leisurey
[ a.reading
[ bovweatching movies
[ c traveling
[ d.sports

3 Please give us feedback about this event.



Chapter 16: Polling Attendees

To create a questionnaire (for the Mac):
1 Open the Polling panel in the event.

2 Add a question by clicking this button and then typing the question.

QE 'i':'E &ﬂ G z|}| \I}

3 Add an answer by clicking this button and then typing the answer.

A

4 To add more answers, repeat step 3.

w/ "ﬁ‘| N g

5 To add more questions, repeat step 2.

6 To change the question type for a question, click the text "Click here to change
question type" that appears under the specific question and then do one of the
following:

= To create a multiple-answer question, select Multiple Answers.
= To create a single-answer question, select Single Answer.

= To create a question that requires a text answer, select Short Answer.

O Gy A O "|}|‘~GV

1. Question 1
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h‘mur Answer ;
¥ Single Answer
Lopestmt, oo oo amed  Multiple Answers
Short Answer

Editing a questionnaire

You can change the type of a question and edit, rearrange, or delete the questions and
answers.

To change the type of a question:

1 Select the question by clicking it, and then select the new type of question in the
Question section.

2 Click Change Type.
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To edit any question or answer that you entered:

1 Select the question or answer by clicking it, and then click the Edit icon.

= > | r ¢

2 Make your changes.

To delete a question or an answer:

Select the question or answer by clicking it, and then click the Delete icon.

| @Erﬁ}(| r § Windows

oM [] 5 R Mac

To rearrange questions or answers:

Select the question or answer by clicking it, and then click the Move Up or Move
Down icon, as appropriate.

BEHBXI||r €

To delete an entire questionnaire:
Click Clear All.

If you have not saved the questionnaire, a message box appears, asking whether you
want to save it or not.

Displaying a timer during polling

208

You can specify that a timer displays for attendees and yourself when a poll is in
progress.

To display a timer:
1 Open the Polling Options dialog box.

= If you use Windows, click Options at the bottom of your Polling panel.
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= If you use the Mac, click this button on the lower-right portion of the Polling
panel.

¢ ( Ciear All ) { Open Foll )

o]

In the dialog box that appears, select Display, and then type the length of time in
the Alarm: box.

Click OK.

Opening a poll

After you finish preparing a poll questionnaire, you can open the poll.

If you prepared your questionnaire in advance and saved it, you must first display it
on the Polling panel.

To open a poll:

1

2

Display your poll questionnaire on the Polling panel, if you have not done so.
Click Open Poll.

The questionnaire appears on attendees' Polling panels. Attendees can now answer
the poll.

As attendees answer the questions, you can watch the polling status on your
Polling panel.

Polling ztatuz Windows:

=
Mot started J 2/3(67%) To view each attendee’s
I progress .| |043(0%) polling status, click one of
S J 1/333%) these three buttons.

R emaining time: 454 Time limit; 10:00

209



Chapter 16: Polling Attendees
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Hot staned 1/1 (100.0%

Mac:
In progress LT ]
Finished 01 (0.0 To view each attendee’s
[ Click to see detailed status | polling status, select the text
Remaining time 0415 Time limit: 0500 '/_C|I.'.|5E Pall ) "Click to see detailed status."

3 Click Close Poll when the time is up.
If you specify a timer and the poll times out, the poll automatically closes.

Attendees can no longer answer questions.

Once you close a poll, you can view the poll results and optionally share them with
attendees.

Viewing and sharing poll results

After closing a poll, you can:
= View the complete results of the poll.
= Share group results with attendees.

= The poll results you can share during a meeting are anonymous. However,
Meeting Center records responses from each attendee, in addition to group results,
and allows you to save those individual and group results.

Viewing poll results

Meeting Center bases the percentage for each answer on the total number of attendees
in the meeting, not the total number of attendees who submitted answers in the poll.
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=

Poll Questions:

Questions |Resuttz | Bar Graph
1.\ hat s wour favvarnite colar?
a. blue 2AB0%) I
b. red 1A4028%) 1l
C. green 0/4[0%)
d. black 0/4[0%)
Mo Angwer 1/4(25%] 1l
2%hat do you enjoy doing at lei...
a. reading 3M75E)
b. watching movies 7%
c. traveling 2AB0%) I The Results column
d. zpartz 1A4028%) 1l indicates the
Mo Answer 1/4(28%) Il
3.FPleaze give uz feedback abou... percentage of
attendees who chose
each answer. The Bar
Graph column
provides a graphic
representation of each
percentage in the

Results column.
Polling ztatuz
3 of 4 attendeez have rezponded
R emaining time: 204 Time limit; 10:00

Share with attendees
[vw Poll results
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Sharing poll results with attendees

After you close a poll, you can share the poll results with attendees.

The poll results you can share during a meeting are anonymous. However, Meeting
Center records responses from each attendee, in addition to group results, and allows
you to save those individual and group results.

To share the results of a poll:

In the Share with attendees section on your Polling panel, select Poll results, and
then click Apply.
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The results of the poll appear in the attendees' Polling panels, just as they do on your
Polling panel.

Saving and opening poll questionnaires and
results

Task description

If you have prepared a poll questionnaire, you can:

=  Save the questionnaire

= Open the saved questionnaire for use in any meeting

After you close a poll, you can:

= Save group results to a .txt file

Save »

=  Save responses from individual attendees to a .txt file

Save As

Transfer... (Chrl+T

Prink
RN a !.

Saving a poll questionnaire in a meeting

After you create a poll questionnaire in a meeting, you can save it as a .atp file. You
can open the file for use in any meeting.

To save a poll questionnaire:

1 On the File menu, choose Save > Poll Questions.
The Save Poll Questions As dialog box appears.

2 Choose a location at which to save the file.

3 Type a name for the file.

4 Click Save.

Meeting Manager saves the poll questionnaire to a file at the location you
specified. Poll questionnaire file names have an .atp extension.
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Saving results of a poll

After closing a poll, you can save the responses in one of these ways:

= Text File group result—Saves the percentage of attendees who chose each
answer in a .txt file.

= Text File individual attendees result—Saves the responses from each attendee,
in addition to the group results, in a .txt file.

File riarme: Poldfl ezl Save I

Save b vpe | Tesd File nchacual sflendees resuli"bd] - | Caneal

T et i crcip neal]” b
Tt File raceichanl sltendess sesl]” ba)

When you are saving poll results,
you can select a format in which you
J want to save the results.
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To save results of a poll:
1 Close the poll if you have not done so.
2 On the File menu, choose Save > Poll Results.
The Save Poll Results As dialog box appears.
3 Select a location at which to save the file.
4 In the "File name" drop-down list, enter a name for the file.

5 Inthe "Save as type" drop-down list, select the format in which you want to save
the results.

6 Click Save.

You can now view poll results by opening the file.

Opening a poll questionnaire file

If you saved a poll questionnaire to a file, you can display the questionnaire on your
Polling panel by opening the file.

Note: You can open a poll questionnaire file only during a meeting.

To open a poll questionnaire file:

1 Use one of these methods to browse to the file:
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= On the File menu, choose Open > Poll Questions.

= Click the Open icon on your Polling panel.

EE [y ™ | 1+ ¥ Windows
= - Ve

The Open Poll Questions dialog box appears.

Select the poll questionnaire file that you want to open.
A poll questionnaire file has a .atp extension.

Click Open.

The poll questionnaire appears on your Polling panel. You can now open the poll
to the attendees.
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Transferring and
Downloading Files During a
Meeting

During a meeting, you can publish files that reside on your computer. Meeting
attendees can then download the published files to their computers or local servers.
Publishing files is useful if you want to provide attendees with a document, a copy of
your presentation, an application, and so on.

Files that you publish reside only on your computer - not on a server. Thus, your
published files are always protected from unauthorized access during a meeting.

Hosts can publish files.

& 4 Share Fie.., ]
Fée name ILocation Sie | Status |
= g _acoess_recquast,., U Admin shuffitemp_sccess, 36564 B Sharad
s MC_DocShans, doc L bt bt Export b Kend, . NFERE Shrad
[Ta dowrdoad a Be, ather selact it and then cick Downlaad, or nght-.., | 2 8

Attendees can download

ublished files.
| P
F narme ! |Lopcation I S | Statie |
+ Retnp_hooess_request.., M B ot Saved
+ M _DoxShare.doc e Mot Sarved
To dorrioeds i, wihe et e Swn S owred, Tt | | 2[@
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Publishing files during a Meeting

During a meeting, you can publish files that reside on your computer, and meeting
attendees can download the files to their computers or local servers.

To publish files during a meeting:

1 In the Meeting window, on the File menu, choose Transfer.

The File Transfer window appears.

T File Tramsler

Filg name |Location Sme Status |
= bermp_sccess_request... U Admin shuffitemp_scosss.., 36564 B Shared
= MC_DotrShare.doc L bt hor- | Enpert b0 Kered, NERE Shred

ITo dowrioad a Be, ether selact it and then cick Download, or night-..., | 2

2 Click Share File.
The Open dialog box appears.
3 Select the file that you want to publish.
4 Click Open.
The file appears in the File Transfer window.
The file is also now available in each attendee’s File Transfer window.

5 Optional. Publish additional files that you want attendees to download.

Note: The number of attendees that have the File Transfer window open, including you,
appears in the lower-right corner of the File Transfer window.

To stop publishing files during a meeting:
In the title bar of the File Transfer window, click the Close button.

Meeting Manager closes the File Transfer window in each attendee's Meeting
window.
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Downloading Files During a Meeting

If a presenter publishes files during a meeting, the File Transfer dialog box
automatically appears in your Meeting window. You can then download the published
files to your computer or a local server.

To download files during a meeting:

1 Inthe File Transfer window, select the file that you want to download.

¥ File Transfer

Al rarre ¢ | Location Sive | ELELL
+ Remnp_bCoess_request.. IEEEA B Mot Saved
+* I"“I:_Dﬂ-csl'ﬂe.d\:bc Jmne Mot Seved
To dowrioad a file, ether sekect it and then cick Download, or Tight-.. 2@

2 Click Download.
The Save As dialog box appears.
3 Choose a location at which to save the file.
4 Click Save.
The file downloads to your selected location.
5 If applicable, download additional files.

6 Once you finish downloading files, in the title bar of the File Transfer window,
click the Close button.

Note: To reopen the File Transfer window at any time, from the File menu, choose
Transfer. This option is available only if the presenter is currently publishing files.
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Managing and Taking Notes

When scheduling a meeting, the host can specify the default note-taking options that
take effect once the meeting starts. During a meeting, the presenter can change the
default note-taking options at any time.

You can choose how to handle meeting notes:
= All participants with access can take private notes.
= Only one participant takes notes or meeting minutes.

= Only one participant takes notes for closed captions.

Note: The notes feature is not available on the Mac.

Role Task description:
Host If the Notes panel is closed, click
e e e s g s ezt Manage Panels and then select
e et gzl Notes from the list and click
Poling Jants Ad d
. .
e *  Setup options f_or taking
notes in a meeting
Mo lp |
e =  Choose one person to take
notes
*These panels are available to participants with appropriate privileges,
Note: On the Floating icon tray, only the first four panels will be displayed. L] Select a part|C|pant as
The remaining panels will be available from the menu,

closed captionist
Reset Ok Cancel

219



Chapter 18: Managing and Taking Notes

Role Task description:

Note taker The host can select one person
to take notes or allow all

participants to take notes
Motes From Team Meeting

=  Get an overview of taking
notes

Agenda:

Welcome
Introduction to team members

= Take personal notes during
Review of open tasks

a meeting

Attendees: Bob, Simon, Michael, Gabriel, . .
Saving notes to a file

Provide closed captions for
a meeting

BN "A'\-“‘ M ‘M-*Sal‘"

Specifying note-taking options for a meeting
During a meeting, you can turn the notes option on or off and specify one of these
options:
= All participants with access to notes can take private notes.

= Only one participant can take notes.

= Only one participant takes notes for closed captions.

To specify note-taking options for Windows:
1 In the Meeting window, on the Meeting menu, choose Options.

The Meeting Options dialog box appears, with the General tab selected by
default.

2 Select the note-taking option you want and click OK.
= To turn the notes option on or off, check or uncheck the Notes check box.

= To turn the closed captions option on or off, select or clear the Enable Closed
Captioning check box.

To specify note-taking options for the Mac:

1 On the Meeting Center menu, select Preferences.

2 Select Tools.

3 Select the note-taking option you want and click OK.

= To turn the notes option on or off, check or uncheck the Notes check box.
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= To turn the closed captions option on or off, check or uncheck the Enable
Closed Captioning check box.

Note:

= Once you change the notes option, any published notes or closed captions are removed from
each participant's Notes or Closed Caption panel. Be sure to ask participants to save notes or
closed captions before you change the notes option.

= When scheduling a meeting, the meeting host can specify the default note-taking options,
which take effect once the meeting starts.

Choosing a note taker

If the single note taker or closed captions option is set for a meeting, you can
designate any participant or closed captionist to be the note taker. When scheduling a
meeting, you can set the notes option, or a presenter can set the notes option during a
meeting.

To designate a note taker for Windows:

1 On the Participants panel, select the participant you want to designate as note
taker.

2 Right-click and then select Change Role To > Note Taker.
A pencil indicator appears to the right of the participant's name in the participant
list.

To designate a note taker for the Mac:

1 On the Participants panel, select the participant you want to designate as note
taker.

2 Select ctrl and then click; then select Change Role To > Note Taker.

A pencil indicator appears to the right of the participant's name in the participant
list.

Note:

= If you select another note taker or closed captionist, any notes or closed captions that the
previous note taker or closed captionist published remain on each participant's Notes or
Closed Caption panel. However, the new note taker or closed captionist cannot edit the
existing notes or closed captions.
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To designate a closed captionist:

1 In the meeting window, in the participant list, select the participant you want to
designate as a closed captionist.

2 On the Participants panel, do one of the following:
= Windows: Right-click and select Change Role To > Closed Captionist.

= Mac: Select ctrl and then click. Then select Change Role To > Closed
Captionist.

E E E |Z| |E_| = A closed captio_n_indicator appears
. next to the participant's name in the
participant list.

-

2% Participants
& Mame L 1 of 2 ready Toals
® webEx admin (Host)
Mariah

Enabling closed captions
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You can easily select the option for closed captions and appoint a participant to
transcribe the closed captions.

To specify the closed caption option:
1 Depending on the operating system you are using, do one of the following:
= Windows: In the Meeting window, on the Meeting menu, choose Options.

The Meeting Options dialog box appears, with the General tab selected by
default.

= Mac: On the Meeting Center menu, select Preferences. Select Tools.

2 To turn the closed captioning option on or off, check or uncheck the Enable
Closed Captioning check box.

To select another participant to transcribe, select the participant's name on the
Participants panel; then right-click (Windows) or select ctrl and then click (Mac) and
then select Change Role To >Closed Captionist.



Chapter 18: Managing and Taking Notes

About taking notes

Taking

Taking

During a meeting, one or more meeting participants with access to the notes feature
can take notes on the Notes or Closed Caption panel in the Meeting window. Only
one participant performs closed captioning.

If all participants are allowed to take notes, they cannot publish their notes to others
during the meeting. However, participants can save their notes at any time during the
meeting.

The meeting host can select the single note taker during the meeting. A single note
taker can publish notes at any time during the meeting or send a meeting transcript
containing the notes to all participants.

If needed, the host can also select a closed captionist. A closed captionist can publish
captions in real-time during the meeting and can also send a transcript containing the
captions to all participants.

personal notes

If the meeting host or presenter has selected the option to allow participants to take
personal notes, you can type your notes on the Notes panel in the Meeting window.

To take personal notes:
1 In the Meeting window, open the Notes panel.

2 Type your notes in the box.

Note: You can save your notes to a text file on your computer.

public notes (meeting minutes)

If the meeting host has designated you as the single note taker for a meeting, you can
type notes on the Notes panel in your Meeting window. Your notes are not visible to
other meeting participants until you publish them. You can publish your notes at any
time during the meeting, or you can send your notes in a meeting transcript to all
participants.
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To take public notes:
1 Inthe Meeting window,open the Notes panel.
2 Type your notes in the box.

3 Optional. To publish your notes, so they appear in each participant's Notes panel,
click Publish.

Note: If the Notes panel is not selected on a participant's Meeting window once you publish
notes, the participant is sees an alert.

Providing closed captions
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If the meeting host has designated you as the closed captionist for a meeting, you can
type captions on the Closed Captions panel in your Meeting window. To type
captions, you can use either a standard keyboard, or a steno keyboard and machine
translation software.

Your captions are visible to other meeting participants in real-time, one line at a time.
You can also send your captions in a meeting transcript to all participants.

To transcribe closed captions:
1 Open the Closed Caption panel.
2 Type your captions in the box.

3 Once you type a line of captions, do either to publish your captions on each
participant's Closed Caption panel:

= Press the Enter key on your computer's keyboard.

= Click Publish on the Closed Caption panel.

Note:

= If the Closed Captions panel is not selected on a participant's Meeting window once you
publish a line of captions, the participant is alerted that captions are available.
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Saving notes to afile

If you are taking personal or public notes (meeting minutes) or closed captions during
a meeting you can save your notes or closed captions to a text file on your computer.
You can also save any notes or closed captions that another note taker or closed
captionist publishes on your Notes or Closed Caption panel.

Once you save new notes to a file, you can save changes to the notes or save a copy of
the notes to another file.

To save new notes:

1 In the Meeting window, do either:
= On the Notes or Closed Caption panel, click Save.
= On the File menu, point to Save, and then choose Notes.
The Save Notes As dialog box appears.

2 Choose a location at which to save the file.

3 Type a name for the file.

4 Click Save.

Meeting Manager saves the file at the location you chose. Its file name has a .txt
extension.

To save changes to notes:

In the Meeting window, do either:

= On the Notes or Closed Caption panel, click Save.

= On the File menu, point to Save, and then choose Notes.

Meeting Manager saves the file at the location you chose. Its file name has a .txt
extension.

To save a copy of notes to another file:

1 In the Meeting window, on the File menu, point to Save As, and then choose
Notes.

The Save Notes As dialog box appears.
2 Do either or both:
= Type a new name for the file.

=  Choose a new location at which to save the file.
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3 Click Save.

Meeting Manager saves the file at the location you chose. The file name is saved with
a .txt extension.

Tip:

Alternatively, you can save all of the following <sassion_Type> information to files at once:

=  Shared presentations or documents

= Chat messages

= Notes

= Poll questionnaire

= Poll results

To save all information at once, on the File menu, choose Save All. In this case, Meeting Manager

uses the default file names for the files. Thus, if you have already saved a file using another name,
Meeting Manager does not overwrite that file.

Sending a meeting transcript to participants
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You can send a transcript of a meeting to all participants at any time during the
meeting. The transcript is an email message that contains general information, such
as:

= Meeting topic
= Meeting number
= Meeting starting and ending times

= URL for the Meeting Information page for the meeting on your meeting service
Web site

= List of participants who joined the meeting (audio-only participants are not listed)
= Meeting agenda
= Any public notes that you took during the meeting

Optionally, you can attach any of these files to the transcript, if you saved them
during the meeting:

= Shared documents

= Chat

= Public notes that you took or that the note taker published during the meeting
= Poll questionnaire

= Poll results
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To send a meeting transcript to participants:

1 Inthe Meeting window, on the File menu, choose Send Transcript.
If you have saved any files during the meeting, the Send Transcript dialog box
appears, allowing you to attach the files to the transcript email message.
If you have not saved any files during the meeting, a transcript email message
opens.

2 If the Send Transcript dialog box appears, select the check box for each file that
you want to attach to the transcript, and then click OK.
The transcript email message opens.

3 Review the email message and make any changes that you want.

4 Send the email message.

Note:

The transcript is sent to all participants who provided their email addresses when joining the
meeting, whether or not they are still attending the meeting when you send the transcript.
Audio-only participants will not be listed in the transcript.

For security purposes, a participant who receives a transcript email message cannot see the
email addresses for the other participants.

The transcript contains notes only if you are the meeting host, the public note taker, or the
closed captionist, and you have saved the notes to a file. If all participants can take private
notes, the transcript email message does not include your private notes, and the option to
attach your notes in a file is not available.

If you saved notes or closed captions to a file, the transcript email message and the attached
notes file contain the latest version of notes that you saved.

If you are the meeting host and end the meeting-and you have not sent a transcript-a message
appears, asking you if you want to send a transcript.
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Sending and Recelving
Video

When you send video, your video is seen by all participants.

If a video camera is attached to your computer, you can broadcast live video to
participants. Live video lets other participants see you, or whatever you focus your
webcam on. To see video, participants do not need to have a webcam installed on
their computers.

To start or stop sending video, simply select the video icon beside your name.

= After you select the icon, it changes
v € 3 day (Host, me) ] to green to indicate that you are
nding vi .
— - sending video

After you start sending video, you can perform the following tasks depending on your
role.
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Role
Host

Windows

Participant

Mac

aritin ipants Thast

e Maoa Presents dedi

Lol 3 MMariab jmel

[1 il fay (Hoad)

Setting the main display

If you are the host, you can decide which participant video to show in the main

display.

To set the video for the main display:

d

Hecordsr b

1 Select the name tag on the main display.
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Tasks
What you can do:

=  Stop or start sending video at
will.

=  Set the main display.
= View video in full-screen mode

= List participants or show
thumbnails.

=  Set webcam options

What you can do:
= Start or stop sending video at will
=  View video in theatre mode

= List participants or show
thumbnails

= Setwebcam options
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Particigpant s Chal E2 Recorder w

b=tk ) Ame Loos - &

e Mike Fraperne  Audo E-|| L

2 Inthe dialog box that appears you can select one of the following:

- Spatlight and Lock a Participant Yideo i = The active speaker. This is the
default. The display focuses on the
current speaker and changes as
the speaker changes.

‘Who do you want participants bo see?

(7} The active sossher |
(%) & spedific participant:
T = A specific participant. The display
| iriash focuses on only the specific
participant that you select.

Switching to and from full-screen mode

Full-screen mode displays your video across the entire desktop space and is great to
use when you want to see a larger view.
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The active speaker (or a specific participant) is shown in the main display with all
other participant videos arranged in a row beneath.

To switch to and from full-screen mode, do one of the following:

=  Double click the main display

= Select the full-screen mode icon in the upper
right corner of the display

- Maris

1 Mariak imel e

B9 fay (Hoat) L]
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Display a list or thumbnail view of participants

Select the participant icon to switch between the participant list or thumbnail
views.

Particgants Chat B Recowder v Participant list view

[ T3 , : ) W lay (st me - &

hefi [} Am= Loper _BE

s Maks Prasenter | Audo ,E g
- . i oo~ Participant thumbnail view
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Setting webcam options

If you have a working webcam, you can set options that are available for that webcam
directly from your meeting.

To set webcam options:

Windows:

At the top right of the main display select the
options icon.

Mac:
At the bottom right of window, select the options
icon.

o Mmriak v L JIE S

™ n Ch )6 fa skt -

A iif o |

Although you can set options for contrast, sharpness, brightness and other general
settings, options can vary depending on your web camera.
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Managing video during sharing

When you are sharing information or someone else is sharing information with you,
the main video display appears in the upper right corner of your desktop. You can
minimize or enlarge this display at will, or move it to any other part of the desktop.

To minimize or adjust the size and position of the main display:

=  Minimize: Select the arrow icon in the upper left corner.

= Resize: Select the bottom right corner and drag the
edge.

= Reposition: Select and drag the display to another
location on the desktop.
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Using My WebEx

About My WebEx

My WebEXx is an area on your WebEx service Web site in which you can access your
user account and personal productivity features. The following features are available,
depending on the configuration of your site and user account:

Personal list of meetings: Provides a list of all the online meetings that you are
hosting and attending. You can view the meetings by day, week, or month, or you
can view all meetings.

Productivity Tools Setup: Optional feature. Lets you set up options for instant or
scheduled meetings that you can start from applications on your desktop. If you
install WebEXx Productivity Tools, you can start or join meetings, sales meetings,
training sessions, and support sessions instantly from One-Click or from other
applications on your desktop, such as Microsoft Office, Web browsers, Microsoft
Outlook, IBM Lotus Notes, and instant messengers. You can also schedule
meetings, sales meetings, events, and training sessions using Microsoft Outlook or
IBM Lotus Notes without going to your WebEXx service site.

Personal Meeting Room: Optional feature. A page on your WebEXx service Web
site on which visitors can view a list of meetings that you are hosting and join a
meeting in progress. Visitors can also access and download files that you share.

File storage: Lets you store files in personal folders on your WebEXx service Web
site, where you can access them on any computer that has access to the Internet.
Also lets you make specific files available on your Personal Meeting Room page,
S0 visitors to your page can access them.
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MC_About My WebEx2

= Address book: Lets you keep information about your personal contacts on your
WebEXx service Web site. Using your address book, you can quickly access
contacts when inviting them to a meeting.

= User profile: Lets you maintain your account information, such as your
username, password, and contact information. Also lets you specify another user
who can schedule meetings on your behalf, set options for your Personal Meeting
Room page, and manage scheduling templates.

= Web site preferences: Lets you specify the home page for your WebEx service
Web site—that is, the page that appears first whenever you access your site. If
your site provides multiple languages, you can also choose a language and locale
in which to display text on your site.

= Usage reports: Optional feature. Lets you obtain information about meetings that
you hosted. If you use the Access Anywhere option, you can also obtain
information about computers that you access remotely.

Obtaining a user account
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Once you obtain a user account, you can use My WebEXx features and host s on the
Web.

You can obtain a user account in one of two ways:

= The site administrator for your WebEx service Web site can create a user account
for you. In this case, you need not sign up for an account on your site, and you can
begin hosting s immediately.

= [If your site administrator has made the self-registration feature available, you can
sign up for an account on your WebEx service Web site at any time.

To obtain a user account using the self-registration feature:
1 Go to your WebEXx service Web site.
2 On the navigation bar, click Set Up > New Account.
The Sign Up page appears.
3 Provide the required information.
4 Click Sign Up Now.

You receive an email message, confirming that you have signed up for a user
account.
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Once your site administrator approves your new user account, you receive another
email message containing your username and password.

Note: Once you obtain a user account, you can edit your user profile to change your password
and provide additional personal information.

Logging in to and out of the WebEXx service site

To manage your online s maintain your user account, you must log in to your WebEx
service Web site.

To log in to your WebEXx service site:

1 Go to your WebEXx service Web site.

2 In the upper-right corner of the page, click Log In.
The Log In page appears.

3 Enter your username and password.

Passwords are case-sensitive, so you must type your password exactly as you
specified it in your user profile.

4 Click Log In.

Tip: If you have forgotten your username or password, click Forgot your password. Provide
your email address, type verification characters, and then click Submit. You will receive an email
message containing your username and password.

To log out from your WebEX service site:

In the upper-right corner of the page, click Log Out.

Using your list of meetings

About your list of meetings
On your WebEXx service Web site, your My Meetings page in My WebEXx includes:
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= A list of all the online meetings that you have scheduled, including both listed and
unlisted meetings.

= A list of meetings on your site to which you are invited.

= An option to start a One-Click meeting (not available for Event Center).

Tip: You can specify that your My WebEx meetings page is the home page that appears once you
log in to your WebEX service Web site.

Opening your meetings list
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You can open your personal list of scheduled meetings on your WebEXx service Web
site to:

= Start a meeting

= Modify a meeting

= Cancel a meeting

You can open your personal list of meetings to which you are invited:
= Obtain information about a meeting

= Join a meeting in progress

To open your meetings list:
1 Log in to your WebEXx service Web site, and then click My WebEx.

The My Meetings page appears, showing your list of scheduled meetings.
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My WebEx Meetings Wealcome, Alice Helgado
o Go to My Personal Meeting Room 13 Start a One-Click Meeting @ m
Dail Weekly Monthly All Meetings English : Pacific DT
y ) ¥ 9

4March 21, 2007 » :]

The meetings you host | [ Show past meetings

O Time~  Topic Type 9 & o

O] 300pm  road map Meeting MAA L MAA NAA W Start
[] 330 pm status review meeting Meating MAA S MAA MNAA W Start
[] 4:00 pm design review heating MAA S MAA NAA W Start
[0 500 pm planning meeting Meeting MAR O MAA MAA L e Start

°Requests Pending ] Requests Approved o Requests Rejected

2 Click one of the tabs to navigate to different views of the My Meetings page:
You can choose Daily, Weekly, Monthly, or All Meetings.
3 Optional. Do either of the following:

= To view the list of meetings to which you are invited, select The meetings
you are invited to from the list.

= Toinclude s in the view that have already occurred, turn on Show past
meetings.

4 (Optional) Select options to control the view:

= To view the list of meetings to which you are invited, select The meetings
you are invited to from the list.

= To include meetings in the view that have already occurred, turn on Show
past meetings.

Tip: You can specify that your My WebEx Meetings page is the home page that appears once you
log in to your WebEX service Web site.

Maintaining your scheduled meetings list

Once you schedule a meeting, it appears in your meetings list on your My Meetings
page.
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An online meeting remains on your My Meetings page until you delete it. When
scheduling a meeting, you can choose to automatically delete the meeting from your
list of meetings once both of these conditions occur:

= You start and end the meeting.
= The scheduled time for the meeting has passed.

However, if you required registration for a scheduled meeting, the meeting remains in
your list until you remove it. That way, you can still view information about attendees
who registered for the meeting at any time after you host the meeting.

To remove a meeting from your list of meetings on your My Meetings page, you must
cancel the meeting by deleting it on this page.

About the My WebEx Meetings page
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How to access this tab
On your WebEXx service Web site, click the My WebEXx tab.

What you can do here
Access these features:
= Alink to your personal meeting room

= A list of meetings you are hosting or are invited to for the specified day, week, or
month

= A list of all meetings you are hosting or are invited to

= Alink to start a One-Click meeting

Options on this page

Use this option... To...

Go To My Personal Go to your Personal Meeting Room page.

Meeting Room Your Personal Meeting Room page lists any meetings that you

scheduled and any in-progress meetings that you are currently
hosting.

Users to whom you provide your personal URL can use this
page to join any meeting that you are hosting. They can also
download files in any folders that you share.
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Use this option... To...

Start a One-Click Start a One-Click Meeting based on settings you have specified
Meeting in One-Click Setup.

Daily View a list all of the meetings for the specified day.

Weekly View a list all of the meetings for the specified week.

Monthly View a list all of the meetings for the specified month.

All Meetings View a list all meetings, or search for meetings by date, host,

topic, or words in the agenda.

Refresh Refresh the information in the meeting list.

(]

About the My WebEx Meetings page - Daily tab

How to access this tab

On your WebEXx service Web site, click My WebEx > My Meetings > Daily tab.

Options on this tab

Option Description
@ Click the Refresh icon at any time to display the most current
list of meetings.

Click to open the Preferences page, where you can select the
Language link language setting for your WebEx service Web site.

Click to open the Preferences page, where you can select the

Time zone link time zone setting for your WebEXx service Web site.

The date for the daily list of meetings. The default is the

Date current date.
Click the Previous Day icon to display a list of meetings for
4 the previous day.
b‘ Click the Next Day icon to display a list of meetings for the
next day.
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Option

The meetings you host

The meetings you are
invited to

Show past meetings

Time

Topic

Type

Status

Delete

Description

Shows a list all of the online meetings or Personal Conference
meetings that you are hosting.

Shows a list all of the meetings or Personal Conference
meetings to which you have been invited.

Select to include concluded meetings in the list of meetings.

The Ascending Sort indicator appears next to a column
heading, and the meetings are sorted by the column, in
ascending order.

The Descending Sort indicator appears next to a column
heading, and the meetings are sorted by the column, in
descending order.

The starting time for each scheduled meeting. Click the box
next to a meeting start time to select that meeting. Click the
box next to the Time column heading to select or clear all
meetings in the list.

The topic for a meeting that you are hosting. Click the topic
name to get information about that meeting. If you are the
alternate host for a Meeting, the topic appears in italics.

Indicates the type of online meeting that you are hosting.
Available meeting types depend on the configuration of your
WebEXx service Web site.

Indicates that the live meeting is in process.

The status of the meeting.

=  Start: You can start this meeting that you are hosting at
any time by clicking the link.

= Join | End: (for hosts) For a meeting in progress that you
are hosting, you can join or end the meeting. Appears if
you left a meeting, or you allowed participants to join the
meeting before its starting time and participants have
already joined the meeting.

O Join: Lets you join the meeting in progress.
O End: Ends the meeting.

= Join: (for attendees) The meeting that you are invited to
has started, and you can now join the meeting.

= Registration: (for attendees) The meeting that you are
invited to requires registration. To display a page on which
you can register to attend the meeting, click the link.
(Does not apply to sales meetings or support sessions.)

Cancels any meetingsthat are currently selected in the list. If
you click this link, a message appears, allowing you to confirm



Option

Chapter 20: Using My WebEXx

Description

that you want to cancel the meeting. Another message
appears, allowing you to inform any invited attendees that you
canceled the meeting. (Does not apply to support sessions.)

About the My WebEx Meetings page - Weekly tab

How to access this tab

On your WebEXx service Web site, click My WebEx > My Meetings > Weekly tab.

Options on this tab

Option
(s

Language link

Time zone link

Week link

4

H

The meetings you host

The meetings you are
invited to

Show past meetings
Day link
Friday

Description

Click the Refresh icon at any time to display the most current
list of meetings.

Click to open the Preferences page, where you can select the
language setting for your WebEx service Web site.
Click to open the Preferences page, where you can select the
time zone setting for your WebEXx service Web site.

The beginning and ending date for the weekly list of meetings.

Click the Previous Week icon to display a list of meetings for
the previous week.

Click the Next Week icon to display a list of meetings for the
next week.

Click the Calendar icon to open the Calendar window for the
current month. Click on any date to open its schedule in the
Daily view.

Shows a list all of the online meetings or Personal Conference
meetings that you are hosting.

Shows a list all of the meetings or Personal Conference
meetings to which you have been invited.

Select to include concluded meetings in the list of meetings.

Opens the Daily view, which shows the scheduled meetings for
the selected day.
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Option Description

The Ascending Sort indicator appears next to a column
- heading, and the meetings are sorted by the column, in
ascending order.

The Descending Sort indicator appears next to a column
= heading, and the meetings are sorted by the column, in
descending order.

b The Expand button appears next to a Day link. Click this
button to expand and display the list of meetings for that day.

- The Collapse button appears next to a Day link. Click this
button to collapse and hide the list of meetings for that day.

The starting time for each scheduled meeting. Click the box
next to a meeting start time to select that meeting. Click the
box next to the Time column heading to select or clear all
meetings in the list.

Time

The topic for a meeting that you are hosting. Click the topic
Topic name to get information about that meeting. If you are the
alternate host for a Meeting, the topic appears in italics.

Indicates the type of online meeting that you are hosting.
Type Available meeting types depend on the configuration of your
WebEX service Web site.

Indicates that the live meeting is in process.

Status The status of the meeting.

=  Start: You can start this meeting that you are hosting at
any time by clicking the link.

= Join | End: (for hosts) For a meeting in progress that you
are hosting, you can join or end the meeting. Appears if
you left a meeting, or you allowed participants to join the
meeting before its starting time and participants have
already joined the meeting.

O Join: Lets you join the meeting in progress.
O End: Ends the meeting.

= Join: (for attendees) The meeting that you are invited to
has started, and you can now join the meeting.

= Registration: (for attendees) The meeting that you are
invited to requires registration. To display a page on which
you can register to attend the meeting, click the link.
(Does not apply to sales meetings or support sessions.)

Delete Cancels any meetingsthat are currently selected in the list. If
you click this link, a message appears, allowing you to confirm
that you want to cancel the meeting. Another message
appears, allowing you to inform any invited attendees that you
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Option Description

canceled the meeting. (Does not apply to support sessions.)

About the My WebEx Meetings page - Monthly tab

How to access this tab

On your WebEXx service Web site, click My WebEx > My Meetings > Monthly tab.

Options on this tab

Option Description
@ Click the Refresh icon at any time to display the most current
list of meetings.

Click to open the Preferences page, where you can select the
Language link language setting for your WebEx service Web site.

Time zone link Click to open the Preferences page, where you can select the
time zone setting for your WebEXx service Web site.
The month for the monthly calendar of meetings. The default is
Month the current month.

Click the Previous Month icon to display a list of meetings for
4 the previous month.

Click the Next Month icon to display a list of meetings for the
' next month.

Click the Calendar icon to open the Calendar window for the
= current month. Click on any date to open its schedule in the
Daily view.

Week Number link Opens the Weekly view, which shows the scheduled meetings
for each day of the selected week.

LYY
io0
Day link Opens the Daily view, which shows the scheduled meetings
for the selected day.
g8
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Option Description

Shows a list all of the online meetings or Personal Conference

The meetings you host meetings that you are hosting.

The meetings you are Shows a list all of the meetings or Personal Conference
invited to meetings to which you have been invited.
Show past meetings Select to include concluded meetings in the list of meetings.

The topic for a meeting that you are hosting. Click the topic
Topic name to get information about that meeting. If you are the
alternate host for a Meeting, the topic appears in italics.

Indicates that the live meeting is in process.

About the My WebEx Meetings page - All Meetings tab

How to access this tab

On your WebEXx service Web site, click My WebEx > My Meetings > All Meetings
tab.

Options on this tab

Option Description
@ Click the Refresh icon at any time to display the most current
list of meetings.

Click to open the Preferences page, where you can select the
Language link language setting for your WebEx service Web site.

Click to open the Preferences page, where you can select the

Time zone link time zone setting for your WebEXx service Web site.

The date for the daily list of meetings. The default is the

Date current date.
Click the Previous Day icon to display a list of meetings for
4 the previous day.
b Click the Next Day icon to display a list of meetings for the
next day.
Search for meetings by Allows you type or select a date range to search for meetings,
date, host, topic, or words | or allows you to type text to search in host names, topics, or
in the agenda agendas. Click Search to start the search.
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Description

Click the Calendar icon to open the Calendar window. Click on
any date to select that date as part of your search criteria.

Shows a list all of the online meetings or Personal Conference
meetings that you are hosting.

Shows a list all of the meetings or Personal Conference
meetings to which you have been invited.

Select to include concluded meetings in the list of meetings.

The Ascending Sort indicator appears next to a column
heading, and the meetings are sorted by the column, in
ascending order.

The Descending Sort indicator appears next to a column
heading, and the meetings are sorted by the column, in
descending order.

The starting time for each scheduled meeting. Click the box
next to a meeting start time to select that meeting. Click the
box next to the Time column heading to select or clear all
meetings in the list.

The topic for a meeting that you are hosting. Click the topic
name to get information about that meeting. If you are the
alternate host for a Meeting, the topic appears in italics.

Indicates the type of online meeting that you are hosting.
Available meeting types depend on the configuration of your
WebEXx service Web site.

Indicates that the live meeting is in process.

The status of the meeting.

=  Start: You can start this meeting that you are hosting at
any time by clicking the link.

= Join | End: (for hosts) For a meeting in progress that you
are hosting, you can join or end the meeting. Appears if
you left a meeting, or you allowed participants to join the
meeting before its starting time and participants have
already joined the meeting.

[0 Join: Lets you join the meeting in progress.
[0 End: Ends the meeting.

= Join: (for attendees) The meeting that you are invited to
has started, and you can now join the meeting.

= Registration: (for attendees) The meeting that you are
invited to requires registration. To display a page on which
you can register to attend the meeting, click the link.
(Does not apply to sales meetings or support sessions.)
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Option Description

Delete Cancels any meetingsthat are currently selected in the list. If
you click this link, a message appears, allowing you to confirm
that you want to cancel the meeting. Another message
appears, allowing you to inform any invited attendees that you
canceled the meeting. (Does not apply to support sessions.)

Maintaining Your Personal Meeting Room Page

About your Personal Meeting Room page

Your user account includes a Personal Meeting Room page on your WebEX service
Web site. Users who visit your page can:

= View a list of online meetings that you are hosting, either scheduled or in
progress.

= Join a meeting in progress.

= View your personal folders and upload or download files to or from your folders,
depending on the settings you specify for your folders.

You can customize your Personal Meeting Room page by adding images and text to
it.

To provide users with access to your Personal Meeting Room page, you must provide
them with your Personal Meeting Room URL.

Tip: Add your Personal Meeting Room URL to your business cards, your email signature, and so
on.

Viewing your Personal Meeting Room page

You can view your Personal Meeting Room page at any time, by going to the link for
the page. The link for your Personal Meeting Room page is available on your:

= My WebEx Meetings page
= My WebEXx Profile page
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To view your Personal Meeting Room page:

1 Log in to your WebEXx service Web site, and then click My WebEx.
The My WebEx Meetings page appears.

2 Click the Go to My Personal Meeting Room link.

Alternatively, in My WebEXx, click My Profile, and then click the Personal
Meeting Room URL link in the Personal Meeting Room section.

Your Personal Meeting Room page appears. The following is an example of a
Personal Meeting Room page.

Cindy Rao"s Meeting Room

gr g Thvs page sharas 3 ey st mpemings. T Jn 4 maeting i progre

K-"’~'\. - "u.—\,l.

e g A e P s, g

Tip: Add your Personal Meeting Room URL to your business cards, your email signature, and so
on.

Setting options for your Personal Meeting Room page

You can add the following to your Personal Meeting Room page:

= Animage (for example, you can add a picture of yourself or your company's
product).

= A custom banner image to the header area of your Personal Meeting Room page,
if your user account has the “branding” option. For example, you can add your
company's logo.

= A welcome message. For example, you can provide a greeting; instructions on
joining an online session; information about yourself, your product, or your
company.

At any time, you can replace or delete images and text that you add.
To add an image to your Personal Meeting Room page:
1 If you have not already done so, log in to your WebEXx service Web site.

2 On the navigation bar at the top of the page, click My WebEXx.
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3 Click My Profile.

The My WebEXx Profile page appears.
4 Under Personal Meeting Room, specify options for your page.
5 At the bottom of the My WebEXx Profile page, click Update.

Sharing files on your Personal Meeting Room page

You can share folders on your My WebEXx Files: Folders page so that they appear on
the Files tab on your Personal Meeting Room page. For any folder that you share, you
can specify whether users can download files from or upload files to the folder.

To share files on your Personal Meeting Room page:

1 Open the My WebEXx Files page.

2 Under Name, locate the folder in which you want to share files.

3 If the file or folder is in a closed folder, click the folder to open it.

4 Click the Properties icon for the folder in which you want to share files.

The Edit Folder Properties window appears.

= Edit Folder Properties - Windows Internet Explorer

Edit Folder Properties

Name: pictures

Description:

Size: 401 KB
Share: Hote the changes apply to all the files in this folda,
@ Do not share this folder

O share this folder

Read

(download only. file names are wisible)

Wite

{upload only: filz names are nat wsibla)
Read & Wiite

{downlead and upload, fle names are wsible)
Allow files to be cvenaritien

B Password pratected

Passwond

Canfirm

§ & Internat £ 100% -

5  Specify sharing options for the folder.

252



6

Chapter 20: Using My WebEXx

Click Update.

Maintaining files in your personal folders

About maintaining files in your folders

Your user account includes personal storage space for files on your WebEX service
Web site.

In your personal storage space, you can:

Create folders to organize your files.
Edit information about any file or folder in your personal folders.
Move or copy a file or folder to a different folder.

Share a folder so it appears on your Personal Meeting Room page.

You can use this storage space to access important information when you are away from the
office. For example, if you are on a business trip and want to share a file during an online
session, you can download the file in your personal folders to a computer, and then share the
file with attendees.

If you share a folder, visitors to your Personal Meeting Room page can upload files to or
download them from the folder. For example, you can use your personal folders to exchange
documents that you share in your sessions, archive recorded meetings, and so on.

Opening your personal folders, documents, and files

To store files on your WebEXx service Web site, or to access files that you stored, you
must open your personal folders.

To open your personal folders:

1

2

Log in to your WebEXx service Web site, and then click My WebEXx.
Click My Files.
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The My WebEXx Files page appears, showing your personal folders and files.
Depending on the settings for your WebEXx Service Web site, you may see
different categories of folders and files, and you can click on the heading links to
see each category:

= My Documents
= My Recordings
= My Event Recordings (available only in Event Center)

= My Training Recordings (available only in Training Center)

My WebEXx Files Welceme, Marie Brooks
My Documents | My Recordings Ii ’.T_
[Search Capacity: 50000 MB  Used: 729 KB
Description Size Shared
720 KB R &
283 KB
ZKE
401 KB

29KEB
KB

Tl
.“r Reguires passmord  R: Read oaly W Write enly  R/W: Reaad B Writs

[Setectal | [ ClearAl | [ Delte | [ Copy . | [ Move

Adding new folders to your personal folders

To organize your files on your WebEXx service Web site, you can create folders in
your personal storage space for files.

To create new folders:

1 Open the My Documents page.

2 Under Action, click the Create Folder button for the folder in which you want a
new folder.

il
L

The Create Folder window appears.
3 Inthe Folder Name box, type a name for the folder.

4 Optional. In the Description box, type a description to help you to identify the
folder's contents.

5 Click OK.
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Uploading files to your personal folders

To store files in your personal folders on your WebEx service Web site, you must
upload them from your computer or a local server.

You can upload:
= Up to three files at once
= Any file that is less than 5076 K

The amount of space available for storing files is determined by your site
administrator. If you require more disk space, contact your site administrator.

To upload files to your personal folders:
1 Open the My Documents page.
2 Locate the folder in which you want to store the file.

3 Under Action for the folder, click the Upload button for the folder in which you
want to store the file.

i

The Upload File window appears.
4 Click Browse.

The Choose File dialog box appears.
5 Select the file that you want to upload to your folder.
6 Click Open.

The file appears in the File name box.

7 Optional. In the Description box, type a description to help you to identify the

file.
8 Optional. Select up to two additional files to upload.
9 Click Upload.

The files are uploaded to the folder that you selected.

10 Once you are finished uploading files, click Finish.
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Moving or copying files or folders in your personal folders

You can move one or more files or folders to another folder on your WebEXx service
Web site.

To move or copy a file or folder:
1 Open the My Documents page.
2 Locate the file or folder that you want to move.
3 Select the check box for the file or folder that you want move.
You can select multiple files or folders.
4 Click Move or Copy.
The Move/Copy File or Folder window appears, showing a list of your folders.

5 Select the option button for the folder in which you want to move or copy the file
or folder.

6 Click OK.

Editing information about files or folders in your personal
folders

You can edit the following information about a file or folder in your personal folders
on your WebEXx service Web site:

= Name

= Description

You can also specify sharing options for folders that appear on your Personal Meeting
Room page.

To edit information about a file or folder:
1 Open the My Documents page.
2 Locate the file or folder for which you want to edit information.

3 Click the Properties icon for the file or folder for which you want to edit
information.

The Edit File Properties or Edit Folder Properties window appears.
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= Edil Folder Properties - Windows Internet Explorer

Edit Folder Properties

Hame: pictures

Description:

Size: 401 KB
Share: lote the changas apply to all the files in this foldai
{® Do not share this folder

O share this folder

Read

(downlaad only, file names are wisible)

White

{upload only: file names are nat vsibla)
Read & Write

{downlead and upload; file names are wisibbe)
Allow files to be cvenaritten

B Password pratected

Password

Canfirrn

o & Internet 100% -

= In the Description box, type a new name for the file or folder.
= In the Name box, type a new name for the file or folder.

4 Click Update.

Searching for files or folders in your personal folders

In your personal folders on your WebEXx service Web site, you can quickly locate a
file or folder by searching for it. You can search for a file or folder by text that
appears in either its name or description.

To search for a file or folder:
1 Open the My Documents page.
2 Inthe Search For box type all or part of the file's name or description.
3 Click Search.
A list of any files or folders that contain the search text appears.

Downloading files in your personal folders

In your personal folders on your WebEXx service Web site, you can download any files
to your computer or a local server.
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1 Open the My Documents page.
2 Locate the file that you want to download.

3 Under Action, click the Download button for the file that you want to download.

&
The File Download dialog box appears.

4 Follow any instructions that your Web browser or operating system provides to
download the file.

Deleting files or folders in your personal folders

You can delete files or folders in your personal folders on your WebEx service Web
site.

To delete a file or folder:

1 Open the My Documents page.

2 Under Name, locate the file or folder that you want to delete.

3 Select the check box for the file or folder that you want delete.
You can select multiple files or folders.

4 Click Delete.

About the My WebEx Files > My Documents page

How to access this page

On your WebEXx service Web site, click My WebEXx Files > My Documents.

What you can do here

= Store files that you use in your online sessions or that you want to access when
away from your office.

= Specify in which folders that visitors to your Personal Meeting Room can
download or upload files.
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Options on this page

Link or option

Capacity

Used

Search for

3

Name

Path

Size

Actions

Shared

Description

The storage space available for your files, in megabytes (MB).

The amount of storage space that your files occupy, in megabytes
(MB). Once this value exceeds your capacity, you can no longer store
files until you remove existing files from your folders.

Lets you locate a file or folder by searching for it. You can search for a
file or folder by text that appears in either its name or description. To
search for a file or folder, type all or part of its name or description in
the box, and then click Search.

Click this button to refresh the information on the page.

The name of the folder or file. Click a folder or file name to open the
Folder Information page or File Information page. From the
Information page, you can access the properties of a folder or file.

|"_-| Indicates that the item is a folder. Click the image to display
the contents of the folder.

Indicates that the item is a file.

The folder hierarchy for the folder or file. The Root folder is the top-
most folder in which all other folders and files reside.

The size of the folder or file, in kilobytes (KB).

Click the icons to perform an action on the folder or file that is
associated with it.

ﬁ“ﬁ; Upload file: Available only for files. Click this icon to open
- the File Upload page, on which you can select up to three
files at a time to upload to a specified folder.

(N Download file: Available only for files. Click this icon to
- download the file associated with it.

Edit File Properties or Edit Folder Properties: Click this
icon to open the Edit File Properties page or Edit Folder
Properties page, on which you can edit information about
the file or folder, respectively.

th Create Folder: Available for folders only. Click this icon to
open the Create Folder page on which you can create a new
folder in your personal storage space.

Specifies the sharing settings for a folder; that is, how others who visit
your Personal Meetings Room can access your folder and its files.
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Link or option Description

R Read only: Visitors to your Personal Meeting Room can
view the list of files in the folder and download the files.

w Write only: Visitors to your Personal Meeting Room can
upload files to the folder, but they cannot view the files in it.

R/\W Read and write: Users can view files in the folder,
download files from the folder, and upload files to the folder.

1 Password Protected: Indicates that the folder is password
protected. Visitors to your Personal Meeting Room must
provide the password you specify to access the folder.

Selects the check boxes for all the folders and files that are visible in
Select All the list. You can then click the Copy or Move button or click the
Delete link to perform an action on the selected folders or files.

Clears the check boxes for all the folders and files that are selected in
Clear All

the list.

Delete Deletes the selected folders and files from the list.

Copy Opens a page on which you can copy the selected folder or file to
another folder.

Move Opens a page on which you can move the selected folder or file to

another folder.

About the Edit Folder Properties page
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How to access this page

On your WebEXx service Web site, click My WebEx > My Files > Properties icon
for folder.

What you can do here

Specify a name, a description, and sharing options for a folder that you created in
your personal folders.



Chapter 20: Using My WebEXx

Options on this page

Use this option...

Name
Description

Share

Share as

Read

Write

Read & write

Allow files to be
overwritten

To...

Enter the name of the folder.
Enter the description of the folder.

Specify who can access this folder.

= Do not share this folder: This folder does not appear on your
Personal Meeting Room page. Thus, visitors to your page
cannot view the folder or access any files in it.

=  Share this folder: This folder appears on your Personal
Meeting Room.

The drop-down list specifies which users can access the folder,
as follows:

O With all: All visitors to your Personal Meeting Room can
access this folder.

O With users with host or attendee accounts: Only visitors
to your Personal Meeting Room who have either a host
account or an attendee account on your WebEXx service
Web site can access this folder.

0  With users with host accounts only: Only visitors to your
Personal Meeting Room who have a host account on your
WebEXx service Web site can access this folder.

Enter the name for the folder that will appear on your Personal
Meeting Room page.

Let visitors to your Personal Meeting Room view the list of files in the
folder and download the files.

Let visitors to your Personal Meeting Room upload files to the folder
but does not allow them to view the files in it.

Let users view files in the folder, download files from the folder, and
upload files to the folder.

Let users upload a file with the same name as an existing file in the

folder and replace the existing file. If this option is not selected, users
cannot overwrite any files in the folder.
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Use this option...
Password protected

Update

Cancel

To...

Let only visitors to your Personal Meeting Room who know the
password view the list of files in the folder, download files from the
folder, or upload files to the folder, depending on the read/write
settings for the folder.

Password: The password that visitors to your Personal Meeting
Room must provide to access the folder.

Confirm: If you specified a password, type it again to verify that you
typed it correctly.

Save any changes that you made to folder's properties, and then
closes the Edit Folder Properties window.

Close the Edit Folder Properties window, without saving any of the
changes that you made.

Opening the My Recordings Page

To upload or maintain recordings, you must do so from the My Recordings page on

your WebEXx service Web site.

To open the My Recordings page:

1 Log in to your WebEX service Web site, and then click My WebEXx.

2 Click My Files > My Recordings.

The My Recordings page appears, showing your recording files.

Uploading a recording file

262

If you recorded a meeting using the integrated or standalone WebEx Recorder, you
can upload the recording file, with a .wrf extension, from your local computer to the

My Recordings page.

Note: If you recorded a meeting using the WebEx Network-Based Recorder (NBR), the WebEx
server automatically uploads the recording file, with an .arf extension, to the appropriate tab on

the My Recordings page once you stop the Recorder. You do not need to upload it yourself.

To upload a recording file:

1 Go to the My Recordings page.
2 Click Add Recording.

3 On the Add Recording page, enter information and specify options.
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Click Save.

Editing information about a recording

You can edit information about a recording at any time.

To edit information about a recording:

1

2

3

4

Go to the My Recordings page.

Click the following icon for the recording that you want to edit.

]

The Edit Recording page appears.

Make your changes.
Click Save.

Sending an email to share a recording

You can send an email one or more people to share your recording with them.

To send an email to share a recording with others:

1

2

Go to the My Recordings page.

Click the appropriate link for your recording type:

Meetings

Events

Sales Meetings
Training Sessions

Miscellaneous

Open the Share My Recording window:

Click the following icon for the recording that you want to share with others.

=]

Click the linked name of the recording you want to share. On the Recording
Information page, click Send Email.
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Send Email

The Share My Recording window appears.

{7 Shsane by Bcording - Micresaft imornet [xplorer provided by... o

e v

Share My Recording

Send o

S—
] Send 5 copy of the emal 1o me
Wour message

[Oiptlomad):

The foliowing recondng will B gent 10 the redipsents
Status meeting JO0EREN F115

June 24, M08, ¥ 22 am San Frascmco Time
Daratson ¥ ming

e @ Interat o -

4 Select recipients for your email:
= Click Select Recipients to select contacts from your Contacts list.

= Type email addresses in the Send to list, separated by commas.
5 (Optional) Type a message in the Your message box.
6 Click Send.

Your email message will be sent to the selected recipients, and will include
information about the recording and a link to play it.

About the Add/Edit Recording page

How to access this page

If you are adding a recording...

1 Onyour WebEx service Web site, click My WebEx > My Files > My
Recordings.

2 Click Add Recording.

264



Chapter 20: Using My WebEXx

If you are editing information about a recording...

1 On your WebEx service Web site, click My WebEx > My Files > My
Recordings.

2 Click the More button in the row of the recording that you want to edit.

3 Click Modify.

L Download
L& Modify

L@ Disable

& Be-assign

[ Delete

What you can do here
= Edit general information about a recording, including the topic and description.

= Require a password to play or download the recording.

Options on this page

Use this option.... To....

Topic Specify the topic of the recording.

Description Provide a description of this recording.

Recording file Click Browse to select the recording file that resides on your

local computer.
Duration Specify the duration of the recording.

File size Displays the size of the recording file (available only when
editing recording information).

Set password Set an optional password that users must provide to view the
recording.

Confirm password Confirm the password that users must provide to view the
recording.
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Playback control options
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Use this option....

Panel Display Options

Recording Playback
Range

Include NBR player
controls

To....

Determines which panels are displayed in the recording when it
is played back. You can select any of the following panels to be
included the recording playback:

= Chat

= Q&A
= Video
= Polling
= Notes

=  File Transfer
=  Participants
= Table of Contents

Panel display options do not modify the panel display in the
actual recording that is stored on the WebEx network.

Determines how much of the recording is actually played back.
You can select either of the following:

= Full playback: Plays back the full length of the recording.
This option is selected by default.

= Partial playback: Plays back only part of the recording
based on your settings for the following options:

O Start: X min X sec of the recording: Specifies the
time to start playback; for example, you can use this
option if you would like to omit the "dead time" at the
beginning of the recording, or if you would like to show
only a portion of the recording.

O End: X min X sec of the recording: Specifies the
time to end playback; for example, you can use this
option if you would like to omit the "dead time" at the
end of the recording. You can not specify an end time
greater than the length of the actual recording.

The partial playback range you specify does not modify the
actual recording that is stored on the server.

Includes full Network Recording Player controls, such as stop,
pause, resume, fast forward, and rewind. This option is selected
by default. If you would like to prevent viewers from skipping
portions of the recording, you can turn off this option to omit
Network Recording Player controls from the playback.
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About the Recording Information page

How to access this page

On your WebEXx service Web site, click My WebEx > My Files > My Recordings >
[recording type] > [topic of a recording].

What you can do here

= View information about the recording.

= Play back the recording.

= Send an email to share the recording with others.

= Download the recording.

= Enable or disable the recording

= Open the Edit Recording page on which you can edit information about a

recording.

Options on this page

Option
Topic

Create time
Duration
Description
File size

Create time

Status

Password

Stream recording link

Download recording link

Description

The name of the recording. You can edit the topic at any time.
The time and date the recording was created.

The length of the recording.

A description of the recording.

The file size of the recording.

The date and time at which the recording was created.

The status of the recording. The possible options are Enable or
Disable.

Indicates whether a user must provide a password to view the
recording.

Clicking the link lets you play the recording (available only for
recording files with the .arf extension that were recorded by
NBR).

Clicking the link lets you download the recording.
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Option Description

Clicking the button lets you play the recording (available only for
recording files with the .arf extension that were recorded by

Play Mow NBR).

If you want to download the recording, you can also click the
link for downloading under Play Recorded a meeting Now.

Clicking the button opens the Share My Recording window,
which allows you to send an email message to selected

- recipients, inviting them to play your recording.
Send Email T o
If you want to send the email with your local email client

instead, click the link for using the email client under Share My
Recording.

Clicking the button opens the Edit Recording page.

Delete Clicking the button deletes the recording.

Clicking the button disables the recording everywhere it is
Disakle published on your WebEx Service Web site (available only for
enabled recordings).

Clicking the button enables the recording everywhere it is
Enahle published on your WebEx Service Web site (available only for
disabled recordings).

=

8—.

=
=)

Back to List ] Clicking the button returns you to the recording list.

About the My WebEx Files > My Recordings page

How to access this page

Log in to your WebEX service Web site, and then click My WebEXx. From the left
navigation bar, click My Files > My Recordings.

What you can do here

Manage, upload, and maintain your recording files.

Options on this page
View different categories of recordings:

= Meetings
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=  Events
= Sales Meetings
= Training Sessions

= Miscellaneous
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About the My WebEx Files > My Recordings > Meetings page

How to access this page

Log in to your WebEXx service Web site, and then click My WebEx. From the left
navigation bar, click My Files > My Recordings > Meetings.

What you can do here

Manage, upload, and maintain recording files of meetings you host.

Options on this page

Option
[S]

Search

You are currently using X
% of Y GB

Site storage X % of Y GB

Topic

Description

Refreshes the information on the page.

Allows you type text to search for within recording names. Click
Search to start the search.

The percentage of available personal storage space on your
WebEx Service Web site that is being used by your recordings.
This field appears only if your site administrator has turned on
the option to show personal recording storage allocation usage.
If this field does appear, and you exceed your personal storage
allocation, you will not be able to record meetings until some
recordings are deleted or the storage allocation is increased by
your system administrator.

The percentage of total available storage space on your WebEx
Service Web site that is being used by all recordings on your
site. If your site exceeds its storage allocation, users will not be
able to record meetings until recordings are deleted or the
storage allocation is increased by your system administrator.

Indicates a disabled recording.

The name of the recording. If you record a meeting on the
server, the WebEx server automatically uploads the recording to
this page. In this case, the topic of the recording is the topic of
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Option Description
the meeting. You can edit the topic at any time.

Size The size of the recording.
Create Time/Date The date and time the recording was created.
Duration The length of the recording.

The format of the recording file.

A recording file can be in WebEx Advanced Recording Format

Format (ARF) or WebEx Recording Format (WRF). You can also store
recording files that are in Windows Media Audio/Video (WMV)
or Shockwave Flash Object (SWF) format.

Lets you play the recording (available only for recording files
with an .arf extension that were recorded by the Network-Based

LJ Recorder).
If playback of the file requires a password, you must provide the
password.

‘lJ Lets you send an email to share this recording with others.

Displays a menu with more options for your recording:

= % Download: Lets you download the recording to your
local computer.

If downloading the file requires a password, you must
S e provide the password.

] g Modify: Lets you edit information of the recording..
= @ Disable: Lets you disable the recording in all locations.

= 4 Delete: Lets you delete the recording from this page.

Lets you upload a new recording.
Add Recording

& Indicates that a recording is password-protected.

About the My WebEx Files > My Recordings > Miscellaneous
page

How to access this page

Log in to your WebEX service Web site, and then click My WebEXx. From the left
navigation bar, click My Files > My Recordings > Miscellaneous.
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What you can do here

Manage, upload, and maintain recording files of meetings you host.

Options on this page

Option
[S]

Search

You are currently using X
% of Y GB

Site storage X % of Y GB

Topic

Size
Create Time/Date

Duration

Format

Description

Refreshes the information on the page.

Allows you type text to search for within recording names. Click
Search to start the search.

The percentage of available personal storage space on your
WebEx Service Web site that is being used by your recordings.
This field appears only if your site administrator has turned on
the option to show personal recording storage allocation usage.
If this field does appear, and you exceed your personal storage
allocation, you will not be able to record meetings until some
recordings are deleted or the storage allocation is increased by
your system administrator.

The percentage of total available storage space on your WebEx
Service Web site that is being used by all recordings on your
site. If your site exceeds its storage allocation, users will not be
able to record meetings until recordings are deleted or the
storage allocation is increased by your system administrator.

Indicates a disabled recording.

The name of the recording. If you record a meeting on the
server, the WebEx server automatically uploads the recording to
this page. In this case, the topic of the recording is the topic of
the meeting. You can edit the topic at any time.

The size of the recording.
The date and time the recording was created.
The length of the recording.

The format of the recording file.

A recording file can be in WebEx Advanced Recording Format
(ARF) or WebEx Recording Format (WRF). You can also store
recording files that are in Windows Media Audio/Video (WMV)
or Shockwave Flash Object (SWF) format.

Lets you play the recording (available only for recording files
with an .arf extension that were recorded by the Network-Based
Recorder).

If playback of the file requires a password, you must provide the
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Option Description
password.

| Lets you send an email to share this recording with others.

Displays a menu with more options for your recording:
] ﬂr Download: Lets you download the recording to your
local computer.
' If downloading the file requires a password, you must
_'] provide the password.
] g Modify: Lets you edit information of the recording.
= '@ Disable: Lets you disable the recording in all locations.
= 4 Delete: Lets you delete the recording from this page.
& Indicates that a recording is password-protected.

Maintaining contact information

About maintaining contact information

You can maintain a personal online address book, in which you can add information
about contacts and create distribution lists. When scheduling a meeting or starting an
instant meeting, you can quickly invite any contacts or distribution lists in your
personal address book. You can also invite contacts in the Company Address Book
for your WebEXx service Web site, if one is available.

You can add contacts to your personal address book in any of the following ways:
= Specify information about contacts one at a time.
= Import contact information from your Microsoft Outlook contacts.

= Import contact information from a comma-separated/comma-delimited values
(CSV) file.
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You can also edit or delete the information about any contact or distribution list in

your personal address book.

Opening your address book

You can open your personal address book on your WebEXx service Web site, to view

or maintain information about your contacts.

To open your address book:
1 Log in to your WebEXx service Web site.
2 On the navigation bar at the top of the page, click My WebEXx.
3 Click My Contacts.
The My WebEXx Contacts page appears.

My WebEx Contacts welcome, Alice Helgado

Viewn |Personal Contacts j Expont |
Import From: |Microsoﬂ Outlaak j Impart I
Search for: I Search |

Mater Search quenas contact name and emall addrass fields anly

Indexs: A B CDEF @ HIJELMHBPMDODERESTUWMWXYZ# A

Name Email Address Phone Number Language
™ &8 Planning Cornrnittes English
[ &8 Sales Departrment English
[T Christine Huliste christine@ asr. corn 1-543-654-04 31 English
I~ John Mullen imullen @ zyire. com 1-408-123-4 567 English
7 Lisa Grantham lisag@zilo. com 1-512-908-0001 English
7 LisaWai lisw @7 euss. com 1-515-898-0583 English
7 Marcel Tillman rmtillman @ pretech. com 1-415-288-5544 English
I~ Sallen Chen schen @ micolite. com 1-512-534-1222 English

selectAl | Clearal | Delste | Add Contact | Add Distribution List

4 Inthe View drop-down list, select one of the following contact lists:

= Personal Contacts: Includes any individual contacts or distribution lists that
you added to your personal address book. If you have a Microsoft Outlook
address book or contacts folder, you can import its contacts to this list of

contacts.

= Company Address Book: Your organization's address book, which includes
any contacts that your site administrator has added to it. If your organization
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uses a Microsoft Exchange Global Address List, your site administrator can
import its contacts to this address book.

Adding a contact to your address book

You can add contacts to your personal address book, one at a time.

To add a contact to your personal address book:
1 Open your personal address book.
2 Inthe View drop-down list, select Personal Contacts.
A list of contacts in your Personal Contacts list appears.
3 Click Add Contact.
The Add Contact page appears.

My WebEx Contacts

MNew Contact

Full name (required)

Email addrass (required)

Job title:

|
3
Gompany: |
|
3

LIRL: (if known)

Phone nurmber: CountnfRegion Amaorciy code: Mumber Extension:
I | | |

Phone nurmber for mobile device: SountnRegion Ama oreity sode: Number Estansion:
[ | | |

Fax numkber: Countrg/Region Amaorety code: Mumber Extension:

fi | | |

Address

Addressz

Gty

State/Provines

ZIF/Postal code: I

Country/Region: I

Lser name: | {if known)

Motes: |

-
=

Add | Cancel
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4 Provide information about the contact.

5 Click Add.

Note:

= You cannot add contacts to your Company Address Book.
= |f you want to add multiple contacts, you can them all at once, instead of adding one contact

at a time.

About the New/Edit Contact page

How to access this page

On your WebEXx service Web site, click My WebEx > My Contacts > Add Contact
or [check box for contact] > Edit.

What you can do here

Enter information about a new or existing contact for your personal address book.

Options on this page

Use this option...

Full name
Email address

Language

Company

Job title

URL

Phone number/Phone

number for mobile
device/Fax number

To...

Enter the contact's first and last name.
Enter the contact's email address.

Set the language in which any email messages that you send to
the contact using your WebEXx service site appear.

Available only if your WebEXx service Web site can be displayed in
two or more languages.

Enter the company or organization for which the contact works.
Enter the contact's position in a company or organization.

Enter the URL, or Web address, for the contact's company or
organization.

Enter the contact's phone numbers. For each number, you can
specify the following:
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Use this option...
Country Code

Area or city code
Number
Extension
Address 1
Address 2
State/Province
ZIP/Postal code
Country

Username

Notes

To...

Specify the number that you must dial if the contact resides in

another country. To select a different country code, click the link to

display the display the Country Code window. From the drop-
down list, select the country in which the contact resides.

Enter the area or city code for the contact's phone number.
Enter the phone number.

Enter the extension for the phone number, if any.

Enter the contact's street address.

Enter additional address information, if necessary.

Enter the contact's state or province.

Enter the contact's ZIP or postal code.

Enter the country in which the contact resides.

Enter the username with which the user logs in to your WebEx
service Web site, if the contact has a user account.

Enter any additional information about the contact.

Importing contact information in a file to your address book

You can add information about multiple contacts simultaneously to your personal
address book, by importing a comma-separated values (CSV) file. A CSV file has the
.csv file extension; you can export information from many spreadsheet and email
programs in CSV format.

To create a CSYV file:

1 Open your address book.

2 Inthe View drop-down list, ensure that Personal Address Book is selected.
3 Click Export.

4 Save the .csv file to your computer.

5 Open the .csv file that you saved in a spreadsheet program, such as Microsoft
Excel.

6 Optional. If contact information exists in the file, you can delete it.

7 Specify information about the new contacts in the .csv file.
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Important: If you add a new contact, ensure that the UID field is blank.

Save the .csv file. Ensure that you save it as a .csv file.

To import a CSV file containing new contact information:

1

2

3

Open your address book.

In the View drop-down list, ensure that Personal Contacts is selected.
In the Import From drop-down list, select Comma Delimited Files.
Click Import.

Select the .csv file in which you added new contact information.

Click Open.

Click Upload File.

The View Personal Contacts page appears, allowing you to review the contact
information you are importing.

Click Submit.
A confirmation message appears.
Click Yes.

Note: If an error exists in any new or updated contact information, a message appears, informing
you that no contact information was imported.

About the Contact Information CSV template

How to access this template

On your WebEXx service Web site, click My WebEx > My Contacts > View >
Personal Address Book > Export.

What you can do here

Specify information about multiple contacts, which you can then import to your
personal address book.
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Fields in this template

Option
UuID

Name

Email

Company
JobTitle
URL

OffCntry

OffArea
OffLoc
OffExt

CellCntry

CellArea
CellLoc

CellExt

FaxCntry

FaxArea
FaxLoc
FaxExt
Address 1
Address 2

State/Province

Description

A number that your WebEXx service site creates to identify the contact. If
you add a new contact to the CSV file, you must leave this field blank.

Required. The contact's first and last name.

Required. The contact's email address. The email address must be in
the following format:

name@company.com

The company or organization for which the contact works.

The contact's position in a company or organization.

The URL, or Web address, for the contact's company or organization.

The country code for the contact's office phone-that is, the number that
you must dial if the contact resides in another country.

The area or city code for the contact's office phone number.
The contact's office phone number.
The extension for the contact's office phone number, if any.

The country code for the contact's cellular or mobile phone-that is, the
number that you must dial if the contact resides in another country.

The area or city code for the contact's cellular or mobile phone number.
The contact's cellular or mobile phone number.

Thee extension for the contact's cellular or mobile phone number, if
any.

The country code for the contact's fax number-that is, the number that
you must dial if the contact resides in another country.

The area or city code for the contact's fax number.
The contact's fax number.

The extension for the contact's fax machine, if any.
The contact's street address.

The additional address information, if necessary.

The contact's state or province.
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Option Description

ZIP/Postal The contact's ZIP or postal code.

Country The country in which the contact resides.

Username The user name with which the user logs in to your WebEXx service Web

site, if the contact has a user account.

Notes Any additional information about the contact.

Importing contact information from Outlook to your address

book

If you use Microsoft Outlook, you can import the contacts that you maintain in your
Microsoft Outlook address book or folder to your personal address book on your
WebEXx service Web site.

To import contacts from Outlook to your personal address book:

1 Open your address book.

2 Inthe View drop-down list, select Personal Contacts.

3 Inthe Import from drop-down list, select Microsoft Outlook.

4 Click Import.
The Choose Profile dialog box appears.

5 Inthe Profile Name drop-down list, select the Outlook user profile that includes
the contact information that you want to import.

6 Click OK.

Note:

When you import contacts in Outlook, your WebEx service Web site retrieves contact
information from the Outlook address book or folder in which you have chosen to keep
personal addresses. For information about keeping personal addresses in Outlook, refer to
Microsoft Outlook Help.

If your personal address book already includes a contact who is also in your Outlook contacts
list, the contact is not imported. However, if you change the contact's email address in your
personal address book, importing the contact from Outlook creates a new contact in your
personal address book.
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Viewing and editing contact information in your address

book

In your personal address book, you can view and edit information about individual
contacts in your Personal Contacts list. You can view, but not edit, information about
contacts in your Company Address Book.

To view or edit contact information:

1

2

Open your address book.

In the View drop-down list, select one of the following:

= Personal Contacts

= Company Address Book

A list of contacts appears.

Locate the contact whose information you want to view or edit.
Under Name, select the contact whose information you want to view or edit.
Do one of the following:

= [f the contact is in your Personal Contacts list, click Edit.

= [f the contact is in your Company Address Book, click View Info.
Information about the contact appears.

Optional. If the contact is in your Personal Contacts list, edit the information that
you want to change on the Edit Contact's Information page.

Click OK.

Finding a contact in your personal address book
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You can quickly locate a contact in your personal address book, using one of several
methods.

To search for a contact in your address book:

1

2

3

Open your address book.
In the View drop-down list, select a contacts list.

Do any of the following:
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= Inthe Index, click a letter of the alphabet to display a list of contacts whose
names begin with that letter. For example, the name Susan Jones appears
under S.

= To search for a contact in the list you are currently viewing, type text that
appears in either the contact's name or email address in the Search for box,
and then click Search.

= If the entire list of contacts does not fit on a single page, view another page by
clicking the links for the page numbers.

= Sort your personal contacts or company address book by name, email address,
or phone number by clicking the column headings.

Creating a distribution list in your address book

You can create distribution lists for your personal address book. A distribution list
includes two or more contacts for which you provide a common name and appears in
your Personal Contacts list. For example, you can create a distribution list named
Sales Department, which includes contacts who are members of your Sales
Department. If you want to invite members of the department to a meeting, you can
select the group rather than each member individually.

To create a distribution list:

1 Open your address book.

2 Click Add Distribution List.

The Add Distribution List page appears.
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Add Distribution List

Dimtribasthon Lbst Inbormation:
Hama i

g | B

Ll |
Hembera

Poeimoril ooovimels Skt ConevimAs
Index: &
Asidy
iFamirag
Add Cosing

] Conca

3 In the Name box, type the name of the group.
4  Optional. In the Description box, type descriptive information about the group.

5 Under Members, locate the contacts that you want to add to the distribution list,
by doing any of the following:

= Search for a contact, by typing all or part of the contact's first or last name in
the Search box.

= Click the letter that corresponds to the first letter of the contact's first name.
= Click All to list all contacts in your Personal Contacts list.

6 Optional. To add a new contact to your Personal Contacts list, under Members,
click Add Contact.

7 In the box on the left, select the contacts that you want to add to the distribution
list.

8 Click Add to move contacts you selected to the box on the right.

9  After you finish adding contacts to the distribution list, click Add to create the
list.

In your Personal Contacts list, the Distribution List indicator appears to the left
of the new distribution list:
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I_ Planning Cornrmittes

Editing a distribution list in your address book

You can add or remove contacts from any distribution list that you have created for
your personal address book. You can also change a group's name or descriptive
information.

To edit a distribution list:
1 Open your address book.
2 Inthe View drop-down list, select Personal Contacts.

A list of the contacts in your Personal Contacts list appears, including any
distribution lists that you have created. The Distribution List indicator appears to
the left of a distribution list:

I- Flanning Cornrmittee

Under Name, select the name of the distribution list. The Edit Distribution List
page appears.
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Edit Distribution List

Distribution List Information:

Mame: |Distributors [Required)
.o |BuperGizmo distributors ﬂ
Description: for Western Region. LI
Members
Search: GDl
Personal contacts Selected contacts
Indesx: 2 B C D E E
GHIJELMHINES John ullen
P2 RSTUY W Lisa YWai
£ L o# Al

Use Ctrl to select multiple
users

Christine Huliste

Liza Grantham
hdarzel Tillman ﬂl
Sallen Chen

Remaowve |

Add Contact |
Cancell

3 Edit information about the distribution list.

4 Click Update.

About the Add/Edit Distribution List page

How to access this page

On your WebEXx service Web site, click My WebEx > My Contacts > Add
Distribution List. Or, select distribution list in Personal Contacts list.

What you can do here

Add contacts to your distribution list or remove contacts from your distribution list.
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Options on this page

Use this option...

Name

Description

Search

Index

Add>
<Remove

Add Contact

Add

Update

To...

Enter the name of the distribution list. For example, if you want to
add a distribution list that includes members of your company's
sales department, you might name the list Sales Department.

Optionally enter descriptive information about the distribution list,
to help you identify it later.

Find a contact, by typing all or part of the contact's first or last
name.

Find a contact, by clicking the letter that corresponds to the first
letter of the contact's first name. To list contacts for which you

identified with a number, click #. To list all contacts in your
Personal Contacts list, click All.

Add a one or more selected contacts to your distribution list.
Remove one or more selected contacts from your distribution list.

Add a new contact to your Personal Contacts list and add the
contact to your distribution list.

Add a new distribution list to your Personal Contacts list.

Update an existing distribution list that you have edited.

Deleting contact information in your address book

You can delete any contact or distribution lists that you have added to your personal

address book.

To delete a contact or contact group:

1 Open your address book.

2 Inthe View drop-down list, select Personal Contacts.

3 Inthe list that appears, select the check box for the contact or distribution list that

you want to delete.
4 Click Delete.

A message appears, asking you to confirm the deletion.

285



Chapter 20: Using My WebEx

5

Click OK.

Maintaining your user profile

About maintaining your user profile

286

Once you obtain a user account, you can edit your user profile at any time to do the
following:

Maintain personal information, including your:

Full name
Username (if your site administrator provides this option)
Password

Contact information (including your street address, email address, and phone
numbers)

Tracking codes that your organization uses to keep records of your meetings
(such as project, department, and division numbers)

Specify whether to display links to your company's partner sites in the My WebEXx
navigation bar, if your site administrator set up partner links.

Manage any scheduling templates that you saved.

Set options for your Personal Meeting Room options, including the images and
welcome message that appear on the page.

Set default options for your online sessions, including:

The default session type that you want to use, if your account includes
multiple session types.

Whether your scheduled meetings are automatically removed from your list of
meetings once the meeting ends.

Whether the Quick Start page appears in the content viewer once you start a
meeting.

The users who can schedule meetings on your behalf.

Set Web site preferences, including:

The home page that appears when you access your WebEX service Web site.
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= The time zone in which meeting times appear.

= The language in which your Web site displays text, if your site includes
multiple languages.

= The locale (the format in which your Web site displays dates, times, currency
values, and numbers).

About the My WebEXx Profile page

How to access this template

On your WebEXx service Web site, click My WebEx > My Profile.

What you can do here

Manage the following:

Account information

Personal information

Partner integration options

Scheduling templates (does not apply to Support Center)
Personal Meeting Room information

Meeting options

Web page preferences, including your home page and language

Support Center CSR Dashboard options (Support Center only)

Personal Information options

Use this option... To...

Username Specify the username for your account. You can change this

name only if the administrator for your WebEXx service Web site
provides this option.

Tip: If you need to change your username, but cannot edit it on
this page, ask your site administrator to change your username
or create a new account for you.
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Use this option...
Change Password

Call-in authentication

Call-back

PIN

Other personal
information options

288

To...
=  Old password: Type the old password for your account.

= New password: Specify the new password for your
account. A password:

[0 Must contain at least four characters
[0 Can consist of a maximum of 32 characters

O Caninclude any letters, numbers, or special
characters, but not spaces

[0 Is case sensitive

= Retype New password: Verify that you typed your
password correctly in the New password box.

If enabled by your site administrator, allows you to be
authenticated and placed into the correct teleconference without
needing to enter a meeting number whenever you dial into any
CLI (caller line identification) or ANI (automatic number
identification) enabled teleconference. Selecting this option for a
phone number in your user profile maps your email address to
that phone number. Caller authentication is available only if you
have been invited to a CLI/ANI enabled teleconference by email
during the meeting scheduling process. Caller authentication is
not available if you are dialing in to a CLI/ANI enabled
teleconference.

When selected for a phone number in your user profile, allows
you to receive a call from the teleconferencing service if it is
using an integrated call-back feature. If your site includes the
international call-back option, participants in other countries
receive a call back. For more information about this option, ask
your site administrator.

If enabled by your site administrator, allows you specify a call-in
authentication PIN to prevent “spoofers” from using your
number to dial into a teleconference. If your site administrator
sets the authentication PIN as mandatory for all accounts using
call-in authentication on your site, you must specify a PIN
number or caller authentication will be disabled for your
account. This option is available only if you have selected the
Call-in authentication option for at least one of the phone
numbers in your profile. The PIN can also be used to provide a
secondary level of authentication for calls where the host is
using the phone and may need to invite additional attendees.

Enter any personal information that you want to maintain in your
profile.
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Partner integration options

Your site administrator can set up custom links to the Web sites of your company's
partners, and then display the links on the My WebEx navigation bar. For example, if
your company uses another company's Web site to provide a service, your site
administrator can provide a link to that company's site in your My WebEXx navigation
bar. You can then show or hide that link.

Use this option.... To....

Display partner links in Shows or hides partner site links in the My WebEx navigation
My WebEx bar.

Calendar Work Hours options

Use these options to specify working hours to use with scheduling calendars.

Use this option... To...
Start time Select the start time for your daily work calendar.
End time Select the end time for your daily work calendar.

Scheduling template options

Use these options to manage scheduling templates that you set up using the
scheduling options on your site.

Use this option... To...

Get Info Shows the settings you set for the selected template.

Edit Opens the scheduling options on your site for the selected
template.

Delete Removes the selected template from your profile.

Select All Selects all the scheduling templates, allowing you to delete

them all at once.
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Personal Meeting Room options

Use this option...

Personal Meeting Room
URL

Welcome Message

Upload Image

Customize branding of
header area

To...

Go to your Personal Meeting Room page. You can click the
URL from the My Profile page to preview your current Personal
Meeting Room page.

Your Personal Meeting Room page shows online sessions that
you scheduled and any in-progress sessions that you are
currently hosting.

Users to whom you provide your personal URL can use this
page to join any meeting that you are hosting. They can also
download files in any folders that you share.

Enter the message that appears on your Personal Meeting
Room page. A message can be a maximum of 128 characters,
including spaces and punctuation.

To specify a message, type it in the box, and then click Update.

Upload an image file from your computer or another computer
on your network to your Personal Meeting Room page. For
example, you can upload a picture of yourself, your company's
logo, or a picture of your company's product. Visitors to your
page can see the image that you upload.

The image can be an maximum of 160 pixels wide. If you
upload a larger image, its width is automatically reduced to 160
pixels. However, the image's aspect ratio is maintained.

Browse: Lets you locate an image.
Upload: Uploads the image that you selected.

Current Image: Displays the image that currently appears on
your Personal Meeting Room page.

Delete: Removes the current image from your Personal
Meeting Room page. This button is available only if you have
uploaded an image for the page.

Upload a banner image to the non-scrolling header area for
your Personal Meeting Room page. For example, you can
upload your company's logo or an advertisement. Visitors to
your page can see the image that you upload. Available only if
your site administrator has turned on this option for your
account.

The image can be a maximum of 75 pixels high. If you upload a
larger image, its height is automatically reduced to 75 pixels.
However, the image's aspect ratio is maintained.

Browse: Lets you locate a banner image.
Upload: Uploads the banner image that you selected.

Current Image: Displays the banner image that currently
appears on your Personal Meeting Room page.
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To...

Delete: Removes the current banner image from your Personal
Meeting Room page. This button is available only if you have
uploaded an image for the page.

Productivity Tools Options

Use this option....

Automatically download
Productivity Tools when
logging in to the WebEx
service site

Session Options

Use this option...

Automatically delete
meetings from My
Meetings when
completed

Default session type

To....

Specify that WebEx Productivity Tools should be downloaded
automatically when you log in to the WebEXx service site. If this
option is turned off, you can still download Productivity Tools
manually.

To...

Specify that once a scheduled meeting ends, the meeting is
automatically removed from your list of scheduled meetings on
the My Meetings page, if the scheduled starting time has
passed. If you do not select this option, the meeting remains on
your list of meetings until you delete it.

You can change this default setting when scheduling a meeting.
Applies only to meetings and sales meeting. Does not apply to
events, support sessions, or training sessions.

Specify the default session type that you host, if your user
account lets you host different types of online sessions.

For more information about session types, ask the site
administrator for your WebEx service.

You can change this default setting when scheduling a meeting.
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Use this option...
Quick Start

To...

Specify whether the Quick Start page appears in the content
viewer once you start a meeting. The Quick Start lets you start
sharing activities quickly, as an alternative to starting them from
a menu or toolbar.

=  Show Quick Start to host and presenter: The Quick Start
appears in the content viewer for the host and presenter.

= Show Quick Start to attendees: The Quick Start appears
in the content viewer for attendees. Select this option only if
you intend to let attendees share information during your
meetings.

You can change this default setting when scheduling a meeting.

Scheduling permission Type the email addresses for any users whom you want to let

schedule meetings for you. Separate email addresses with
either a comma or a semicolon.

Select From Host List: Open the Select Host page, which
contains a list of all users who have accounts on your WebEx
service Web site. On this page, you can select users whom you
want to let schedule meetings for you.

Web page preferences options

Use this option...

Home page

Time zone

Language

Locale

To...

Set the first page that appears when you access your WebEXx service
Web site.

Set the time zone in which you reside.

If you select a time zone for which daylight saving time (DST) is in
effect, your WebEXx service Web site automatically adjusts its clock for
daylight saving time.

Note: The selected time zone appears:

= Only on your view of your WebEx service Web site, not other
users' views.

= In all meeting invitations that you send using your WebEXx service
Web site.
Set the language in which your WebEX service Web site displays text.

Note: The languages that appear in this list are limited to the languages
that have been set up for your Web site.

Set the format in which your Web site displays dates, times, currency
values, and numbers.
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Editing your user profile

Once you obtain a user account, you can edit your user profile at any time to change
account login information, contact information, and other options available for your
account.

To edit your user profile:

1

2

3

4

5

Log in to your WebEXx service Web site.
On the navigation bar, click My WebEXx.
Click My Profile.

Edit the information on the page.

When you are finished editing your user profile, click Update.

Managing scheduling templates

About managing scheduling templates

Scheduling templates let you save the options you set for a meeting for later use. Once
you save a scheduling template, you can use it to quickly schedule another meeting,
instead of setting the same options again. If you saved a scheduling template using the
Save As Template option when scheduling a meeting, you can manage the template,
as follows:

View the options you set in the template.
Edit the options you set in the template.

Delete the template.

Managing scheduling templates

You can view, edit, or delete any scheduling templates that you saved.
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To manage scheduling templates:

1 Log in to your WebEXx service Web site.

2 On the navigation bar, click My WebEXx.

3 Click My Profile.

The My Profile page appears.

4 Under Scheduling Templates, select a template in the list.

Scheduling Templates

Option
Topic

Create time
Duration
Description
File size

Create time

Status

Password

Stream recording link

Download recording link

Uz Cirl 1o selact muHipls templats

MC: Registrahon Required Getinio =
MC: Staff Meeting o

MC: Markting Team Meeting Edit

Delete

ik

Selectall

Description

The name of the recording. You can edit the topic at any time.
The time and date the recording was created.

The length of the recording.

A description of the recording.

The file size of the recording.

The date and time at which the recording was created.

The status of the recording. The possible options are Enable or
Disable.

Indicates whether a user must provide a password to view the
recording.

Clicking the link lets you play the recording (available only for

recording files with the .arf extension that were recorded by
NBR).

Clicking the link lets you download the recording.
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Option Description

Clicking the button lets you play the recording (available only for
recording files with the .arf extension that were recorded by

Play Mow NBR).

If you want to download the recording, you can also click the
link for downloading under Play Recorded a meeting Now.

Clicking the button opens the Share My Recording window,
which allows you to send an email message to selected

- recipients, inviting them to play your recording.
Send Email T o
If you want to send the email with your local email client

instead, click the link for using the email client under Share My
Recording.

Clicking the button opens the Edit Recording page.

Delete Clicking the button deletes the recording.

Clicking the button disables the recording everywhere it is
Disakle published on your WebEx Service Web site (available only for
enabled recordings).

Clicking the button enables the recording everywhere it is
Enahle published on your WebEx Service Web site (available only for
disabled recordings).

=

8—.

=
=)

Back to List ] Clicking the button returns you to the recording list.

Generating Reports

About generating reports

If your user account includes the reports option, you can view the following reports:

Note:
= For some reports, if you click on the report link within 15 minutes after the meeting
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ends, you will see a preliminary version of that report. The preliminary report provides
quick access to data before the final, more accurate data is available. The preliminary
report contains only a subset of the information that is available in the final report.

= When the final, more accurate data is available, which is usually 24 hours after the
meeting ends, the preliminary report is replaced by the final report.

= You can download both preliminary reports and final reports as comma-separated
values (CSV) files.

General Meeting Usage reports

These reports contain information about each online session that you host. You can
view the following reports:

Summary Usage report: Contains summary information about each meeting
including topic, date, start and end time, duration, number of attendees you
invited, number of invited attendees who attended, and type of voice conference
you used.

Note: Initially, this report appears as a Preliminary Usage Summary Report, but after the
final, more accurate usage data is available, it is replaced by the Final Usage Summary
Report.

Summary Usage report CSV (comma-separated values) file: Contains
additional details about each meeting, including the minutes that all participants
were connected to the meeting and tracking codes.

Session Detail report: Contains detailed information about each participant in a
meeting, including the time the participant joined and left the meeting, the
attentiveness during the meeting, and any information that the attendee provided.

Note: Initially, this report appears as a Preliminary Session Detail Report, but after the
final, more accurate session detail data is available, it is replaced by the Final Session Detail
Report.

Generating reports
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You can generate usage reports that provide information about each online meeting
that you have hosted on your site.

You can export or download the data to a comma-separated values (CSV) file which
you can then open in a spreadsheet program such as Microsoft Excel. You can also
print reports in a printer-friendly format.

To generate a report:

1

2

Log in to your WebEX service Web site, and then click My WebEX.
Click My Reports.
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The My Reports page appears.
3 Choose the type of report you want to generate.

4 Specify your search criteria, such as a date range for which you want to view
report data.

5 Click Display Report.
6 To change the order in which report data is sorted, click the column headings.

The report data is sorted by the column that has an arrow next to the column
heading. To reverse the sort order, click the column heading. To sort using
another column, click that column's heading.

7 Do one of the following, as appropriate:

= If you are viewing a general meeting usage report and want to display the
report in a format that is suitable for printing, click Printer-Friendly Format.

8 If you are viewing the usage report for an a meeting and want to view the content
in the report, click the link for the meeting name.

9 To export the report data in comma-separated values (CSV) format, click Export
Report or Export.

10 If available, click links on the report to display more details.
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